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1. ПОЯСНИТЕЛЬНАЯ ЗАПИСКА

Дисциплина «Проектирование в графическом дизайне» входит в обязательную часть дисциплин ООП ФГОС ВО (уровень бакалавриата) и адресована студентам 1-4 курса (I-VII семестр), направление подготовки 54.03.01 Дизайн, профиль Графический дизайн Академии Матусовского. Дисциплина реализуется кафедрой графического дизайна.
Дисциплина логически и содержательно-методически взаимосвязана с дисциплинами: «Шрифт», «Компьютерная графика», «Основы композиции. Теоретический курс», прохождении практики: проектно-технологической, преддипломной, подготовке к государственной итоговой аттестации. 
Содержание дисциплины «Проектирование в графическом дизайне» раскрывает суть стилистики прошлых эпох; стилистические направления и течения ХХ-ХХI вв; орнаменты, историческая классификация орнаментов; закономерности композиции; стилизация. Рассматриваются основные правила построения и приемы комбинирования изобразительных элементов; типы проектно-графических изображений; разновидности знаков: изображения (абстрактные и изобразительные), словесные, комбинированные, объемные; фактура и текстура; характер шрифта эпохи, монограмма, экслибрис. Рассматриваются понятие формальной композиции; типы проектирования: вербальное, графическое, объемное, объемно-пространственное, пространственно-временное; понятие «знак-морфем» (логотип) и «знак-символ» (эмблема) формально-композиционное отображение состояний; взаимосвязь и взаимозависимости функции и формы, художественного образа и формы; стилистика прошлых эпох; стилистические направления и течения ХХ-ХХI вв; орнаменты, историческая классификация орнаментов; закономерности композиции; стилизация.
Также рассматриваются основные правила построения и приёмы комбинирования изобразительных элементов; типы проектнографических изображений; разновидности знаков: изображения (абстрактные и изобразительные), словесные, комбинированные, объемные; фактура и текстура; характер шрифта эпохи, монограмма, экслибрис.
Рассматриваются понятие формальной композиции; типы проектирования: вербальное, графическое, объёмное, объёмно-пространственное, пространственно-временное; понятие «знак-морфема» (логотип) и «знак-символ» (эмблема) формально-композиционное отображение состояний; взаимосвязь и взаимозависимости функции и формы, художественного образа и формы; принцип серийности в графическом дизайне, графические серии, признаки серии, моносерии и мультисерии, серия почтовых марок, серия этикеток, книжная серия, игральные карты, спичечные этикетки, серия карманных календарей, серия открыток;
Изучение методики проектирования фирменного стиля; изучение истории фирменного стиля; знакомство с основными понятиями фирменного стиля, знак-индекса, символа, эмблемы, пиктограммы, логотипа; разработка фирменного изобразительного знака; разработка корпоративной идентификации; разработка рекламных носителей фирменного стиля.
Раскрывается суть таких тем, как: возможности прикладных графических программ векторных, растровых и многостраничной верстки, взаимодействие между ними (программами) и трансформация художественного образа от авторского эскиза до оригинал-макета, процесс создания оригинал-макетов pos-материалов при помощи графических растровых и векторных редакторов; структурирование и создание концепции бренда, определение целевой аудитории бренда и разработка макетов, что является последним связующим звеном между художником и производством.
Преподавание дисциплины предусматривает следующие формы организации учебного процесса: лекции, практические занятия, самостоятельная работа студентов и консультации.
Программой дисциплины предусмотрены следующие виды контроля: текущий контроль успеваемости в форме: устный опрос, электронное тестирование, защита графических работ, просмотр на мониторе выполненных заданий в графических редакторах и т. п.
Итоговый контроль в форме зачета с оценкой и экзамена.
Общая трудоемкость освоения дисциплины составляет 22 зачетные единицы, 792 часа. Программой предусмотрены 106 часов – лекционные занятия, 314 часов - практических занятий; 318 часов - самостоятельной работы; 54 часа – контроль.

1. ЦЕЛЬ И ЗАДАЧИ ИЗУЧЕНИЯ ДИСЦИПЛИНЫ

Цель преподавания дисциплины: подготовка специалиста, имеющего основные теоретические знания об общих характеристиках стилистики прошлых эпох и стилистике современного изобразительного и декоративно-прикладного искусства; подготовка специалиста способного квалифицированно разбираться в разновидностях типов проектно-графических изображений; разновидностей знаков: изобразительных (абстрактных и изобразительных), словесных, комбинированных, объемных; фактур и текстур; стилистике и исторической классификации орнаментов; формирование практических навыков комбинирования различных изобразительных элементов; понимание и умение использовать на практике понятие взаимосвязи и взаимозависимости функции и формы, художественного образа и формы; формально-композиционного отображения состояния; закономерности композиции и стилизации; формирование у обучающегося проектной культуры дизайна как междисциплинарной, многопрофильной творческой области, при которой дизайн-проект является целостной многофакторной системой, результирующей накопленный проектный опыт и определяющей тенденции развития предметно-пространственной среды и современную парадигму проектности; формирование у обучающихся структурных подходов к дизайн-проектированию; практическое освоение методологической базы проектирования в графическом дизайне; формирование проектного мышления как фундамента успешной и эффективной профессиональной деятельности.
Задачи изучения дисциплины:
· передача определенной системы знаний, связанных с прошлой, современной и новейшей стилистикой в изобразительном и декоративно-прикладном искусстве;
· формирование уровня знаний необходимого для функционально-структурного анализа произведений графического дизайна и изобразительного искусства существующих или вновь созданных; ознакомление с различными методами комплексного подхода к решению конкретных задач макетирования объектов графического дизайна, как одиночных, так и комплексных (серии, вида, группы изданий и т.п.);
· развитие объемно-пространственных представлений, необходимых для решения задач макетирование объектов дизайна современными средствами художественно-компьютерной графики;
· формирование умений целенаправленно наблюдать и изучать окружающую предметную среду - сравнивать, сопоставлять, выявлять сходство и различие предметов и явлений; определять главное и подчиненное в художественных образах произведений искусства, дизайна, архитектуры и окружающей среды;
· чувствовать зависимость элементов изображения, связанных между собой композиционной логикой: композиционная равновесие, согласованность плоскости и изобразительных элементов, согласованность формы, функции, структуры и декора, соответствие и гармоничность содержания и формы;
· развитие вербально-образного и предметно-образного мышления, представления и фантазии, способности анализировать и синтезировать художественный образ на базе сопоставления и поисков аналогий;
· ознакомление с базовыми терминами и понятиями графического дизайна;
· передача определенной системы знаний, связанных с прошлой, современной и новейшей стилистикой в изобразительном и декоративно-прикладном искусстве;
· формирование уровня знаний, необходимого для функционально-структурного анализа произведений графического дизайна и изобразительного искусства существующих или вновь созданных;
· ознакомление с различными методами комплексного подхода к решению конкретных задач макетирования объектов графического дизайна, как одиночных, так и комплексных (серии, вида, группы изданий и т.п.);
· развитие объёмнопространственных представлений, необходимых для решения задач;
· макетирование объектов дизайна современными средствами художественно-компьютерной графики;
· формирование умений целенаправленно наблюдать и изучать окружающую предметную среду - сравнивать, сопоставлять, выявлять сходство и различие предметов и явлений;
· умение определять главное и подчиненное в художественных образах произведений искусства, дизайна, архитектуры и окружающей среды;
· умение проследить зависимость элементов изображения, связанных между собой композиционной логикой: композиционная равновесие, согласованность плоскости и изобразительных элементов, согласованность формы, функции, структуры и декора, соответствие и гармоничность содержания и формы;
· развитие вербально-образного и предметно-образного мышления, представления и фантазии, способности анализировать и синтезировать художественный образ на базе сопоставления и поисков аналогий;
· ознакомление с основными этапами проектирования объектов рекламной и печатной продукции;
· обретение навыков разработки и подачи проектов;
· выявление стилистических особенностей в сочетании текста, иллюстраций и различных видов сетки;
· обретение навыков практической реализации проектной идеи в виде дизайн-образца графического изделия;
· изучение методики проектирования фирменного стиля;
· ознакомление с понятийно-категориальным аппаратом проектирования в дизайне; 
· раскрытие сущности и структуры проектной культуры дизайна; 
· практическое освоение методов предпроектной (предваряющей дизайн-проектирование) исследовательской деятельности: методов сбора, обработки и анализа материалов, способных оказать принципиальное влияние на генерацию проектной идеи;  
· ознакомление с современными материалами и технологиями, производственными ресурсами, техническими базами, аппаратными средствами, программным обеспечением дизайна; 
· практическое освоение техник и приемов создания эскизных проектов, методов оформления и подачи эскизов на всех стадиях ведения проекта; 
· принципов создания эскизных проектов; методик подготовки к текущей, промежуточной и финальной защите дизайн-проекта.


2. МЕСТО ДИСЦИПЛИНЫ В СТРУКТУРЕ ООП ВО

Курс входит в блок обязательных дисциплин, по подготовке студентов по направлению подготовки 54.03.01 Дизайн, профиль Графический дизайн.
Дисциплина «Проектирование в графическом дизайне» относится к базовой части по профилю. Данному курсу должно сопутствовать изучение дисциплин «Основы композиции», «Компьютерная графика», «Иллюстрация», «Дизайн периодических изданий», «Шрифт», которые логически, содержательно и методически связаны с дисциплиной «Проектирование в графическом дизайне».
Изучение таких дисциплин как «Академический рисунок», «Академическая живопись», «Цветоведение», «Пластическая анатомия», «Фотоискусство», «Графический дизайн в среде», «Техники исполнения дизайн-проектов» способствует успешному овладению студентами дисциплины «Проектирование в графическом дизайне». 
В программе учтены межпредметные связи с другими учебными дисциплинами такими как: «Компьютерная графика». Использование междисциплинарных связей обеспечивает преемственность изучения материала, исключает дублирование и позволяет рационально распределять время.
Освоение дисциплины будет необходимо при прохождении практик: преддипломной, проектно-технологической практики, подготовке к процедуре защиты и защите выпускной квалификационной работы.

3. ТРЕБОВАНИЯ К РЕЗУЛЬТАТАМ ОСВОЕНИЯ ДИСЦИПЛИНЫ
Изучение дисциплины направлено на формирование компетенций в соответствии с ФГОС ВО направления подготовки 54.03.01 Дизайн, профиль Графический дизайн: УК-3, ОПК-3, ПК-2, ПК-3.

Универсальные компетенции (УК):
	№ компетенции
	Содержание компетенции
	Индикаторы
	Рехультаты обучения

	УК-3
	Способен осуществлять социальное взаимодействие и реализовывать свою роль в команде
	УК-3.1 Эффективно взаимодействует с членами команды на всех этапах разработки проекта — от концепции до реализации.
	Знать: правила и приёмы социального взаимодействия и возможности их применения в различных ситуациях. 
Уметь: организовать социальное взаимодействие в команде, осознавать свою роль и брать на себя ответственность. 
Владеть: навыками организации работы в команде для достижения необходимых результатов, общих целей и индивидуальных задач, навыками аргументированного изложения собственной точки зрения, ведения дискуссии.



Общепрофессиональные компетенции (ОПК):
	№ компетенции
	Содержание компетенции
	Индикаторы
	Результаты обучения

	ОПК-3
	Способен выполнять поисковые эскизы изобразительными средствами и способами проектной графики; разрабатывать проектную идею, основанную на концептуальном, творческом подходе к решению дизайнерской задачи; синтезировать набор возможных решений и научно обосновывать свои предложения при проектировании дизайн объектов, удовлетворяющих утилитарные и эстетические потребности человека (техника и оборудование, транспортные средства, интерьеры, полиграфия, товары народного потребления).
	ОПК-3.1. Создает поисковые эскизы, используя различные изобразительные средства и техники проектной графики, чтобы визуализировать идеи и концепции.
· 
	Знать: средства создания проектного образа; основные приемы и методы выполнения художественно-графических работ.
Уметь: выполнять поисковые эскизы; разрабатывать проектную идею; обосновывать художественный замысел дизайн-проекта.
Владеть: навыками эскизирования; навыками концептуального подхода к проектированию объектов дизайна; 



Профессиональные компетенции (ПК):

	№ компетенции
	Содержание компетенции
	Индикаторы
	Результаты обучения

	ПК-2
	Способен определять требования к дизайн-проекту, синтезировать набор возможных решений проектных задач и методологических подходов к выполнению дизайн-проекта; разрабатывать проектные идеи, основанные на концептуальном, творческом подходе к решению дизайнерской задачи.

	ПК-2.1. Синтезирует различные варианты решений, используя концептуальный и творческий подход, и разрабатывать проектные идеи, которые сочетают функциональность и эстетику.
	Знать: основы проектной культуры дизайна, концептуальные основы дизайна по областям, виды современных продуктов дизайна, их назначение, функциональные свойства, особенности технологий их дизайн-проектирования.
Уметь: анализировать информацию, необходимую для работы над дизайн-проектом объектов визуальной информации, идентификации и коммуникации с учётом пожеланий заказчика и предпочтений целевой аудитории. 
Владеть: проектной культурой дизайна, основными методами дизайн-проектирования, пониманием роли смежных дисциплин и междисциплинарных подходов к современной проектной культуре.

	ПК-3
	Способен применять современные технологии, требуемые для реализации дизайн-проекта на практике; применять компьютерное программное обеспечение, используемое в дизайне объектов визуальной информации, идентификации и коммуникации.
	· [bookmark: _GoBack]ПК-3.2. Использует специализированное программное обеспечение для проектирования и визуализации дизайн-проектов.
	Знать: современные технологии, которые нужны для реализации дизайн-проекта на практике;   
Уметь: применять компьютерное программное обеспечение в рамках реализации дизайн-проекта;  
Владеть: умением развивать компетенцию в сфере использования компьютерных технологий для поиска, переработки и дальнейшей подачи визуальной информации.




4. СТРУКТУРА УЧЕБНОЙ ДИСЦИПЛИНЫ
	Названия разделов и тем
	
Очная форма

	
	Всего 
	в том числе

	
	
	л
	п
	с. р.
	кон.

	1
	2
	3
	4
	5
	6

	РАЗДЕЛ I. ПРИМЕНЕНИЕ СТИЛИСТИЧЕСКИХ ОСОБЕННОСТЕЙ ПРИ РАЗРАБОТКЕ ГРАФИЧЕСКОГО ПРОЕКТА
(I СЕМЕСТР)

	Тема 1. Стилистика эпох.
	22
	4
	4
	14
	-

	Тема 2. Персонифици- рованный индивидуальный образ
	28
	8
	6
	14
	-

	Тема 3. Виды 
проектно-графических изображений. 
	22
	4
	4
	14
	-

	Всего по I разделу
	72
	16
	14
	42
	-

	РАЗДЕЛ II. СОЗДАНИЕ ГРАФИЧЕСКОГО ПРОЕКТА В СТИЛИСТИКЕ XX-XXI ВЕКОВ
(II СЕМЕСТР)

	Тема 4. Стилистика ХХ–ХХI веков
	50
	14
	12
	24
	-

	Тема 5. Создание социального образа
	52
	14
	18
	20
	-

	Тема 6. Серийные объекты
	42
	12
	10
	20
	-

	Всего по II разделу
	144
	40
	40
	64
	-

	Всего по  I и II разделу
	216
	56
	54
	106
	-

	РАЗДЕЛ III.СЕРИЙНЫЕ ОБЪЕКТЫ В ГРАФИЧЕСКОМ ДИЗАЙНЕ
(III СЕМЕСТР)

	Тема 1. Принцип серийности в графическом дизайне
	2
	2
	-
	-
	-

	Тема 2. Серийные объекты в графическом дизайне
	4
	4
	-
	-
	-

	Тема 3. Серийный объект – открытка
	91
	2
	34
	46
	9

	Тема 4. Серийный объект – почтовая марка
	65
	2
	16
	38
	9

	Всего по III разделу
	162
	10
	50
	84
	18

	РАЗДЕЛ IV. РАЗРАБОТКА СИСТЕМЫ ВИЗУАЛЬНОЙ ИДЕНТИФИКАЦИИ  
(IV СЕМЕСТР)

	Тема 5. Фирменный знак, логотип
	2
	2
	-
	-
	-

	Тема 6. Фирменный блок
	14
	2
	8
	4
	-

	Тема 7. Разработка корпоративной идентификации
	76
	2
	42
	32
	-

	Тема 8. Разработка  рекламных носителей фирменного стиля
	52
	4
	20
	28
	-

	Всего по IV разделу
	144
	10
	70
	64
	-

	Всего по  III и IV разделу
	306
	20
	120
	148
	18

	РАЗДЕЛ V. СОЗДАНИЕ МАКЕТОВ КНИЖНЫХ ИЗДАНИЙ В ПРОЦЕССЕ ИЗУЧЕНИЯ ПРОГРАММЫ МНОГОСТРАНИЧНОЙ ВЕРСТКИ
(V СЕМЕСТР)

	Тема 1. Книжное издание.
	8
	6
	2
	-
	-

	Тема 2. Макетирование и подготовка в печать многостраничных книжных изданий.
	46
	4
	18
	15
	9

	Всего часов обучения за V семестр
	54
	10
	20
	15
	9

	РАЗДЕЛ VI. ПРОЕКТИРОВАНИЕ В ВЕКТОРНОМ ГРАФИЧЕСКОМ РЕДАКТОРЕ
(VI СЕМЕСТР)

	Тема 3. Знакомство с рабочей средой. Выделение и выравнивание. 
Создание и редактирование фигур.
	24
	4
	16
	4
	-

	Тема 4. Трансформирование объектов. 
Рисование с помощью инструментов Pen и Pencil. 
Цвет и работа с ним в программе
	28
	2
	18
	8
	-

	Тема 5. Работа с текстом. Работа со слоями. 
Создание переходов между цветами и фигурами. 
	28
	2
	18
	8
	-

	Тема 6. Работа с кистями. Применение эффектов.
Работа с символами.
	28
	2
	18
	8
	-

	Всего часов обучения за VI семестр
	108
	10
	70
	28
	-

	Всего часов за V и VI семестр
	162
	20
	90
	43
	9

	РАЗДЕЛ VII. СОЗДАНИЕ ИНДИВИДУАЛЬНОГО ОБРАЗА ОБЪЕКТА В РЕКЛАМЕ
(VII СЕМЕСТР)

	Тема 1. POS-материалы в маркетинге: виды и правила разработки.
	22
	2
	10
	4
	6

	Тема 2. Разработка концепции бренда. Целевая аудитория: определение и анализ.
	22
	2
	10
	4
	6

	Тема 3. Бренд-стратегии создания продукта.
	22
	2
	10
	4
	6

	Тема 4. Разработка дизайна pos-материалов.
	22
	2
	10
	4
	6

	Тема 5. Графическо-информационные объекты как пространственно-временная коммуникационная система. 
Психофизические свойства цвета.
	20
	2
	10
	5
	3  

	Всего часов за VII семестр
	108
	10
	50
	21
	27

	Всего часов
	792
	106
	314
	318
	54













5. СОДЕРЖАНИЕ ДИСЦИПЛИНЫ
6.1 Лекционный материал


РАЗДЕЛ I. ПРИМЕНЕНИЕ СТИЛИСТИЧЕСКИХ ОСОБЕННОСТЕЙ ПРИ РАЗРАБОТКЕ ГРАФИЧЕСКОГО ПРОЕКТА
(I СЕМЕСТР)

Тема 1. Стилистика эпох. 
Стилистика эпох. Основы композиции. Целостность, взаимозависимость элементов, композиционная равновесие, симметрия, асимметрия. закономерности композиции. Фактура и текстура. Зрительное восприятие формы и пространства. Точка-линия-плоскость.
 Литература: [1 - С. 40-46; 2- С.9-10; 4 – С. 3-7; 5 – С.97-106.; 5- С.9-109; 7-  С.25-30]

Тема 2. Персонифицированный индивидуальный образ 
Искусство силуэта. История костюма. Создание персонифицированного индивидуального образа в заданной стилистике. 
 Литература: [1 - С. 40-46; 2 - С.9-10; 5- С.9-109; 10 – С.10-160]

Тема 3. Виды проектно-графических изображений 
История орнамента. Историческая классификация орнаментов. Стилизация. Основные правила построения разновидностей изобразительных элементов. Разновидности знаков: изобразительные (абстрактные и изобразительные), словесные, комбинированные, объемные. Монограмма. Инициал. Вензель. Буквица. Экслибрис. 
 Литература: [2. - С.9-10; 5 – С.97-106;. 7-  С.25-30 ]
РАЗДЕЛ II. СОЗДАНИЕ ГРАФИЧЕСКОГО ПРОЕКТА В СТИЛИСТИКЕ XX-XXI ВЕКОВ
(II СЕМЕСТР)
 
Тема 4. Стилистика ХХ –ХХI веков 
Стилистика изобразительного искусства ХХ –ХХI вв. Векторный портрет. 
 Литература: [1 - С. 40-46;; 2- С.9-10;]

Тема 5. Создание социального образа. 
Понятие «знак-морфем» (логотип) и «знак-символ» (эмблема). Этапы подготовки эмблемы. Формально-композиционные средства. Пиктограммы. Создание изобразительного знака (идеограммы). Разработка словесного знака (логограммы).  
 Литература: [2- С.9-10; 13 – С.48-51.]

Тема 6. Серийные объекты 
Взаимосвязь и взаимозависимость функции и формы. Взаимосвязь и взаимозависимость художественного образа и формы. Серийные объекты. Этапы подготовки серийных объектов. Объемно-графическая модель на заданную тему.  
Литература: [2- С.9-10;   — С.7-8; 83-85;   — С. 3-5: 7-  С.25-30]
РАЗДЕЛ III.СЕРИЙНЫЕ ОБЪЕКТЫ В ГРАФИЧЕСКОМ ДИЗАЙНЕ
(III СЕМЕСТР)

Тема 1. Принцип серийности в графическом дизайне
Серийность объектов. Графические серии. Синтаксические, семантические и прагматические функции серийных графических изображений. Признаки серии. Инвариантный, вариационный принцип построения изображений при серийном типе визуализации смысла в графическом дизайне. Моносерия, мультисерия.
Литература: [1 (С. – 3-5), 2 (С. – 12-62), 5 (С. – 7-71), 7 (С. – 9-21)] 

Тема 2. Серийные объекты в графическом дизайне
Серия почтовых марок. Серия этикеток. Книжная серия. Авторская серия. Игральные карты. Спичечные этикетки. Филумения. Серия карманных календарей. Серия открыток. 
Литература: [1 (С. – 3-5), 2 (С. – 12-62), 5 (С. – 7-71), 7 (С. – 9-21), 22, 23, 25, 26, 27] 
Тема 3. Серийный объект – открытка 
Стандартные маркированные почтовые карточки. Иллюстрированные маркированные почтовые карточки. Маркированные почтовые карточки специального назначения. Немаркированные почтовые карточки. Художественные и документальные открытки. Композиционно-графическая модель серии. 
Литература: [16 (С. – 65-109), 19 (С. – 86-96), 21 (С. – 56-76),  23, 25, 28, 29, 30]

Тема 4. Серийный объект – почтовая марка 
Серия почтовых марок. «Омнибусная» серия. Идентичная серия. Перманентная серия. Смешанная серия. Эссе. Высокая печать. Глубокая печать. Плоская печать. Коммеморативная марка. Штемпель гашения.
Литература: [3  (С. – 4-8), 4 (С. –5-119), 5 (С. –8-21), 6 (С. –5-55), 16 (С. – 65-109) 22, 26, 27]

РАЗДЕЛ IV. РАЗРАБОТКА СИСТЕМЫ ВИЗУАЛЬНОЙ ИДЕНТИФИКАЦИИ
(IV СЕМЕСТР)
 
Тема 5. Фирменный знак, логотип
Фирменный стиль. Графический фирменный стиль. Функции фирменного стиля. Средства формирования образа фирмы. Основные элементы графического фирменного стиля. Логотип. Торговый знак. Фирменное сочетание цветов. Фирменный шрифт. Схема верстки. Слоган. Рекламный символ фирмы.
Литература: [10  (С. – 98-127), 11 (С. –9-22), 13 (С. – 52-57), 18 (С. – 183-190)] 

Тема 6. Фирменный блок
Константа основных составляющих фирменного стиля. Фирменный цвет. Фирменный шрифт. Логотип. Слоган. Основные функции товарного знака. Типы товарных знаков. Функции логотипа. Корпоративный герой. Постоянный коммуникатор.
Литература: [ 8 (С. – 4-33), 9  (С. – 7-105), 11 (С. – 4-24, 80-120), 18 (С. – 182-202), 33, 34]

Тема 7. Разработка корпоративной идентификации
Этапы создания логотипа. Композиция логотипа. Подбор шрифта. Подбор размера. Удобочитаемость. Подбор цвета. Технические ограничения. Бриф. Стилеобразующие константы. Фирменные цвета. Цветовая гамма.  Цветовая символика. Ассоциации. Сочетаемость шрифтов. Ритм в шрифтовых композициях. Модульные сетки. 
Литература: [15 (С. – 15-77), 20 (С. – 148-170), 18 (С. – 143-161, 202-207), 33,34]
Тема 8. Разработка рекламных носителей фирменного стиля 
Рекламная печатная продукция. Флаер. Лифлет. Буклет. Рекламный плакат. Каталог. Наружная реклама. Вывеска. Штендер. Пилон. Баннер. Брендмауер. Лайтбокс. POS-материалы. Диспенсер. Мобайл. Вобблер. Муляж. Фриджи. Стикеры. Кубарик. Плакат. Листовка. Проспект. Календарь. Функциональность рекламно-информационных средств. Композиционная структура. Целевая аудитория. Эмоциональное воздействие. Сувенирная продукция. Открытки. Значки. Магниты. Упаковка. Пакеты. Сумки. Фирменная упаковочная бумага.
Литература: [  17 (С. – 6-35)   18 (С. – 123-163, 207-223), 33, 34]
РАЗДЕЛ V. СОЗДАНИЕ МАКЕТОВ КНИЖНЫХ ИЗДАНИЙ В ПРОЦЕССЕ ИЗУЧЕНИЯ ПРОГРАММЫ МНОГОСТРАНИЧНОЙ ВЕРСТКИ
(V СЕМЕСТР)
Тема 1. Книжное издание.
Анатомия книги. Макетирование страницы. Особенности верстки прозы и поэзии. Форматы книжных изданий. Служебные части книжных изданий и правила их верстки. 
Литература: [21— С. 9-120; 10 — С. 17-86; 14 — С.19-39; 51-79; 11 — С. 11-243; 22 — С. 17-122]
Тема 2. Макетирование и подготовка в печать многостраничных книжных изданий.
Особенности макетирования книжных изданий в программе многостраничной верстки. Препресс макета многостраничной верстки. Постпресс макета многостраничной верстки. Создание спуска полос макета многостраничной верстки.
Литература: [21— С. 120-164; 10 — С. 87-231; 14 — С.81-96; 99-103; 198-201; 283-288; 11 — С. 262-364; 22 — С. 123-237]

РАЗДЕЛ VI. ПРОЕКТИРОВАНИЕ В ВЕКТОРНОМ ГРАФИЧЕСКОМ РЕДАКТОРЕ
(VI СЕМЕСТР)
Тема 3. Знакомство с рабочей средой. Выделение и выравнивание. Создание и редактирование фигур.
Начало работы. Обзор рабочей среды. Настройка яркости пользовательского интерфейса приложения. Панель Tools. Панель Control. Работа с палитрами. Восстановление и сохранение состояния рабочей среды. Использование меню палитр. Изменение режима просмотра иллюстрации. Использование команд просмотра. Использование инструмента Zoom. Прокрутка документа. Просмотр иллюстрации. Навигация по нескольким монтажным областям. Использование палитры Navigator. Представление о линейках. Упорядочение нескольких документов. Группы документов. Выделение объектов. Использование инструмента Selection. Использование инструмента Direct Selection. Выделение с помощью прямоугольной области. Выделение с помощью инструмента Magic Wand. Выделение похожих объектов. Выравнивание объектов. Выравнивание объектов друг относительно друга. Выравнивание по ключевому объекту. Выравнивание точек. Распределение объектов. Выравнивание по монтажной области. Управление группами объектов. Группирование элементов. Работа в режиме изоляции. Добавление в группу. Упорядочивание объектов. Изменение порядка наложения объектов. Выделение объектов на заднем плане. Скрытие объектов. Применение методов выделения. Работа с базовыми фигурами. Представление о режимах рисования. Создание прямоугольников. Создание прямоугольников со скругленными углами. Создание эллипсов. Создание многоугольников. Рисование за объектами. Создание звезд. Изменение ширины и выравнивания обводки. Работа с сегментами линии. Соединение контуров. Использование инструмента Width. Преобразование обводки в кривые. Комбинирование и редактирование фигур. Работа с инструментом Shape Builder. Работа с эффектами палитры Pathfinder. Работа с режимами фигуры. Использование режима рисования Draw Inside. Редактирование фигур. расположенных внутри других фигур. Использование инструмента Eraser. Трассировка изображений для создания фигур. Чистка изображения после трассировки.
Литература: [1— С. 64-165; 2 — С. 58-166; 7 — С.28-40; 83-85; 8 — С. 26-46]
Тема 4. Трансформирование объектов. Рисование с помощью инструментов Pen и Pencil. Цвет и работа с ним в программе.
Управление монтажными областями. Добавление монтажных областей в документ. Редактирование монтажных областей. Переименование монтажных областей. Переупорядочение монтажных областей. Трансформирование объектов. Работа с линейками и направляющими. Масштабирование объектов. Отражение объектов. Вращение объектов. Искажение объектов. Наклон объектов. Точное позиционирование объектов. Изменение перспективы. Выполнение нескольких трансформаций. Использование эффекта Free Distor. Знакомство с инструментом Реп (Перо). Создание прямых линий. Создание криволинейных контуров. Построение кривой. Преобразование точек кривой в угловые точки. Создание рисунка скрипки. Рисование кривых. Выделение кривой. Рисование криволинейного контура. Рисование различных типов кривых. Рисование фигуры скрипки. Создание струн скрипки. Разделение контура. Добавление указателей стрелок. Создание пунктирной линии. Редактирование кривых. Удаление и добавление опорных точек. Преобразование между гладкими и угловыми точками. Рисование с помощью инструмента Pencil. Редактирование с помощью инструмента Pencil. Представление о цвете. Цветовые режимы. Представление об элементах управления цветом. Создание цвета. Создание и сохранение пользовательского цвета. Редактирование образца цвета. Использование библиотек образцов. Создание плашечного цвета. Использование палитры цветов. Создание и сохранение оттенка цвета. Копирование атрибутов оформления. Создание цветовых групп. Работа с палитрой Color Guide. Редактирование цветовой группы. Редактирование цветов графического объекта. Работа с палитрой Kuler. Назначение цветов графическому объекту. Коррекция цвета. Раскрашивание с помощью узоров. Применение существующих узоров. Создание узора. Применение узора. Редактирование узора. Работа с быстрой заливкой. Создание группы с быстрой заливкой. Редактирование областей быстрой заливки.
Литература: [1— С. 168-284; 2 — С. 170-286; 7 — С.250-281; 434-447; 8 — С. 240-267; 414-426]
Тема 5. Работа с текстом. Работа со слоями. Создание переходов между цветами и фигурами.
Работа с текстом. Создание текста из точки. Создание текста в области. Импорт простого текста из файла. Работа с переполнением текста и повторным заполнением текста. Связывание текста. Создание столбцов текста. Форматирование текста. Изменение размера шрифта. Изменение цвета шрифта. Изменение дополнительных атрибутов текста. Работа с глифами. Изменение размеров текстовых объектов. Изменение атрибутов абзаца. Создание и использование стилей текста. Создание и использование стиля абзаца. Редактирование стиля абзаца. Копирование атрибутов текста. Создание и применение стиля символов. Редактирование стиля символов. Изменение формы текста путем искажения оболочки. Изменение формы текста в оболочке. Обтекание объекта текстом. Создание текста по открытому контуру. Создание текста по закрытому контуру. Преобразование текста в кривые, Создание слоев. Выделение и перемещение объектов и слоев. Копирование содержимого слоев. Перемещение слоев. Закрепление слоев. Просмотр слоев. Вставка слоев. Создание обтравочных масок. Объединение слоев. Поиск слоев. Применение к слоям атрибутов оформления. Изоляция слоев. Работа с градиентами. Создание и применение линейного градиента. Изменение направления и угла градиентного перехода. Применение градиента к обводке. Редактирование градиентной обводки. Создание и применение радиального градиента. Изменение цветов радиального градиента. Настройка радиального градиента. Применение градиентов к нескольким объектам. Другие методы редактирования цветов градиента. Добавление прозрачности к градиентам. Создание переходов между объектами. Создание перехода с заданным числом шагов. Модификация перехода. Создание и редактирование плавных цветовых переходов.
Литература: [1— С. 288-418; 2 — С. 290-422; 7 — С.106-140; 222-246; 8 — С. 110-143; 218-237]
Тема 6. Работа с кистями. Применение эффектов. Работа с символами.
Работа с кистями. Использование каллиграфических кистей. Настройка кисти. Использование цвета заливки с кистями. Удаление мазков кисти. Использование объектных кистей. Рисование с помощью инструмента Paintbrush. Редактирование контуров с помощью инструмента Paintbrush. Создание объектной кисти. Редактирование объектной кисти. Использование кистей из щетины. Изменение параметров кисти из щетины. Рисование кистью из щетины. Использование узорчатых кистей. Создание узорчатой кисти. Применение узорчатой кисти. Изменение атрибутов цвета кистей. Изменение цвета кисти с использованием метода окраски Tints. Изменение цвета кисти с использованием метода окраски Hue Shift. Работа с инструментом Blob Brush. Рисование с помощью инструмента Blob Brush. Объединение контуров с помощью инструмента Blob Brush. Редактирование с использованием инструмента Eraser. Использование интерактивных эффектов. Применение эффекта. Редактирование эффекта. Стилизация текста с помощью эффектов. Редактирование фигур с помощью эффекта Pathfinder. Применение эффекта Offset Path. Создание объемного эффекта. Создание трехмерного объекта вращением. Изменение освещения трехмерного объекта. Проецирование символа на трехмерный объект. Использование атрибутов оформления. Редактирование и добавление атрибутов оформления. Добавление дополнительной обводки. Добавление дополнительной заливки. Переупорядочение атрибутов оформления. Применение атрибутов оформления к слою. Использование стилей графики. Создание и сохранение стиля графики. Применение стиля графики к объекту. Замена атрибутов стиля графики. Применение стиля графики к слою. Изменение стиля графики, примененного к слою. Применение существующих стилей графики. Применение нескольких стилей графики. Применение стиля графики к тексту. Копирование и удаление стилей графики. Создание графики для Всемирной паутины. Выравнивание объектов по пиксельной сетке. Фрагментация изображения. Выделение и редактирование фрагментов.
РАЗДЕЛ VII. СОЗДАНИЕ ИНДИВИДУАЛЬНОГО ОБРАЗА ОБЪЕКТА В РЕКЛАМЕ
(VII СЕМЕСТР)

Тема 1. POS-материалы в маркетинге: виды и правила разработки.
POS-материалы. Бренд. Рекламная полиграфическая продукция и маркетинг. Функции и виды pos-материалов: воблер, шелфтокер, некхенгер, плакат, штендер, пиллар, лайтбокс, бренд-зона, панель-кронштейн.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29].

	Тема 2. Разработка концепции бренда. Целевая аудитория: определение и анализ.
Концепция бренда. Целевая аудитория. Нейминг. Логотип. Фирменные гарнитуры. Рекламный слоган. Маркетинговая ценность слогана. Корпоративный герой(маскот). Фирменный блок, фирменное наименование, брендбук, бриф, гайдлайн.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29]

	Тема 3. Бренд-стратегии создания продукта.
Понятие стратегии бренда. Цели. Задачи. Основные принятые стратегии брендинга. Ключевые составляющие бренд-стратегии. Уровни бренда, позиционирование, целевая аудитория, цели стратегии, взаимодействие с рынком.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29]

	Тема 4. Разработка дизайна pos-материалов.
Заголовок в рекламе. POS-материалы, леттеринг, плакат, реклама, носитель, панель-кронштейн, штендер, стоппер, мобайл, пиллар.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29]

	Тема 5. Графическо-информационные объекты как пространственно-временная коммуникационная система. 
Психофизические свойства цвета. Шрифт и цвет в фирменном стиле. Составляющие фирменного стиля. Носители фирменного стиля – составляющие имиджа.
Литература: [1— С. 45-48; 2 — С. 16-17; 3 — С.104-136; 146-154; 4 — С. 87-101; 108-114] 


6.2 Практические задания


РАЗДЕЛ I. ПРИМЕНЕНИЕ СТИЛИСТИЧЕСКИХ ОСОБЕННОСТЕЙ ПРИ РАЗРАБОТКЕ ГРАФИЧЕСКОГО ПРОЕКТА
(I СЕМЕСТР)

Тема 1. Стилистика эпох. 
1. Стилистика эпох.  
2. Композиция как средство художественной выразительности.  
3. Зрительное восприятие формы и пространства.  
4. Средства-материалы.  
5. Точка-линия-плоскость.

Термины: стилистика, композиция, целостность, взаимозависимость элементов, композиционная равновесие, симметрия, асимметрия, закономерности композиции, фактура, текстура, зрительное восприятие, средства-материалы, точка, линия, плоскость. 

Литература: [1 - С. 40-46; 2- С.9-10; 4 – С. 3-7; 5 – С.97-106.; 5- С.9-109; 7-  С.25-30]
Практическое занятие 1. Образная композиция на основе объекта окружающей среды.
Выполнить:  
1. На основе формы объекта окружающей среды создать графическую композицию, превратив начальную линию в один или несколько образов на свободную тему, связанную с особенностями характера, увлечениями или личными особенностями. 
2. На плотной бумаге формата А4 изобразить форму выбранного объекта.
3. Начальная линия должна явно проглядываться в композиции, хотя образы можно создавать, используя как внутреннее пространство абриса, так и внешнее. 
Описание: графическая цветная или черно-белая композиция. Формат А4. Техника исполнения свободная. 
Материалы: простые или цветные карандаши, акварель, акрил, гуашь, тушь и тд.

Практическое занятие 3. Упражнение на ассоциативное представление «Точка-линия-плоскость». Собственные ассоциации.
Выполнить:  
1. Заполнить таблицу соответствующими изображениями по заданной схеме, руководствуясь собственными (личными) ассоциациями. Необходимо выразить отдельно линией, формой (пятном), текстурой (плоскостью) ряд абстрактных признаков, раскрывающих 7 ваших личностных характеристик, как положительных, так и отрицательных. 
2. В работе не использовать изображения предметов и явлений реального мира. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения свободная. 
Материалы: перо, тушь, линер, рапидограф.


Тема 2. Персонифицированный индивидуальный образ
1. Искусство силуэта.  
2. История костюма.   
3. Создание персонифицированного индивидуального образа в заданной стилистике. 

Термины: стилистика, стилизация, композиция, целостность, взаимозависимость элементов, 	композиционная 	равновесие, 	симметрия, 	асимметрия, 	закономерности композиции, фактура, текстура, зрительное восприятие, средства-материалы, точка, линия, плоскость, костюм, персонифицированный образ. 

Литература: [1 - С. 40-46; 2 - С.9-10; 5- С.9-109; 10 – С.10-160]
Практическое занятие 5. Создание собственного силуэта.
Выполнить:  
1. Создать в векторной программе изображение собственного силуэта. 
2. Создать декоративное обрамление силуэту.  
3. Изобразить в векторном редакторе личную подпись (знак). 
4. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная черно-белая печать.

Практическое занятие 7. Стилизация «Костюм эпохи».
Выполнить:  
1.   Изобразить в векторной программе себя в определенной позе, одетым в костюм выбранной эпохи. 
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная черно-белая печать.  
 
Тема 3. Виды проектно-графических изображений 
1. История орнамента. Историческая классификация орнаментов.  
2. Стилихация. Основные правила построения разновидностей изобразительных элементов. 
3. Разновидности знаков: изобразительные (абстрактные и изобразительные), словесные, комбинированные, объемные.  
4. Монограмма. Инициал. Вензель. Буквица.  
5. Экслибрис. Книжный знак. 

Термины: орнамент, знак, абстрактный знак, словесный знак, комбинированный знак, объемный знак, монограмма, инициал, вензель, буквица, экслибрис, книжный знак.

Литература: [2. - С.9-10; 5 – С.97-106;. 7-  С.25-30 ]

Практическое занятие 8. Стилизация «Растение – птица – животное».
Выполнить:  
1. Создать в векторной программе стилизации (растение – птица – животное): натуральный вид/орнаментально-линейная манера/стилизация объекта и угловатых форм/ стилизация объекта из округлых форм.
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения — векторная графика, работа в материале.
Материалы: бумага формата А4, принтерная черно-белая печать.

Практическое занятие 9. Шрифтовой экслибрис.
Выполнить:  
1. Создать в векторной программе шрифтовой экслибрис (книжный знак) с использованием шрифтов и декоративно-орнаментальных элементов выбранной эпохи. 
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная черно-белая печать. 
 

РАЗДЕЛ II. СОЗДАНИЕ ГРАФИЧЕСКОГО ПРОЕКТА В СТИЛИСТИКЕ XX-XXI ВЕКОВ
(II СЕМЕСТР)
 
Тема 4. Стилистика ХХ –ХХI веков. 
1. Стилистика изобразительного искусства ХХ –ХХI вв.  
2. Векторный портрет.  
Термины: изобразительное искусство ХХ –ХХI вв., авангард, авангардизм, модернизм, фовизм, примитивизм, кубизм, футуризм, кубофутуризм, дадаизм, супрематизм, лучизм, орфизм, пуризм, экспрессионизм, конструктивизм, неопластицизм, функционализм, баухауз, абстрактный экспрессионизм, постживописная абстракция, искусство аутсайдеров, бедное искусство, кинетическое искусство, флуксус, поп арт, оп арт, минимализм, концептуализм, искусство действия, гиперреализм, спациализм, неодадаизм, неоэкспрссионизм, постмодернизм, деконструктивизм, ретривализм, провокация,  инсталляция, автоматическое письмо, коллаж, перформанс, хеппенинг, энвайроумент, флешмоб, нетарт, видеоарт, синтетическое искусство. 

Литература: [1 - С. 40-46;; 2- С.9-10;]
Практическое занятие 10. Векторный портрет.
Выполнить:  
1. Собственный векторный портрет в 3/4 в цвете. 
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая цветная композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная цветная печать. 
 
Тема 5. Создание социального образа. 
1. Понятие «знак-морфем» (логотип) и «знак-символ» (эмблема).  
2. Этапы подготовки эмблемы.  
3. Формально-композиционные средства.  
4. Пиктограммы.  
5. Создание изобразительного знака (идеограммы).  
6. Разработка словесного знака (логограммы).  

Термины: знак-морфем, знак-символ, логотип, эмблема, пиктограмма, идеограмма, логограмма, личный знак. 

Литература: [2- С.9-10; 13 – С.48-51.]
Практическое занятие 11. Личный знак. 
Выполнить: 
1. Создать личный знак (по 3 варианта):
  -         на основе собственной подписи (почерка); 
· на основе собственных инициалов; 
· с узнаваемыми знаковыми элементами своей профессии; 
· на основе личных увлечений (занятия, хобби: музыка, кино, литература, молодежные течения, мода и т.д.); 
· на основе ассоциаций с животным, птицей, растением, объектом, предметом, техникой…
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя.
Описание: графическая цветная композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная цветная печать.

Тема 6. Серийные объекты 
1. Взаимосвязь и взаимозависимость функции и формы.  
2. Взаимосвязь и взаимозависимость художественного образа и формы.  
3. Серийные объекты. Этапы подготовки серийных объектов.  
4. Объемно-графическая модель на заданную тему. 

Термины: функция, форма, художественный образ, серийный объект, объемнографическая модель.

Литература: [2- С.9-10;   — С.7-8; 83-85;   — С. 3-5: 7-  С.25-30]

Практическое занятие 13. Серийные объекты.
Выполнить: 
1. Обложка перекидного календаря в выбранной стилистике на тему течения, направления ХХ-ХХI века. Но обложке должны быть тема календаря, год, изобразительный элемент, эмблема академии. 
2. Один лист перекидного календаря с любым месяцем в выбранной стилистике на тему течения, направления ХХ-ХХI века. На листе должны быть изобразительный элемент, календарная сетка, слоган или рекламный заголовок. 
Описание: графическая цветная композиция. Формат А4. Техника исполнения — векторная графика.

РАЗДЕЛ III.СЕРИЙНЫЕ ОБЪЕКТЫ В ГРАФИЧЕСКОМ ДИЗАЙНЕ 
(III СЕМЕСТР)
 
Тема 1. Принцип серийности в графическом дизайне 
1. Понятие серийности. 
2. Графические серии.
3. Признаки серии.
4. Моносерии и мультисерии.
 
Термины: серийность объектов, графические серии, синтаксические, семантические и прагматические функции серийных графических изображений, признаки серии, инвариантный, вариационный принцип построения изображений при серийном типе визуализации смысла в графическом дизайне, моносерия, мультисерия. 
Выполнить:  
1. Изучить основную и дополнительную литературу по теме. 
2. Подготовиться к устному опросу по теме «Принцип серийности в графическом дизайне» 
 
Литература: [1 (С. – 3-5), 2 (С. – 12-62), 5 (С. – 7-71), 7 (С. – 9-21)] 
 
Тема 2. Серийные объекты в графическом дизайне
1. Серия почтовых марок. 
2. Серия этикеток. 
3. Книжная серия. 
4. Игральные карты. 
5. Спичечные этикетки. 
6. Серия карманных календарей. 
7. Серия открыток. 
 
Термины: серия почтовых марок, серия этикеток, книжная серия, авторская серия, игральные карты, спичечные этикетки, филумения, серия карманных календарей, серия открыток. 
Выполнить:  
1. Изучить основную и дополнительную литературу по теме. 
2. Подготовиться к устному опросу по теме «Серийные объекты в графическом дизайне».
 
Литература: [1 (С. – 3-5), 2 (С. – 12-62), 5 (С. – 7-71), 7 (С. – 9-21), 22, 23, 25, 26, 27] 
Тема 3. Серийный объект – открытка 
1. Деление открыток по предназначению.
2. Деление открыток по технике исполнения.
3. Художественные и документальные открытки.
4. Типы открыток.
5. Композиционно-графическая модель серии.
6. Имитация художественных техник в растровой программе.
 
Термины: стандартные маркированные почтовые карточки, иллюстрированные маркированные почтовые карточки, специального назначения маркированные почтовые карточки, немаркированные почтовые карточки, художественные и документальные открытки, композиционно-графическая модель серии.  
Выполнить:  
Графическую серию в виде набора открыток на одну из предложенных тем. Для этого необходимо: 
· изучить аналогичные серии; 
· при необходимости выполнить фотосъемку архитектурных объектов, выбрав одну из тем серии; 
· при необходимости произвести художественную обработку фотографий;
· при необходимости выполнить иллюстрации;
· разработать серию открыток и упаковку для серии;
· распечатать в цвете в нужном формате.  
 
Литература: [16 (С. – 65-109), 19 (С. – 86-96), 21 (С. – 56-76),  23, 25, 28, 29, 30] 
 
Тема 4. Серийный объект – почтовая марка 
1. Серия почтовых марок.
2. Типы серий.
3. Проект почтовой марки.
4. Этапы создания марки художником.
 
Термины: серия почтовых марок, «омнибусная» серия, идентичная серия, перманентная серия, смешанная серия, эссе, высокая печать, глубокая печать, плоская печать, коммеморативная марка, штемпель гашения.  
Выполнить:  Создать серию коммеморативной марки на предложенную тему. 
 
Литература: [3  (С. – 4-8), 4 (С. –5-119), 5 (С. –8-21), 6 (С. –5-55), 16 (С. – 65-109) 22, 26, 27] 
 
РАЗДЕЛ IV. РАЗРАБОТКА СИСТЕМЫ ВИЗУАЛЬНОЙ ИДЕНТИФИКАЦИИ
(IV СЕМЕСТР) 
Тема 5. Фирменный знак, логотип 
1. Понятие фирменного стиля, его задачи и функции.
2. Основные составляющие фирменного стиля.
3. Каким же должен быть современный фирменный стиль?
 
Термины: фирменный стиль, графический фирменный стиль, функции фирменного стиля, средства формирования образа фирмы, основные элементы графического фирменного стиля, логотип, торговый знак, фирменное сочетание цветов, фирменный шрифт, схема верстки, слоган, рекламный символ фирмы.  
Выполнить:  
1. Изучить основную и дополнительную литературу по теме. 
2. Подготовиться к устному опросу по теме «Фирменный знак, логотип» 
 
Литература: [10  (С. – 98-127), 11 (С. –9-22), 13 (С. – 52-57), 18 (С. – 183-190)] 
Тема 6. Фирменный блок 
1. Товарный знак.
2. Фирменная шрифтовая надпись (логотип).
3. Фирменный лозунг (слоган).
4. Фирменный цвет.
5. Фирменный комплект шрифтов.
 
Термины: константа основных составляющих фирменного стиля, фирменный цвет, фирменный шрифт, логотип, слоган, основные функции товарного знака, типы товарных знаков, функции логотипа, корпоративный герой, постоянный коммуникатор.  
Выполнить:  
1. Разработать фирменный знак и логотип на основе названия фирмы. Гармонично связать изобразительный и шрифтовой элементы.  
2. Разработать варианты динамического фирменного знака в системе визуальной идентификации.  
Варианты фирм:
1. Фирменный стиль магазина компьютерной техники;
2. Фирменный стиль магазина одежды;
3. Фирменный стиль ювелирного магазина; 
4. Фирменный стиль турбюро;
5. Фирменный стиль ресторана;
6. Фирменный стиль фито-аптеки.
 
Литература: [ 8 (С. – 4-33), 9  (С. – 7-105), 11 (С. – 4-24, 80-120), 18 (С. – 182-202), 33, 34] 
 
Тема 7. Разработка корпоративной идентификации 
1. Этапы создания логотипа.
2. Создание композиции.
3. Подбор шрифта.
4. Подбор размера.
5. Учёт удобочитаемости.
6. Подбор цвета.
7. Технические ограничения.
8. Разработка визитки.
 
Термины: этапы создания логотипа, композиция логотипа, подбор шрифта, подбор размера, удобочитаемость, подбор цвета, технические ограничения, бриф, стилеобразующие константы, фирменные цвета, цветовая гамма, цветовая символика, ассоциации, сочетаемость шрифтов, ритм в шрифтовых композициях, модульные сетки. 
Выполнить: 
1. Разработку фирменного блока элементов делопроизводства: фирменные бланки (для международной переписки, для коммерческого письма, для приказов, для внутренней переписки и т. д.), фирменные конверты, фирменные папки-регистраторы, фирменные записные книжки, фирменные ежедневники, фирменные блоки бумаг для записей, визитки.  
Литература: [15 (С. – 15-77), 20 (С. – 148-170), 18 (С. – 143-161, 202-207), 33,34] 
Тема 8. Разработка рекламных носителей фирменного стиля 
1. Рекламные носители фирменного стиля 
2. Brandbook  
3. Основные понятия брендинга 
 
Термины: рекламная печатная продукция, флаер, лифлет, буклет, рекламный плакат, каталог, наружная реклама, вывеска, штендер, пилон, баннер, брендмауер, лайтбокс, POS-материалы, диспенсер, мобайл, вобблер, муляж, фриджи, стикеры, кубарик, плакат, листовка, проспект, календарь, функциональность рекламно-информационных средств, композиционная структура, целевая аудитория, эмоциональное воздействие, сувенирная продукция, открытки, значки, магниты, упаковка, пакеты, сумки, фирменная упаковочная бумага.  
Выполнить: 
1. Разработку рекламных носителей фирменного стиля. Рекламная печатная продукция: флаер, буклет, рекламный плакат. Наружная реклама: вывеска, баннер, брендмауер. 
2. Разработку сувенирной продукции. Открытки. Значки. Магниты. Письменные принадлежности. 
3. Разработку упаковки. Пакеты, сумки. Фирменная упаковочная бумага.  
 
Литература: [  17 (С. – 6-35)   18 (С. – 123-163, 207-223), 33, 34]


РАЗДЕЛ V. СОЗДАНИЕ МАКЕТОВ КНИЖНЫХ ИЗДАНИЙ В ПРОЦЕССЕ ИЗУЧЕНИЯ ПРОГРАММЫ МНОГОСТРАНИЧНОЙ ВЕРСТКИ
(V СЕМЕСТР) 
Тема 1. Книжное издание.
1. Анатомия книги. 
2. Макетирование страницы. 
3. Особенности верстки прозы и поэзии. 
4. Форматы книжных изданий. 
5. Служебные части книжных изданий и правила их верстки

Термины: колонтитул, колонлинейка, пагинация, контртитул, сигнатура, авантитул, глава, ISBN, фронтиспис, норма, нахзац, форзац, брошюра, переплет, мягкая обложка, суперобложка, сигнет, распашной титул, инкунабулы, книжный блок, корешок, каптал, крышка, двухступенчатый колонтитул, сторонки, шпация, отстав, расстав, рубчик, короб, клапан, ляссе, кант, фортитул, выходные сведения, выпускные данные, надвыпускные данные.

Практическое занятие №1
Макетирование и иллюстрирование книжного издания (прозы)

Выполнить:
1. Создать общую концепцию книжного издания (прозы).
2. Создание концепцию обложки книжного издания (прозы).

Литература: [21— С. 9-120; 10 — С. 17-86; 14 — С.19-39; 51-79; 11 — С. 11-243; 22 — С. 17-122]

Тема 2. Макетирование и подготовка в печать многостраничных книжных изданий.

1. Подобрать цветовую гамму для иллюстраций книжного издания.
2. Выполнить отрисовку иллюстраций для книжного издания.
3. Произвести разверстку иллюстраций по полосам книжного издания. 
4. Создание спуска полос макета многостраничной верстки

Термины: колофон, предисловие, постоянный колонтитул, переменный колонтитул, часть, раздел, шмуцтитул, глава, параграф, сноска, комментарий, ссылка, научное издание, научно-популярное издание, производственно-практическое издание, нормативное производственно-практическое издание, учебное издание, справочное издание, издание для досуга, рекламное издание, литературно-художественное издание.
Практическое занятие №2
Макетирование и иллюстрирование книжного издания (поэзии)
Выполнить:
1. Создать общую концепцию книжного издания (поэзии).
2. Создание концепцию обложки книжного издания (поэзии).
3. Произвести шрифтоподбор для книжного издания (поэзии).
4. Выполнить макетирование обложки книжного издания (поэзии). 
5. Создать эскиз модульной сетки книжного издания (поэзии).
6. Сверстать титульный лист книжного издания (поэзии).
7. Выставить колонцифры и разверстать колонтитулы книжного издания (поэзии).
8. Разверстать текстовый материал книжного издания (поэзии).
9. Выполнить эскизы иллюстраций для книжного издания (поэзии).

Литература: [21— С. 120-164; 10 — С. 87-231; 14 — С.81-96; 99-103; 198-201; 283-288; 11 — С. 262-364; 22 — С. 123-237]

РАЗДЕЛ VI. ПРОЕКТИРОВАНИЕ В ВЕКТОРНОМ ГРАФИЧЕСКОМ РЕДАКТОРЕ
(VI СЕМЕСТР)

Тема 3. Знакомство с рабочей средой. Выделение и выравнивание. Создание и редактирование фигур

1. Обзор рабочей среды
2. Изменение режима просмотра иллюстрации
3. Навигация по нескольким монтажным областям
4. Использование палитры Navigator
5. Поиск ресурсов при работе с векторным редактором.
6. Выделение объектов
7. Выравнивание объектов
8. Управление группами объектов
9. Упорядочивание объектов
10. Скрытие объектов
11. Применение методов выделения
12. Создание нового документа
13. Работа с базовыми фигурами
14. Комбинирование и редактирование фигур
15. Трассировка изображений для создания фигур

Практическое занятие №3
Создание в векторной программе концепции листовки формата А6 (2 +2), подготовленной под печать на ризографе и разложенной на формате А3

Термины: векторное изображение, растровое изображение, пиксель, кривые Безье, слой, разрешение, векторный редактор, растровый редактор, меню просмотра, палитра Layers, палитра Navigator, инструмент Selection, цветоделение, ризография, препресс, постпресс.

Выполнить:
1.	Рассмотреть один из популярных способов печати на ризографе. 
2.	Определить роль раздаточного материала в полиграфическом блоке носителей для фирменных стилей. 
3.	Научиться создавать макеты к этому виду печати. 
4.	Ознакомиться с приемами расположения основных и второстепенных элементов в подобного рода листовках и со средствами акцентирования на главном в ней.
5.	Создать новый файл формата А3.
6.	Создать эскиз макет в два цвета (лицо и оборот) рекламной листовки предприятия или магазина формата А6 под печать на ризографе. На обороте расположить карту проезда.
7.	Листовка должна иметь объекты, которые не доходят к краям листовки на 5 мм.
8.	Листовка не должна иметь объекты разных цветов, которые находятся близко один к другому.

Литература: [1— С. 64-165; 2 — С. 58-166; 7 — С.28-40; 83-85; 8 — С. 26-46]

Практическое занятие №4
Отрисовка с трех предоставленных растровых изображений логотипов трех векторных логотипов и создание с ними трех визиток, подготовленных к шелкотрафаретному виду печати

Термины: выбивка (knockout), вырезка (slice), групповой объект, заливка, комбинированный объект, обводка, поле обрезки, рабочее пространство (working space), равномерная заливка, расширение контура, палитра Pathfinder, палитра Align, палитра Transform, расширение оболочки, трансформационные маркеры, цветовая модель.

Выполнить:
1. Научиться использовать инструменты графических примитивов в программе.
2.	Создать файл формата А4.
3.	Поместить в файл растровые изображения логотипов.
4.	Отрисовать каждый логотип в векторе.
5.	Все нарисованные контуры перевести в объекты.
4.	Создать для каждого логотипа визитку, в которой использовать только цвета логотипа.

Литература: [1— С. 64-165; 2 — С. 58-166; 7 — С.28-40; 83-85; 8 — С. 26-46]

Тема 4. Трансформирование объектов. Рисование с помощью инструментов Pen и Pencil. Цвет и работа с ним в программе

1. Управление монтажными областями
2. Трансформирование объектов
3. Точное позиционирование объектов
4. Создание прямых линий
5. Создание криволинейных контуров
6. Рисование кривых
7. Редактирование кривых
8. Рисование с помощью инструмента Pencil
9. Представление о цвете
10. Создание цвета
11. Работа с быстрой заливкой.

Практическое занятие №5
Первичная отрисовка в векторной программе натюрморта с помощью инструмента «градиентная сетка»

Термины: векторное изображение, векторный контур, градиентная заливка, заливка по сетке, изобразительный эффект, комплексное изображение, инструмент Pencil, инструмент Pen, маска непрозрачности (opacity mask), обрезная маска (clipping mask), опорная точка, растрирование, слой,  текстура.

Выполнить:
1. Создание файла формата Latter.
2. Поместить в файл растровое изображение натюрморта.
3. Закрепить помещенное изображение.
4. С помощью инструментов Pen и графических примитивов последовательно отрисовать каждый элемент натюрморта, задавая цвет с помощью инструмента градиентной сетки, отсекающую маску и маску прозрачности.
5. Использовать для ускорения процесса отрисовки эффекты трансформирования.
6.  После процесса отрисовки, если были использованные эффекты трансформирования, расширить эти эффекты.
7. Для создания более реалистичных объектов применение фильтров программы.
8. Допустимые приемы для подготовки в печать созданного макета с помощью инструмента „градиентная сетка” и примененных эффектов. 
9. Встроить растровое изображение в файл.

Литература: [1— С. 168-284; 2 — С. 170-286; 7 — С.250-281; 434-447; 8 — С. 240-267; 414-426]

Тема 5. Работа с текстом. Работа со слоями. Создание переходов между цветами и фигурами

1. Работа с текстом
2. Форматирование текста
3. Создание и использование стилей текста
4. Создание слоев
5. Закрепление слоев
6. Просмотр слоев
7. Вставка слоев
8. Создание обтравочных масок
9. Объединение слоев
10. Поиск слоев
11. Применение к слоям атрибутов оформления
12. Работа с градиентами

Практическое занятие №6
Создание концепции автопортрета в технике оп-арт с помощью кириллического текста. Создание в программе структуры автопортрета в технике оп-арт. 

Термины: выключка, свойства текста, инструмент Blend, импорт текстовых файлов, текста вдоль контура, текст фигурный, глифы, кегль, кернинг, направляющая, объект перехода, рабочий лист (artboard), текстовая дорожка, текстовая оборка, текстовый блок, текстовый стиль, трекинг, шрифт, гарнитура шрифта.

Выполнить:

1. Создать файл формата Latter.
2. Поместить в созданный файл фото с собственным изображением.
3. Закрепить фото и используя инструменты текста, отрисовать автопортрет в технике оп-арт.
4. При создании автопортрета можно использовать инструменты группы Pen, кисти, фильтры и эффекты группы Warp, а также наложения градиентной сетки (меш).
5. Для увеличения эффекта объема использовать разный кегль символов и палитру Color.

Литература: [1— С. 288-418; 2 — С. 290-422; 7 — С.106-140; 222-246; 8 — С. 110-143; 218-237]

Тема 6. Работа с кистями. Применение эффектов. Работа с символами

1. Работа с кистями
2. Использование каллиграфических кистей
3. Использование объектных кистей
4. Использование кистей из щетины
5. Использование узорчатых кистей
6. Изменение атрибутов цвета кистей
7. Работа с инструментом Blob Brush

Практическое занятие №7
Создание макета-эскиза черно-белого автопортрета (имитация туши), выполненного с помощью функции трассирования и кистей в векторном редакторе 

Термины: графический стиль, профиль кисти, растровое изображение, символ, слои оформления, инструментом Blob Brush, каллиграфическая кист, щетинная кисть, узорчатая кисть, объектная кисть, функция Expand, функция Expand Appearance, палитра редактирования эффектов Appearance, растровый эффект, векторный эффект.

Выполнить:
1. Поместить растровое изображение автопортрета.
2. С помощью настроек трассирования и кистей программы сымитировать в программе технику туши.
3. Полученный результат упростить и разгруппировать.

Литература: [1— С. 422-583; 2 — С. 426-553; 7 — С. 352-370; 374-405; 8 — С. 334-352; 356-386] 

Практическое занятие №8
Создание макета-эскиза цветного автопортрета (имитация акварели), выполненного с помощью функции трассирования и кистей в векторном редакторе

Термины: инструмент Lasso, контур, путь, встроенное изображение, помещенное изображение, растровое изображение, палитра Stroke, образец цвета, инструмент Brush, инструмент Pen, инструмент частичного выделения, редактирование узлов, меню эффектов, символ, слои оформления, инструментом Blob Brush.

Выполнить:
1. Поместить растровое изображение автопортрета.
2. С помощью настроек трассирования и кистей программы сымитировать в программе технику акварели.
3. Полученный результат упростить и разгруппировать. Упражнения на выравнивание объектов с помощью диалогового окна Align and Distribute.

Литература: [1— С. 422-583; 2 — С. 426-553; 7 — С. 352-370; 374-405; 8 — С. 334-352; 356-386]

РАЗДЕЛ VII. СОЗДАНИЕ ИНДИВИДУАЛЬНОГО ОБРАЗА ОБЪЕКТА В РЕКЛАМЕ
(VII СЕМЕСТР)

Тема 1. 	POS-материалы в маркетинге: виды и правила разработки.   
1. POS-материалы. Основные понятия. Классификация. Функции.
2. Анализ различных видов рекламной продукции.
3. Особенности размещения pos-материалов.
4. 
Практическое занятие № 1
Создание и защита презентации по теме «POS-материалы в маркетинге (на основе известных брендов)»

Выполнить: 
1. Произвести сбор и анализ аналогов pos-материалов известных брендов(классификация, функции). 
2. Создать презентацию по заданной теме. 
3. Защита презентации по заданной теме. 
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29].
 
Тема 2. Разработка концепции бренда. Целевая аудитория: определение и анализ.
1. Бренд. Брендинг.
2. Определение целевой аудитории. 
3. Нейминг. Слоган.
4. Графический знак.  
5. Логотип, цветовая гамма, шрифты, стилеобразующие элементы.
6. Маскот.

Практическое занятие № 2
Разработать концепцию бренда

Выполнить: 
1. Произвести сбор и анализ аналогов современных брендов. 
2. Создать общую концепцию бренда (нейминг, слоган, логотип, фирменные гарнитуры, маскот).
3. Выполнить эскизы (не менее 10). 
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29] 

Тема 3. Бренд-стратегии создания продукта.
1. Понятие стратегии бренда. Цели. Задачи.
2. Основные принятые стратегии брендинга.
3. Ключевые составляющие бренд-стратегии.

Практическое занятие № 3
Создание и защита презентации по теме «Типы стратегий брендинга и их составляющие»

Выполнить: 
4. Произвести сбор и анализ информации по заданной теме. 
5. Создать презентацию по заданной теме. 
6. Защита презентации по заданной теме. 
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29] 

Тема 4. Разработка дизайна pos-материалов.
1. Информационно-рекламная продукция.
2. Шелфтокер. Рекламный плакат.
3. Некхенгер. Воблер. Листовка.

Практическое занятие № 4.1
Создание концепции шелфтокера

Выполнить: 
1. Произвести сбор и анализ аналогов шелфтокеров. 
2. Создать общую концепцию шелфтокера для бренда.
3. Выполнить эскиз шелфтокера. 
4. На базе созданной концепции шелфтокера создать макетирование и сборку шелфтокера для бренда. 
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29]
 
Практическое занятие № 4.2
Создание концепции рекламного плаката

Выполнить: 
1. Произвести сбор и анализ аналогов рекламных плакатов. 
2. Создать общую концепцию рекламного плаката.
3. Выполнить эскиз рекламного плаката. 
4. На базе созданной концепции плаката создать макетирование и сборку рекламного плаката для компании сильногазированных напитков. 
Литература: [1— С. 87-96; 2 — С. 16-23; 3 — С.83-93; 4 — С. 38-45] 

Практическое занятие № 4.3
Создание концепции ценника (некхенгер)

Выполнить: 
1. Произвести сбор и анализ аналогов ценников. 
2. Создать общую концепцию ценника для бренда.
3. Выполнить эскиз ценника. 
4. На базе созданной концепции ценника создать макетирование и сборку ценника для бренда.
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65]

Практическое занятие № 4.4
Создание концепции воблера

Выполнить: 
1. Произвести сбор и анализ аналогов воблеров. 
2. Создать общую концепцию воблера для бренда.
3. Выполнить эскиз воблера. 
4. На базе созданной концепции воблера создать макетирование и сборку воблера для бренда.
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65]

Практическое занятие № 4.5
Создание концепции листовки

Выполнить: 
1. Произвести сбор и анализ аналогов листовок. 
2. Создать общую концепцию листовки для бренда.
3. Выполнить эскиз листовки. 
4. На базе созданной концепции воблера создать макетирование и сборку листовки для бренда.
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65]

Тема 5. Графическо-информационные объекты как единая пространственно-временная коммуникационная система. Психофизические свойства цвета. 
 
1. Шрифт и цвет в айдентике.  
2. Составляющие айдентики.  
3. Носители айдентики – составляющие имиджа.
4. 
Практическое занятие №5.1
Создание концепции стоппера

Выполнить: 
5. Произвести сбор и анализ аналогов стопперов. 
6. Создать общую концепцию стоппера для бренда.
7. Выполнить эскиз стоппера. 
8. На базе созданной концепции стоппера создать макетирование и сборку стоппера для бренда. 
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65] 

Практическое занятие №5.2
Создание концепции мобайла

Выполнить: 
5. Произвести сбор и анализ аналогов мобайлов. 
6. Создать общую концепцию мобайла для бренда.
7. Выполнить эскиз мобайла. 
8. На базе созданной концепции мобайла создать макетирование и сборку мобайла для бренда.
Литература: [1— С. 38-51; 2 — С. 26-27; 3 — С.137-142; 4 — С. 72-84]

Практическое занятие №5.3
Создание концепции пиллара

Выполнить: 
1. Произвести сбор и анализ аналогов пилларов. 
2. Создать общую концепцию пиллара для бренда.
3. Выполнить эскиз пиллара. 
4. На базе созданной концепции пиллара создать макетирование и сборку пиллара для бренда.
Литература: [1— С. 38-51; 2 — С. 26-27; 3 — С.137-142; 4 — С. 72-84]

Практическое занятие №5.4
Создание концепции панель-кронштейна

Выполнить: 
1. Произвести сбор и анализ аналогов панель-кронштейнов. 
2. Создать общую концепцию панель-кронштейна для бренда.
3. Выполнить эскиз панель-кронштейна. 
4. На базе созданной концепции панель-кронштейна создать макетирование и сборку панель-кронштейна для бренда.
Литература: [1— С. 38-51; 2 — С. 26-27; 3 — С.137-142; 4 — С. 72-84]

Практическое занятие №5.5
Создание концепции итоговой экспозиции с POS-материалами, выполненными за семестр

Выполнить: 
1. Подготовить изображения созданных POS-материалов с необходимыми параметрами для создания показательной итоговой семестровой экспозиции. 
2. Создать общую концепцию экспозиции с изображениями POS-материалов для бренда. 
3. Выполнить эскиз экспозиции с изображениями POS-материалов для бренда.
4. Выполнить макетирование и сборку экспозиции с изображениями POS-материалов для бренда. 
Литература: [1— С. 45-48; 2 — С. 16-17; 3 — С.104-136; 146-154; 4 — С. 87-101; 108-114] 
 

7. СОДЕРЖАНИЕ САМОСТОЯТЕЛЬНОЙ РАБОТЫ
Целью проведения самостоятельной работы является получение студентами теоретических знаний в области проектирования, композиции, а также практических навыков работы в прикладных графических программах векторной и растровой графики. Применение этих навыков при создании художественного образа от авторского эскиза до оригинал-макета, что является последним связующим звеном между художником и производством.  
Самостоятельная работа студентов предназначена для внеаудиторной работы по закреплению теоретического курса и практических навыков дисциплины; по изучению дополнительных разделов дисциплины, а также включает:
· подготовку к проекту (подбор прототипов, разработка эскизов);
· утверждение графических решений и отработку стилистики;
· разработку проекта на заданную тему и в заданной форме представления;
· подготовку проекта к печати;
· пробную распечатку и печать в требуемой цветовой модели соответствующего формата.
В течение всего I семестра студенты готовят материалы и самостоятельно выполняют задание в программе векторной графики, согласно варианту, для комплексной (совместно с дисциплиной «Компьютерная графика») работы «Стилистика исторических эпох».
В течение всего II семестра студенты готовят материалы и самостоятельно выполняют задание в программах векторной и растровой графики, согласно варианту, для комплексной (совместно с дисциплиной «Компьютерная графика») работы «Стилистика XX-XXI веков».
В III семестре студенты самостоятельно разрабатывают серию почтовых открыток и серию почтовых марок.
В течение всего IV семестра студенты готовят материалы и самостоятельно выполняют задание в программах векторной и растровой графики, согласно варианту, для работы «Фирменный стиль».
В течение всего V семестра студенты готовят материалы и самостоятельно выполняют работу в программе многостраничной верстки и графических редакторах по созданию книжных изданий и иллюстраций к ним.
В течение всего VI семестра студенты готовят материалы и самостоятельно выполняют задание в программе векторной графики.
В течение всего VII семестра студенты готовят материалы и самостоятельно выполняют задание по созданию оригинал-макетов ряда POS-материалов, согласно заданной теме.

7.1. ТЕМЫ И ЗАДАНИЯ ДЛЯ САМОСТОЯТЕЛЬНЫХ ЗАНЯТИЙ

РАЗДЕЛ I. ПРИМЕНЕНИЕ СТИЛИСТИЧЕСКИХ ОСОБЕННОСТЕЙ ПРИ РАЗРАБОТКЕ ГРАФИЧЕСКОГО ПРОЕКТА
(I СЕМЕСТР)

Тема 1. Стилистика эпох. 
1. Стилистика эпох.  
2. Композиция как средство художественной выразительности.  
3. Зрительное восприятие формы и пространства.  
4. Средства-материалы.  
5. Точка-линия-плоскость.

Термины: стилистика, композиция, целостность, взаимозависимость элементов, композиционная равновесие, симметрия, асимметрия, закономерности композиции, фактура, текстура, зрительное восприятие, средства-материалы, точка, линия, плоскость. 

Литература: [1 - С. 40-46; 2- С.9-10; 4 – С. 3-7; 5 – С.97-106.; 5- С.9-109; 7-  С.25-30]

Практическое занятие 2
Абстрактная композиция на основе объекта окружающей среды

Выполнить:  
1. На основе формы объекта окружающей среды создать абстрактную графическую композицию.  
2. Начальный абрис создаёт замкнутое пространство, которое нужно организовать любым образом, не выходя за пределы контура. Возможен вариант сквозного прорезания абриса с последующей подкладкой снизу текстурной подложки. 
3. Абрис разместить в оптическом центре заданного формата.  
4. Это задание является своеобразным тестом на понимание понятия абстрактного и его отличия от создания конкретных, реальных образов. Понятие абстрактного противопоставляется конкретному. В абстрактных композициях не используются изображения предметов и явлений реального мира, а организовываются хаотические или упорядоченные поверхности из точек, пятен, линий или пространственные конструкции из точек, линейных, геометрических форм, поверхностей, объемов. 
Описание: графическая цветная или черно-белая композиция. Формат А4. Техника исполнения свободная. 
Материалы: простые или цветные карандаши, акварель, акрил, гуашь, тушь и тд. 
 
Практическое занятие 4
 Упражнение на ассоциативное представление «Точка-линия-плоскость». Ассоциации эпохи
Выполнить:  
1. Найти в литературе или других источниках сведения о стилистике эпох. Проанализировать стилевые особенности предложенной временной эпохи и выявить наиболее характерные типы линий, форм (пятен), текстур (плоскостей).  
2. Заполнить таблицу соответствующими изображениями по заданной схеме, руководствуясь найденным материалом, связанным со стилистикой эпох. Необходимо выразить отдельно линией, формой (пятном), текстурой (плоскостью) характерные черты стилистики предложенной эпохи.   
3. Дать историческую и временную характеристику и составить семантическое описание каждого изображения.  
4. Написать реферат на тему выбранного стиля эпохи.
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения свободная. 
Материалы: перо, тушь, линер, рапидограф.  

Тема 2. Персонифицированный индивидуальный образ
1. Искусство силуэта.  
2. История костюма.   
3. Создание персонифицированного индивидуального образа в заданной стилистике. 

Термины: стилистика, стилизация, композиция, целостность, взаимозависимость элементов, 	композиционная 	равновесие, 	симметрия, 	асимметрия, 	закономерности композиции, фактура, текстура, зрительное восприятие, средства-материалы, точка, линия, плоскость, костюм, персонифицированный образ. 

Литература: [1 - С. 40-46; 2 - С.9-10; 5- С.9-109; 10 – С.10-160]
Выполнить: 
1. Изучить основную и дополнительную литературу по теме.  
2. Подготовиться к тесту по вопросам темы. 

Практическое занятие 6
 Создание собственного силуэта, отражающего увлечения

Выполнить:  
1. Создать в векторной программе изображение ростового силуэта, отражающего ваши увлечения. 
2. Вырезать созданный силуэт из черной бумаги. 
3. Наклеить вырезанный силуэт на формат А4. 
4. Подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения — векторная графика, работа в материале. 
Материалы: бумага формата А4, черная тонированная в массе бумага, канцелярский нож, лезвия, клей.

Тема 3. Виды проектно-графических изображений 
1. История орнамента. Историческая классификация орнаментов.  
2. Стилихация. Основные правила построения разновидностей изобразительных элементов. 
3. Разновидности знаков: изобразительные (абстрактные и изобразительные), словесные, комбинированные, объемные.  
4. Монограмма. Инициал. Вензель. Буквица.  
1. Экслибрис. Книжный знак. 

Термины: орнамент, знак, абстрактный знак, словесный знак, комбинированный знак, объемный знак, монограмма, инициал, вензель, буквица, экслибрис, книжный знак.

Литература: [2. - С.9-10; 5 – С.97-106;. 7-  С.25-30 ]

Практическое занятие 8
Стилизация «Растение – птица – животное»

Выполнить:  
1. Доработать в векторной программе стилизации (растение – птица – животное): натуральный вид/орнаментально-линейная манера/стилизация объекта и угловатых форм/ стилизация объекта из округлых форм.
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения — векторная графика, работа в материале.
Материалы: бумага формата А4, принтерная черно-белая печать.

Практическое занятие 9
Шрифтовой экслибрис

Выполнить:  
1. Доработать в векторной программе шрифтовой экслибрис (книжный знак) с использованием шрифтов и декоративно-орнаментальных элементов выбранной эпохи. 
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая черно-белая композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная черно-белая печать. 
 

РАЗДЕЛ II. СОЗДАНИЕ ГРАФИЧЕСКОГО ПРОЕКТА В СТИЛИСТИКЕ XX-XXI ВЕКОВ
(II СЕМЕСТР)
 
Тема 4. Стилистика ХХ –ХХI веков. 
1. Стилистика изобразительного искусства ХХ –ХХI вв.  
2. Векторный портрет.  
Термины: изобразительное искусство ХХ –ХХI вв., авангард, авангардизм, модернизм, фовизм, примитивизм, кубизм, футуризм, кубофутуризм, дадаизм, супрематизм, лучизм, орфизм, пуризм, экспрессионизм, конструктивизм, неопластицизм, функционализм, баухауз, абстрактный экспрессионизм, постживописная абстракция, искусство аутсайдеров, бедное искусство, кинетическое искусство, флуксус, поп арт, оп арт, минимализм, концептуализм, искусство действия, гиперреализм, спациализм, неодадаизм, неоэкспрссионизм, постмодернизм, деконструктивизм, ретривализм, провокация,  инсталляция, автоматическое письмо, коллаж, перформанс, хеппенинг, энвайроумент, флешмоб, нетарт, видеоарт, синтетическое искусство. 

Литература: [1 - С. 40-46; 2- С.9-10;]

Выполнить: 
1. Изучить основную и дополнительную литературу по теме.
2. Подготовить презентацию на тему выбранного течения или направления искусства ХХ–ХХI века.
3. Написать реферат на тему выбранного течения или направления искусства ХХ–ХХI века. 

Тема 5. Создание социального образа. 
1. Понятие «знак-морфем» (логотип) и «знак-символ» (эмблема).  
2. Этапы подготовки эмблемы.  
3. Формально-композиционные средства.  
4. Пиктограммы.  
5. Создание изобразительного знака (идеограммы).  
6. Разработка словесного знака (логограммы).  

Термины: знак-морфем, знак-символ, логотип, эмблема, пиктограмма, идеограмма, логограмма, личный знак. 

Литература: [2- С.9-10; 13 – С.48-51.]
Практическое занятие 11. Личный знак. 
Выполнить: 
1. Доработать личный знак (по 3 варианта):
  -         на основе собственной подписи (почерка); 
· на основе собственных инициалов; 
· с узнаваемыми знаковыми элементами своей профессии; 
· на основе личных увлечений (занятия, хобби: музыка, кино, литература, молодежные течения, мода и т.д.); 
· на основе ассоциаций с животным, птицей, растением, объектом, предметом, техникой…
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя.
Описание: графическая цветная композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная цветная печать.

Практическое занятие 12. Знак группы. 
Выполнить: 
1. Создать аббревиатурный знак группы (логотип) в выбранной стилистике ХХ-
ХХI века (3 варианта).
2. Скомпоновать изображения на формате А4 и подписать название темы, имя, фамилию студента, аббревиатуру группы, фамилию и инициалы преподавателя. 
Описание: графическая цветная композиция. Формат А4. Техника исполнения — векторная графика. 
Материалы: бумага формата А4, принтерная цветная печать. 
 
Тема 6. Серийные объекты 
1. Взаимосвязь и взаимозависимость функции и формы.  
2. Взаимосвязь и взаимозависимость художественного образа и формы.  
3. Серийные объекты. Этапы подготовки серийных объектов.  
4. Объемно-графическая модель на заданную тему. 

Термины: функция, форма, художественный образ, серийный объект, объемнографическая модель.

Литература: [2- С.9-10;   — С.7-8; 83-85;   — С. 3-5: 7-  С.25-30]

Практическое занятие 13
 Серийные объекты

Выполнить: 
1. Обложка перекидного календаря в выбранной стилистике на тему течения, направления ХХ-ХХI века. Но обложке должны быть тема календаря, год, изобразительный элемент, эмблема академии. 
2. Один лист перекидного календаря с любым месяцем в выбранной стилистике на тему течения, направления ХХ-ХХI века. На листе должны быть изобразительный элемент, календарная сетка, слоган или рекламный заголовок.
3. Компоновка семестровой работы «Стилистика ХХ-ХХI века» (формат А2). 
Описание: графическая цветная композиция. Формат А2. Техника исполнения — векторная и растровая графика. 
Материалы: бумага формата А2, принтерная цветная печать.

РАЗДЕЛ III.СЕРИЙНЫЕ ОБЪЕКТЫ В ГРАФИЧЕСКОМ ДИЗАЙНЕ 
(III СЕМЕСТР)

Тема 3. Серийный объект – открытка 
7. Деление открыток по предназначению.
8. Деление открыток по технике исполнения.
9. Художественные и документальные открытки.
10. Типы открыток.
11. Композиционно-графическая модель серии.
12. Имитация художественных техник в растровой программе.
 
Термины: стандартные маркированные почтовые карточки, иллюстрированные маркированные почтовые карточки, специального назначения маркированные почтовые карточки, немаркированные почтовые карточки, художественные и документальные открытки, композиционно-графическая модель серии.  
Выполнить:  
Графическую серию в виде набора открыток на одну из предложенных тем. Для этого необходимо: 
· изучить аналогичные серии; 
· при необходимости выполнить фотосъемку архитектурных объектов, выбрав одну из тем серии; 
· при необходимости произвести художественную обработку фотографий;
· при необходимости выполнить иллюстрации;
· разработать серию открыток и упаковку для серии;
· распечатать в цвете в нужном формате.  
 
Литература: [16 (С. – 65-109), 19 (С. – 86-96), 21 (С. – 56-76),  23, 25, 28, 29, 30] 
 
Тема 4. Серийный объект – почтовая марка 
5. Серия почтовых марок.
6. Типы серий.
7. Проект почтовой марки.
8. Этапы создания марки художником.
 
Термины: серия почтовых марок, «омнибусная» серия, идентичная серия, перманентная серия, смешанная серия, эссе, высокая печать, глубокая печать, плоская печать, коммеморативная марка, штемпель гашения.  
Выполнить: Создать серию коммеморативной марки на предложенную тему. 
 
Литература: [3  (С. – 4-8), 4 (С. –5-119), 5 (С. –8-21), 6 (С. –5-55), 16 (С. – 65-109) 22, 26, 27]

РАЗДЕЛ IV. РАЗРАБОТКА СИСТЕМЫ ВИЗУАЛЬНОЙ ИДЕНТИФИКАЦИИ
(IV СЕМЕСТР)
  
Тема 5. Фирменный блок
Выполнить:  
1. Разработать фирменный знак и логотип на основе названия фирмы. Гармонично связать изобразительный и шрифтовой элементы.  
2. Разработать варианты динамического фирменного знака в системе визуальной идентификации.
Материал: компьютерная графика.
Варианты тем: 
Логотип и товарный знак ювелирного магазина 
1. Brilissa, 
2. Damiani, 
3. Enigma, 
4. Roberto Bravo. 
Логотип и товарный знак турбюро 
5. Travel Studio, 
6. Mandarin Tours, 
7. Глобус. 
Логотип и товарный знак фито-аптеки  
8. Green Apotek, 
9. Биофарма, 
10.  Валедус.
Разработать логотип и товарный знак согласно предложенному варианту.
Литература: [ 8 (С. – 4-33), 9  (С. – 7-105), 11 (С. – 4-24, 80-120), 18 (С. – 182-202), 33, 34]

Тема 7. Разработка корпоративной идентификации 
Выполнить: 
1. Разработку фирменного блока элементов делопроизводства: фирменные бланки (для международной переписки, для коммерческого письма, для приказов, для внутренней переписки и т. д.), фирменные конверты, фирменные папки-регистраторы, фирменные записные книжки, фирменные ежедневники, фирменные блоки бумаг для записей, визитки. 
Литература: [15 (С. – 15-77), 20 (С. – 148-170), 18 (С. – 143-161, 202-207), 33,34]

Тема 8. Разработка рекламных носителей фирменного стиля
Выполнить: 
4. Разработку рекламных носителей фирменного стиля. Рекламная печатная продукция: флаер, буклет, рекламный плакат. Наружная реклама: вывеска, баннер, брендмауер. 
5. Разработку сувенирной продукции. Открытки. Значки. Магниты. Письменные принадлежности. 
6. Разработку упаковки. Пакеты, сумки. Фирменная упаковочная бумага.
7. Презентацию фирменного стиля в виде единой целостной композиции.
Материал: компьютерная графика, цветная печать на бумаге формата А2.
Литература: [  17 (С. – 6-35)   18 (С. – 123-163, 207-223), 33, 34]

РАЗДЕЛ V. СОЗДАНИЕ МАКЕТОВ КНИЖНЫХ ИЗДАНИЙ В ПРОЦЕССЕ ИЗУЧЕНИЯ ПРОГРАММЫ МНОГОСТРАНИЧНОЙ ВЕРСТКИ
(V СЕМЕСТР)
Тема 1. Книжное издание.

Выполнить:
1. Произвести шрифтоподбор для книжного издания.
2. Выполнить макетирование обложки книжного издания. 
3. Создать эскиз модульной сетки книжного издания.
4. Сверстать титульный лист книжного издания.
5. Выставить колонцифры и разверстать колонтитулы книжного издания.
6. Разверстать текстовый материал книжного издания.

Цель задания – подготовить материал для выполнения семестрового задания по верстке книжных изданий – прозы и поэзии, с дальнейшим авторским иллюстрированием и подготовкой их к печати. Выработать у студента способность к грамотному выбору шрифтовых гарнитур к книжным изданиям.

Литература: [21— С. 9-120; 10 — С. 17-86; 14 — С.19-39; 51-79; 11 — С. 11-243; 22 — С. 17-122]

Тема 2. Макетирование и подготовка в печать многостраничных книжных изданий.

Выполнить:
1. Особенности макетирования книжных изданий в программе многостраничной верстки.
2.  Препресс макета многостраничной верстки. 
3. Постпресс макета многостраничной верстки. 

Цель задания – изучить особенности макетирования книжных изданий в программе многостраничной верстки. Выработать у студентов навыки подготовки макетов книжных изданий к печати и послепечатной подготовки.

Литература: [21— С. 120-164; 10 — С. 87-231; 14 — С.81-96; 99-103; 198-201; 283-288; 11 — С. 262-364; 22 — С. 123-237]

РАЗДЕЛ VI. ПРОЕКТИРОВАНИЕ В ВЕКТОРНОМ ГРАФИЧЕСКОМ РЕДАКТОРЕ
(VI СЕМЕСТР)

Тема 3. Знакомство с рабочей средой. Выделение и выравнивание. Создание и редактирование фигур

Выполнить:
1.	Разложить, каждый цвет выполненной на практическом занятии листовку по слоям в файле используя метки реза.

Цель задания – научится грамотно раскладывать по цветам макеты подготовленный под способ печати на ризографе используя возможности векторного графического редактора с целью вырабатывания профессиональных навыков, необходимых в дальнейшей работе.

Литература: [1— С. 64-165; 2 — С. 58-166; 7 — С.28-40; 83-85; 8 — С. 26-46]

Выполнить:
1.	Ознакомиться с функциями перемещения объектов в стопке, изменения периметров объектов с целью имитирования контуров. 
2.	Выучить требования к печати шелкотрафаретным способом. 
3.	Научиться пользоваться функциями изменения формы объектов с целью подготовки макету к шелкотрафаретной печати. 
4.	Расставить метки реза по углам каждой визитки.
5.	Разложить каждую визитку с логотипом по цветам с учетом требований к шолкотрафаретному виду печати.
6.	Каждую разложенную визитку перенести в новой слой, который заранее следует создать в файле.

Цель задания – научится грамотно раскладывать по цветам макеты подготовленный под шелкотрафаретный способ печати используя возможности векторного графического редактора с целью вырабатывания профессиональных навыков, необходимых в дальнейшей работе.

Литература: [1— С. 64-165; 2 — С. 58-166; 7 — С.28-40; 83-85; 8 — С. 26-46]

Тема 4. Трансформирование объектов. Рисование с помощью инструментов Pen и Pencil. Цвет и работа с ним в программе

Выполнить:
1. Подборку растровых изображений натюрморта с количеством предметов не менее 5-и.
2. Анализ приемов применения инструмента „градиентная сетка”. 
3. Работу с инструментами выделения и трансформации. 
4. Необходимый рядом эффектов и фильтров, с помощью которых можно имитировать разные поверхности.

Цель задания – научится анализировать и выбирать изобразительный материал, необходимый для дальнейшего выполнения задания. Изучить и грамотно использовать инструментарий и эффекты используя возможности векторного графического редактора с целью вырабатывания профессиональных навыков, необходимых в дальнейшей работе.

Литература: [1— С. 168-284; 2 — С. 170-286; 7 — С.250-281; 434-447; 8 — С. 240-267; 414-426]

Тема 5. Работа с текстом. Работа со слоями. Создание переходов между цветами и фигурами

Выполнить:
1. Поиск концепции автопортрета в технике оп-арт с помощью кириллического текста.
2. По завершению работы все эффекты упростить, а символы перевести в кривые.
3. Растровое изображение встроить в файл.

Цель задания – научится анализировать и выбирать изобразительный материал, необходимый для дальнейшего выполнения задания. Изучить и грамотно использовать инструментарий и возможности векторного графического редактора с целью вырабатывания профессиональных навыков, необходимых в дальнейшей работе.

Литература: [1— С. 288-418; 2 — С. 290-422; 7 — С.106-140; 222-246; 8 — С. 110-143; 218-237]

Тема 6. Работа с кистями. Применение эффектов. Работа с символами

Выполнить:
1. Создать новый файл в формате А5.
2. Создать ряд кистей, имитирующих мазки туши.

Цель задания – подготовить рабочую основу, необходимую для дальнейшего макетирования. Изучить конкретную аналоговую художественную технику и с помощью векторного графического редактора создать инструмент (кисти) способный её имитировать с целью вырабатывания профессиональных навыков, необходимых в дальнейшей работе.

Литература: [1— С. 422-583; 2 — С. 426-553; 7 — С. 352-370; 374-405; 8 — С. 334-352; 356-386] 

Выполнить:
1. Создать новый файл в формате А5.
2. Создать ряд кистей, имитирующих мазки акварельной краски.

Цель задания – подготовить рабочую основу, необходимую для дальнейшего макетирования. Изучить конкретную аналоговую художественную технику и с помощью векторного графического редактора создать инструмент (кисти) способный её имитировать с целью вырабатывания профессиональных навыков, необходимых в дальнейшей работе.

Литература: [1— С. 422-583; 2 — С. 426-553; 7 — С. 352-370; 374-405; 8 — С. 334-352; 356-386]

РАЗДЕЛ VII. СОЗДАНИЕ ИНДИВИДУАЛЬНОГО ОБРАЗА ОБЪЕКТА В РЕКЛАМЕ
(VII СЕМЕСТР)

Тема 1. 	POS-материалы в маркетинге: виды и правила разработки.
   
Практическое занятие №1
Создание и защита презентации по теме «POS-материалы в маркетинге (на основе известных брендов)»

Выполнить: 
1. Произвести сбор и анализ аналогов pos-материалов (классификация, функции). 
2. Создать презентацию по заданной теме.
3. Защитить презентацию по заданной теме на аудиторном занятии.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29].
 
Тема 2. Разработка концепции бренда. Целевая аудитория: определение и анализ.

Практическое занятие №2
Разработать концепцию бренда

Выполнить: 
1. Разработать общую концепцию бренда (нейминг, слоган, логотип, фирменные гарнитуры, маскот).
2. Выполнить эскизы (не менее 5).
3. Презентовать на занятии разработанные материалы.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29] 

Тема 3. Бренд-стратегии создания продукта.

Практическое занятие №3
Создание и защита презентации по теме «Типы стратегий брендинга и их составляющие»

Выполнить: 
1. Произвести сбор и анализ информации по заданной теме. 
2. Создать презентацию по заданной теме.
3. Презентовать на занятии разработанные материалы.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29] 

Тема 4. Разработка дизайна pos-материалов.

Практическое занятие №4.1
Создание концепции шелфтокера

Выполнить: 
1.Произвести сбор и анализ аналогов шелфтокеров. 
2. Создать общую концепцию шелфтокера для бренда.
Литература: [1— С. 22-33; 2 — С. 5-15; 3 — С.7-23; 62-80; 4 — С. 13-29] 

Практическое занятие №4.2
Создание концепции рекламного плаката

Выполнить: 
1. Произвести сбор и анализ аналогов рекламных плакатов. 
2. Создать общую концепцию рекламного плаката.
Литература: [1— С. 87-96; 2 — С. 16-23; 3 — С.83-93; 4 — С. 38-45] 

Практическое занятие №4.3
Создание концепции ценника(некхенгер)

Выполнить: 
1. Произвести сбор и анализ аналогов ценников. 
2. Создать общую концепцию ценника для бренда.
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65]
Практическое занятие №4.4
Создание концепции воблера

Выполнить: 
1. Произвести сбор и анализ аналогов воблеров. 
2. Создать общую концепцию воблера для бренда.
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65]

Практическое занятие №4.5
Создание концепции листовки

Выполнить: 
1. Произвести сбор и анализ аналогов листовок. 
2. Создать общую концепцию листовки для бренда.
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65]

Тема 5. Графическо-информационные объекты как единая пространственно-временная коммуникационная система. Психофизические свойства цвета. 

Практическое занятие №5.1
Создание концепции стоппера

Выполнить: 
1. Произвести сбор и анализ аналогов стопперов. 
2. Создать общую концепцию стоппера для бренда.
Литература: [1— С. 180-182; 185-186; 2 — С. 24-25;  3 — С.96-102;   4 — С. 48-65] 

Практическое занятие №5.2
Создание концепции мобайла

Выполнить: 
1. Произвести сбор и анализ аналогов мобайлов. 
2. Создать общую концепцию мобайла для бренда.
Литература: [1— С. 38-51; 2 — С. 26-27; 3 — С.137-142; 4 — С. 72-84]

Практическое занятие №5.3
Создание концепции пиллара

Выполнить: 
1. Произвести сбор и анализ аналогов пилларов. 
2. Создать общую концепцию пиллара для бренда.
Литература: [1— С. 38-51; 2 — С. 26-27; 3 — С.137-142; 4 — С. 72-84]
 
Практическое занятие №5.4
Создание концепции панель-кронштейна

Выполнить: 
1. Произвести сбор и анализ аналогов рекламных консолей(панель-кронштейн). 
2. Создать общую концепцию панель-кронштейна для бренда.
Литература: [1— С. 38-51; 2 — С. 26-27; 3 — С.137-142; 4 — С. 72-84]

Практическое занятие №5.5
Создание концепции итоговой экспозиции с POS-материалами, выполненными за семестр

Выполнить: 
1. Подготовить изображения созданных POS-материалов с необходимыми параметрами для создания показательной итоговой семестровой экспозиции. 
2. Создать общую концепцию экспозиции с изображениями POS-материалов для бренда. 
Литература: [1— С. 45-48; 2 — С. 16-17; 3 — С.104-136; 146-154; 4 — С. 87-101; 108-114] 
 


8. ОЦЕНОЧНЫЕ СРЕДСТВА ДЛЯ КОНТРОЛЯ УСПЕВАЕМОСТИ СТУДЕНТА

Перечень оценочных средств

	№
п/п
	Наименование
оценочного
средства
	Краткая характеристика оценочного средства
	Представление оценочного средства в фонде

	1.
	Тестовые задания
	Система стандартизированных заданий, позволяющая автоматизировать процедуру измерения уровня знаний и умений обучающегося.
	Тест

	2.
	Устный и письменный опрос
	Средство контроля, включающее устный опрос на предмет использования специальных терминов и понятий; теоретические вопросы для письменного опроса, стандартные задачи и задания для диагностики и оценивания умения синтезировать, анализировать, обобщать фактический и теоретический материал с формулированием конкретных выводов, установлением причинно-следственных связей. Средство рассчитано на выяснение объема знаний обучающегося по учебной дисциплине, конкретной теме или разделу.
	Теоретические вопросы для устного и письменного опроса по темам дисциплины для подготовки к практическим занятиям

	3.
	Вопросы к зачёту/экзамену
	Включает список вопросов к зачёту по дисциплине «Проектирование в графическом дизайне». Перечень вопросов покрывает все темы дисциплины и позволяет оценить уровень сформированных компетенций.
	Список вопросов к зачёту/экзамену

	4.
	Выставка-просмотр практических работ 



	На выставках-просмотрах демонстрируются выполненные студентами практические работы, которые должны соответствовать требованиям каждой темы дисциплины за семестр. На просмотр приглашают других преподавателей кафедры графического дизайна с целью объективной оценки профессионального уровня выполненных заданий.

	Требования к проведению выставки-просмотра и оценки работ студентов.





8.1. Теоретические вопросы и задания для устного контроля знаний в ходе проведения текущей аттестации за I семестр

1.	Какие бывают разновидности стиля?
2.	Что такое национальный стиль, жанровый стиль?
3.	Понятие «художественное направление», «стиль школы», «индивидуальный стиль», «стиль произведения».
4.	Взаимосвязь и взаимозависимость функции и формы, художественного образа и тектоники, структуры и формы, формы и тектоники.
5.	Какие этапы подготовки проектного задания?
6.	Из чего состоит подготовительный этап?
7.	Из чего состоит этап дизайнерской предложения?
8.	Как подобрать шрифт и изображение в композиции на основе нюансных и контрастных соотношений?
9.	Как усилить качества изображения с помощью цвета?
10.	Ассоциативные качества цвета.
11.	Особенности композиционного построения серии.
12.	Средства достижения единства всех элементов серии.
13.	Что такое фактура и текстура?
14.	Какие бывают виды композиции?
15.	Что такое оптический и геометрический центр композиции?
16.	Что такое взаимозависимость элементов композиции?
17.	Что такое композиционное равновесие?
18.	Что такое симметрия и асимметрия в композиции?
19.	Принципы организации асимметричной композиции.
20.	Понятие о композиционных средствах: тождество, равенство, сходство, нюанс, контраст.

8.2. Тестовые задания для контроля во II семестре
ТЕСТ



	№
	Вопрос
	Вариант ответа
	код

	1
	Строение, взаимосвязь частей, обеспечивающая целостность изображения, направленная на раскрытие содержания, идеи произведения – это…

	конструкция
	а

	
	
	конституция
	б

	
	
	композиция
	в

	
	
	компоновка
	г

	2
	Выберите из предложенных вариантов определение понятия «композиционное построение».
	приведение к целостности и гармонии одной из частей произведения
	а

	
	
	состояние, при котором все элементы сбалансированы между собой
	б

	
	
	приведение к целостности и гармонии всех частей произведения
	в

	
	
	состояние, при котором элементы не сбалансированы между собой
	г

	3
	Что является простейшим элементарным композиционным средством-материалом?
	точка
	а

	
	
	линия
	б

	
	
	плоскость
	в

	
	
	пятно
	г

	4
	Назовите выделенную часть плоскости (в пространстве - облако), характеризующуюся формой, цветом, фактурой.
	пятно
	а

	
	
	объем
	б

	
	
	линия
	в

	
	
	плоскость
	г

	5
	Особенность восприятия, выражающаяся в том, что все свойства одних предметов воспринимаются в сравнении с теми же свойствами других предметов – это…

	избирательность
	а

	
	
	запоминаемость
	б

	
	
	константность
	в

	
	
	соотносительность
	г

	6
	Какой стиль потрясает своей роскошью и великолепием, ему свойственна свобода и витиеватость, склонность к кривым линиям, дроблению формы?

	Барокко
	а

	
	
	Рококо
	б

	
	
	Ампир
	в

	
	
	Классицизм
	г

	7
	Назовите отличительные особенности Романского стиля.
	Сложные и массивные сооружения из камня. Замки и стены, боевые башни были каменными, тяжеловесными, с большим запасом прочности
	а

	
	
	Простые и массивные сооружения из камня. Замки и стены, боевые башни были каменными, тяжеловесными, с большим запасом прочности
	б

	
	
	Сложные и не большие сооружения из камня. Замки и стены, боевые башни были каменными, тяжеловесными, с большим запасом прочности
	в

	
	
	Простые и массивные сооружения из камня. Палаццо и дворцы, боевые башни были каменными, тяжеловесными, с большим запасом прочности
	г

	8
	Назовите отличительные особенности Готического стиля.





	устремлённость ввысь, чувство невесомости, лёгкости каменных стен и сводов, которое достигается подчёркнутыми вертикалями тонких опор, стрельчатыми арками
	а

	
	
	устойчивость, чувство невесомости, тяжесть каменных стен и сводов, которое достигается подчёркнутыми вертикалями тонких опор, полукруглыми арками
	б

	
	
	устойчивость форм, чувство невесомости, тяжесть каменных стен и сводов, которое достигается подчёркнутыми вертикалями тонких опор
	в

	
	
	устремлённость вниз, чувство невесомости, тяжесть каменных стен и сводов, которое достигается подчёркнутыми вертикалями тонких опор, стрельчатыми арками
	г

	9
	Этому стилю присущи логичность планировки и геометризм объёмной формы. Основой архитектурного языка стал ордер, в пропорциях и формах более близкий к античности, чем в зодчестве предыдущих эпох. Это стиль…


	Классицизм
	а

	
	
	Возрождение
	б

	
	
	Ампир
	в

	
	
	Модерн
	г

	10
	Назовите стиль, в основе которого лежит возвращение к античности, чёткая форма, стремление к уравновешенным пропорциям, повышенное использование в мебели архитектурных элементов. Мерой гармоничности форм служило правило золотого сечения.
	Модерн
	а

	
	
	Возрождение
	б

	
	
	Рококо
	в

	
	
	Ампир
	г

	11
	Назовите стиль, характерными чертами которого являются декоративность, плавность линий и округлость форм, их гибкость и текучесть, обилие орнаментов и украшений, внимание к растительным, природным мотивам.
	Античность
	а

	
	
	Модерн
	б

	
	
	Рококо
	в

	
	
	Классицизм
	г

	12
	Назовите отличительные особенности Античного стиля.
	 стиль Наполеона Бонапарта, характеризуется тягой к монументальности
	а

	
	
	простые и массивные сооружения из камня, каменные замки и стены
	б

	
	
	устремлённость ввысь, чувство невесомости, лёгкости каменных стен и сводов
	в

	
	
	ордерная система, включающая ионический, дорический и коринфский архитектурные ордеры
	г

	13
	Назовите отличительные особенности эпохи Ампир.
	устремлённость ввысь, чувство невесомости, лёгкости каменных стен и сводов которое достигается подчёркнутыми вертикалями тонких опор, стрельчатыми арками
	а

	
	
	характеризуется тягой к монументальности, величию, возник во Франции в период правления Наполеона
	б

	
	
	характеризуется тягой к монументальности, величию, возник в Италии в период правления Наполеона
	в

	
	
	простые и массивные сооружения из камня, каменные замки и стены
	г

	14
	Назовите стиль, характерными чертами которого являются камерность, декоративность и грация, весомые формы, стремление к красоте, легкости и вечной молодости.
	Античность
	а

	
	
	Модерн
	б

	
	
	Рококо
	в

	
	
	Классицизм
	г

	15
	Назовите стиль, неотъемлемой частью которого являются религия, заупокойный культ и ритуал в виде мумификации, обожествление фараона.
	Ампир
	а

	
	
	Модерн
	б

	
	
	Античность
	в

	
	
	Древний Египет
	г

	16
	Соразмерность частей художественного целого как в отношении друг с другом, так и в соответствии с целым – это…
	симметрия
	

	17
	Механизм коррекции, обеспечивающий адекватность зрительного образа объекта самому объекту – это…

	константность (предметность)
	

	18
	Как называется обманчивость зрительного восприятия?

	Иллюзорность
	

	19
	Как называется упорядоченный набор элементов, которые следуют друг за другом в определенном порядке?
	Последовательность
	

	20
	Общая часть двух смежных областей поверхности, движущаяся точка – это…
	линия
	

	21
	Дайте определение форме (свободно-художественной), описание которой математически затруднительно, например, клякса.
	Нерегулярная форма
	

	22
	Перечислите параметры объема.
	Вершина, ребро, грань
	

	23
	Какую линию образует движение точки по траектории с интервалом метрическим или ритмически оптическим?
	Пунктирную, штрих-пунктирную, штриховую
	

	24
	Назовите объект, который может быть фронтальным, принадлежать объему и находиться в пространстве, обладая геометрически минимальной толщиной.
	Плоскость
	

	25
	Раскройте понятие орнамент.
	Ритмично повторяющийся рисунок, основанный на симметричной композиции его элементов и выражаемый линией, цветом или рельефом
	

	26
	Наиболее элементарные и универсальные орнаментальные композиции – это…
	линейная (идея постоянного поступательного движения), шахматная (сетчатая), круговая (идея замкнутого кругового движения)
	

	27
	Как называется орнаментальный мотив, образованный двумя спиралями, закрученными внутрь?
	Волюта
	

	28
	Дайте определение термину «силуэт».
	Форма фигуры или предмета, видимая как плоское пятно, заполненное черным или каким-либо другим однотонным цветом
	

	29
	Книжный знак, который владельцы библиотек наклеивают на книгу, преимущественно на внутреннюю сторону переплета – это…
	экслибрис
	

	30
	Раскройте понятие инициал (буквица).
	Начальные буквы имени, отчества, фамилии; крупная, отличная от прочих, первая буква главы, раздела или целой книги
	

	31
	В CorelDRAW создайте простые геометрические объекты: квадрат, круг, прямоугольник, пятно произвольной формы. Поворачивая и перемещая эти объекты, изменяя их размеры и цвет, выполните все примеры, иллюстрирующие графические иллюзии при восприятии формы объекта.
	(выполнить задание)
	


Критерии оценки: за каждый правильный ответ на вопрос с вариантами ответа студент может получить 0,1 балла. За каждый ответ на открытый вопрос студент может получить 0,2 балла. За корректное выполнение последнего задания студент может получить 0,5 балла. При условии всех правильных ответов - максимально возможное количество баллов – 5.

8.3. Теоретические вопросы, задачи и задания для устного/письменного опроса в ходе проведения текущей аттестации во II семестре

1.	Принципы построения динамической композиции.
2.	Принципы построения статической композиции.
3.	Способы достижения выразительности в композиции.
4.	Основные виды изображений на плоскости, их типичные признаки.
5.	Определить понятие «Ритм».
6.	Определить понятие «Модуль».
7.	Определить понятия: значок, идеограмма, буква, графема.
8.	Перечислить все этапы подготовительного процесса для создания векторного портрета.
9.	Расскажите о превращении фотографии в векторный портрет.
10.	Раскройте разницы между логотипом, знаком, инициалом, вензелем и монограммой.
11.	Расскажите о трёх этапах создания знака.
12.	Какие разновидности логотипа вам известны?
13.	Перечислить пять общих принципов создания логотипа.
14.	Перечислить общие положения при создании логотипа. Раскройте каждое из них.
15.	Какие основные стили логотипов вам известны? Приведите примеры.
16.	Что такое стилизация и ее роль в создании графического знака?
17.	Чем отличается знак эпохи модернизма от знака эпохи постмодернизма?
18.	Что такое логограмма?
19.	Являются ли понятия «логограмма» и «иероглиф» синонимами?
20.	Что такое пиктограмма?

8.4. Вопросы для зачёта в III семестре

1. Что называют серийными объектами в графическом дизайне?
2. Где и в каком году впервые появилась музыкальная открытка?
3. Какие вы знаете примеры серийных объектов?
4. Дайте определение понятию «Филателия»?
5. Что представляет собой композиционно-графическая модель?
6. В чем заключается предназначение почтовой марки?
7. Перечислите обязательные элементы почтовой марки.
8. В какой графической технике были созданы первые почтовые марки?
9. Дайте определение понятию «серия почтовых марок».
10. Как называется памятная почтовая марка, выпущенная в ознаменование события, знаменательной даты или юбилея выдающейся личности?
11. Как называется графический/текстовый знак, нанесённый, в виде наклейки, бирки или талона, на товар, экспонат, любой другой продукт производства, с указанием торговой марки производителя, названия, даты производства, срока годности?
12. Что являлось прообразом современных этикеток?
13. Перечислите основные элементы, помещаемые на этикетку
14. При помощи чего выполняется высечка?
15. Дайте определение понятию «книжная серия».
16. Какое название имеют книги, объединенные общим оформлением и по тем или иным причинам позиционированные издателем как составляющие единую последовательность?
17. Перечислите известные вам жанры книжных серий.
18. Можно ли назвать книжной серией группу книг, состоящую из литературных произведений различных жанров?
19. Что такое авторская книжная серия?
20. Могут ли в авторскую книжную серию входить книги разных авторов?
21. Чем отличается оформление книжной серии от оформления самостоятельного книжного издания?
22. От какого количества печатных изданий начинается понятие серии?
23. Дайте определение серийным объектам – игральные карты.
24. Как называются передняя и задняя стороны игральной карты?
25. Когда и где появились первые игральные карты?
26. Кого представляет каждая фигура на лицевой стороне игральных карт?
27. Поясните символику мастей игральных карт
28. Что такое тиснение?
29. Является ли спичечная этикетка серийным объектом графического дизайна?
30. Что такое «филумения»?
31. Как называют коллекционеров спичечными этикетками?
32. Что такое «филотаймия»?
33. Дайте определение карманному календарю.
34. Перечислите известные вам формы карманных календарей.
35. В чем заключается преимущество карманных календарей перед утилитарными печатными изданиями?
36. На каких материалах печатаются карманные календари?
37. Дайте определение открытке.
38. Что такое «филокартия»?
39. Является ли филокартия вспомогательной исторической дисциплиной?
40. Как выглядели первые открытки?
41. Что называют открытым «почтовым листком»?
42. Что стало прообразом художественной открытки?
43. Что обозначает слово «открытка» в переводе на ряд европейских языков?
44. Какие виды открыток вам известны?
45. Как называлась самая ранняя поздравительная открытка (Лондон, XV в.)?
46. Когда появились первые советские новогодние открытки?

8.5. Теоретические вопросы, задачи и задания для устного/письменного опроса в ходе проведения текущей аттестации в IV семестре

1.	Что такое «серийность»?
2.	Что называют графической серией?
3.	Назовите основные признаки графической серии.
4.	Что такое «константа» в графической серии?
5.	Чем отличаются моносерии и мультисерии?
6.	Каковы функции серийных объектов в графическом дизайне?
7.	Что такое инвариативный принцип построения изображений при серийном типе визуализации смысла в графическом дизайне?
8.	Что такое вариационный принцип построения изображений при серийном типе визуализации смысла в графическом дизайне?
9.	Что такое почтовая марка?
10.	Что такое этикетка?
11.	Чем характеризуется книжная серия?
12.	Какие примеры книжных серий вы знаете?



8.6. Выставка-просмотр выполненных практических работ в I и II семестре

Промежуточными точками контроля знаний, умений и профессионально-личностных качеств студентов являются выставки-просмотры выполненных семестровых работ по основным темам дисциплины «Проектирование в графическом дизайне». В I и II семестре студентами выполняются семестровые работы совместно с дисциплиной «Компьютерная графика».
Пояснение. На выставках-просмотрах студенты на компьютерах выставляют индивидуально выполненные задания, которые должны по объему и уровню исполнения соответствовать требованиям каждого семестрового задания. После того, как выставили работы, студенты выходят из компьютерной аудитории. На выставку-просмотр приглашают других преподавателей профильных дисциплин кафедры графического дизайна с целью коллегиальной, объективной оценки уровня выполненных студентами работ. Вместе с тем, после коллегиального обсуждения, ведущий преподаватель дисциплины приглашает студентов в аудиторию, где задает возникшие дополнительные и контрольные вопросы по основам иллюстрации, мотивируя каждого студента сравнивать свой уровень с уровнем остальных участников выставки-просмотра, определяя пути саморазвития и самосовершенствования. Таким образом, преподаватель объективно выставляет оценку промежуточного контроля знаний и умений будущих дизайнеров по дисциплине «Проектирование в графическом дизайне». 
Алгоритм работы студентов на выставке-просмотре:
1. Выставить в электронном виде (сохранённые на электронном носителе в формате JPG) либо распечатанном виде (если того требует задание) выполненные практические семестровые работы в полном объёме и соответственно указанным требованиям каждого задания. 
2. Ответить на контрольные и проблемные вопросы.
3. Осуществить анализ достоинств и недостатков своих работ.
4. Провести сравнительную оценку своих академических работ с рисунками одногруппников, выявить достоинства и недостатки собственного уровня проекта иллюстрации. 
5. Сделать выводы. Определить перспективы дальнейшего саморазвития и самосовершенствования.

8.7. Тестовые задания, которые выдаются в середине V семестра
для контроля знаний в ходе проведения текущей аттестации
ТЕСТ
Примечание: на усмотрение проводящего контроль преподавателя, тестирование проходит либо на бумажных носителях, либо при помощи программного обеспечения, позволяющего проводить электронное тестирование.

Вариант №1
	№
	Вопрос
	Варианты ответа

	1
	Что представляет собой контртитул?

	А) редко используемый в отечественном книжном деле термин, обозначающий то же, что и авантитул.
Б) это левая часть разворотного титула. Он содержит выходные данные, характерные для многотомного или серийного издания в целом.
В) в старопечатных книгах добавочный титул, помещаемый перед титульным листом для предохранения его от загрязнения, порчи. Современный шмуцтитул, предваряет часть, главу издания, содержит краткое название этой части или главы, эпиграф и т. д. 
Г) порядковый номер печатного листа издания, помещаемый в нижнем поле первой полосы.

	2
	С помощью какой команды можно вклеить объект в то же самое место по таким же координатам?

	А) Ctrl + Alt + V
Б) Ctrl + Alt + Shift + V
В) Ctrl + Shift + V
Г) Ctrl + V

	3
	Что представляет собой форзац?
	А) первая страница книжного блока, один из титульных элементов декоративно-композиционного назначения, появляющийся в книге, как правило, при наличии контртитула или фронтисписа.
Б) иллюстрация в книге, помещаемая обычно на левой стороне разворота титульного листа.
В) четырехстраничный лист бумаги, одна сторона которого приклеивается к внутренней стороне переплетной крышки, а другая, в большинстве книг, узкой полоской у корешка - к первой и последней страницам издания.
Г) последняя страница издания с его выпускными данными.

	4
	Что представляет собой колофон?
	А) первая страница издания, расположенная перед титульным листом и содержащая обычно издательскую марку, эпиграф, посвящение, надзаголовочные данные, выходные данные.
Б) порядковый номер страницы или столбца книги, периодического издания и т. п.
В) краткое название издания, или фамилия автора, или номер типографского заказа, помещаемые в левом нижнем углу первой полосы каждого печатного листа.
Г) последняя страница издания с его выпускными данными.

	5
	Что представляет собой сигнатура?

	А) порядковый номер печатного листа издания, помещаемый в нижнем поле первой полосы перед нормой. Служит для контроля при комплектовании тетрадей в книжный блок.
Б) краткое название издания, или фамилия автора, или номер типографского заказа, помещаемые в левом нижнем углу первой полосы каждого печатного листа.
В) порядковая нумерация страниц (полос), столбцов (колонок) или отд. элементов издания (отрезков текста, таблиц, иллюстраций и др.). 
Г) край переплетной крышки или обложки, выступающий за обрез блока.

	6
	Какой командой возможно преобразование текстовых элементов в графические векторные изображения в программе программе многостраничной верстки?
	А) Shift + Alt + W
Б) Shift+Ctrl+O
В) Ctrl + Alt + P
Г) Ctrl + Alt + V

	7
	Что представляет собой каптал?
	А) хлопчатобумажная или шелковая тесьма шириной до 10 мм с утолщенным цветным краем.
Б) край блока (книги, брошюры, журнала). Место, где скреплены все технологические элементы издания (тетради, марля, каптал, ляссе и пр.).
В) край переплетной крышки или обложки, выступающий за обрез блока.
Г) углубление на переплетной крышке готового изделия (книги, альбома и пр.) для улучшения его раскрываемости по месту расстава.

	8
	Что представляет собой рубчик?

	А) край переплетной крышки или обложки, выступающий за обрез блока.
Б) хлопчатобумажная или шелковая тесьма шириной до 10 мм с утолщенным цветным краем.
В) углубление на переплетной крышке готового изделия (книги, альбома и пр.) для улучшения его раскрываемости по месту расстава.
Г) край блока (книги, брошюры, журнала). Место, где скреплены все технологические элементы издания (тетради, марля, каптал, ляссе и пр.).

	9
	Что представляет собой распашной титул?

	А) титульный лист, размещенный на развороте.
Б) первая страница издания, расположенная перед титульным листом и содержащая обычно издательскую марку, эпиграф, посвящение, надзаголовочные данные, выходные данные.
В) титульный лист, состоящий из титульной страницы и оборота титула.
Г) разновидность титульного листа, декоративные и изобразительные элементы которого располагаются на первом развороте книги. 

	10
	Что представляет собой пагинация?
	А) порядковая нумерация страниц (полос), столбцов (колонок) или отд. элементов издания (отрезков текста, таблиц, иллюстраций и др.).
Б) краткое название издания, или фамилия автора, или номер типографского заказа, помещаемые в левом нижнем углу первой полосы каждого печатного листа.
В) элемент структуры издания, содержащий некоторые справочные данные об издании, например, фамилию автора, заглавие книги.
Г) иллюстрация, размещенная на развороте.

	11
	Что представляет собой нахзац?

	А) элемент издания в виде односгибного листа бумаги или конструкции из двух листов, скрепляющий книжный блок с задней сторонкой переплетной крышки.
Б) четырехстраничный лист бумаги, одна сторона которого приклеивается к внутренней стороне переплетной крышки, а другая, узкой полоской у корешка - к первой и последней страницам издания.
В) последняя текстовая или смешанная полоса издания или его части, обычно заполненная не до конца.
Г) начальная строка с абзацным отступом.

	12
	Что в книге называется "норма"?
	А) линейка, помещаемая вверху полосы и отделяющая колонтитул от текста. 
Б) краткий   заголовок, помещаемый над текстом начальной полосы книги или её части, главы и отделённый от него крупным пробелом.
В) порядковая нумерация страниц (полос), столбцов (колонок) или отд. элементов издания (отрезков текста, таблиц, иллюстраций и др.). 
Г) краткое название издания, или фамилия автора, или номер типографского заказа, помещаемые в левом нижнем углу первой полосы каждого печатного листа и обозначает принадлежность листа к данному изданию.

	13
	Что в книге называется "фронтиспис"?
	А) иллюстрация в книге, помещаемая обычно на левой стороне разворота титульного листа. Может иметь вид воспроизведенных в различных техниках портрет автора книги или лица, о котором идет рассказ.
Б) редко используемый в отечественном книжном деле термин, обозначающий то же, что и авантитул.
В) последняя страница издания с его выпускными данными.
Г) чистая страница, используемая в издании для композиционно-ритмических целей при оформлении. Иногда это оборот титульного листа, шмуцтитула.

	14
	Что в книге называется "авантитул"?
	А) разновидность титульного листа, декоративные и изобразительные элементы которого располагаются на первом развороте книги.
Б) добавочный титульный лист, помещаемый на одном развороте с основным‚ переводных изданиях на нем приводятся те же сведения, что и на титульном листе, но на языке оригинала.
В) добавочный титул, помещаемый перед титульным листом для предохранения его от загрязнения, порчи.
Г) первая страница книжного блока, один из титульных элементов декоративно-композиционного назначения. Содержит некоторую часть выходных данных: издательскую марку (или наименование издательства) либо марку серии, реже - эпиграф, посвящение.

	15
	С помощью каких команд можно скрыть направляющие?
	А) W
Б) Q
В) Е
Г) Ctrl + ;

	16
	Что в книге называется "кант"?
	А) конструктивный элемент издания в виде листа плотной бумаги или тонкого картона, на который наклеивают иллюстрационный материал.
Б) картонная коробка, предназначенная для упаковки и защиты ценных изданий от повреждений при транспортировке и для улучшения товарного вида. 
В) край переплетной крышки или обложки, выступающий за обрез блока.
Г) чистая страница, используемая в издании для композиционно-ритмических целей при оформлении.

	17
	Что такое инкунабулы?
	А) книжные издания раннего периода книгопечатания (условно до 1 Января 1501 г.), внешне похожи на рукописные книги. 
Б) подобранные в порядке следования страницы, скрепленные между собой в корешке и обрезанные с трех сторон. 
В) издания, содержащие два текста, которые начинаются с обеих сторон обложки или переплетной крышки, при этом каждый из текстов имеет свой титульный лист и свою пагинацию.
Г) отдельные оттиски иллюстративного материала или текста, вклеиваемые между определенными страницами издания.

	18
	Как называются загнутые края суперобложки?
	А) канты
Б) расставы
В) отставы
Г) клапаны

	19
	Что называют в книге "сторонками"?
	А) соотношение ширины и высоты страницы издания; непосредственно связанные с его форматом. 
Б) латунные или цинковые шрифты, служащие для тиснения на переплетных крышках заголовков и других текстов.
В) две части титульного листа, композиционно составляющие единое целое, где текстовые и/или изобразительные элементы начинаются на левой странице разворота, а заканчиваются на правой.
Г) два листа картона оклеенных переплетным материалом и составляющих обложку.

	20
	Что в книге называется "крышка"?
	А) твердая обложка, изготовленная из картона и крепящаяся к книжному блоку при помощи форзацев.
Б) хлопчатобумажная или шелковая тесьма шириной до 10 мм с утолщенным цветным краем. 
В) край блока (книги, брошюры, журнала). Место, где скреплены все технологические элементы издания (тетради, марля, каптал, ляссе и пр.)
Г) запечатанная площадь страницы любого издания, на которой размещаются текст, иллюстрации.



Вариант №2

	№
	Вопрос
	Варианты ответа

	1
	Что в книжном издании называется "часть"?
	А) небольшая рубрика, имеющая специальное условное обозначение (знак §).
Б) структурно-композиционная единица текста издания, типографически выделенная и, как правило, имеющая собственный заголовок.
В) структурная единица текста произведения, представляющая собой наиболее крупную ступень его деления.
Г) система рубрик основного текста издания, в которой выявлена их связь и соподчиненность.

	2
	Что в книжном издании называется "раздел"?
	А) крупная рубрика, являющаяся одной из высших ступеней деления основного текста.
Б) самая мелкая структурно-композиционная единица текста, графически обозначаемая в наборе абзацным отступом, обратным абзацным отступом или неполной концевой строкой.
В) система рубрик основного текста издания, в которой выявлена их связь и соподчиненность.
Г) составная часть основного текста сборника, которая представляет собой законченное произведение, освещающее какую-либо тему.

	3
	Что в книжном издании называется "глава"?
	А) структурная часть основного теста издания, завершающая его, где подводятся итоги работы, делаются обобщения, выводы и т.п.
Б) структурная единица текста произведения, представляющая собой наиболее крупную ступень его деления.
В) элемент аппарата научного журнала или сборника, содержащий главные положения и выводы статьи и помещаемый обычно в ее конце.
Г) крупная рубрика, имеющая самостоятельный заголовок. Нередко объединяются в разделы или части произведения и, в свою очередь, могут делиться на параграфы.

	4
	Что в книжном издании называется "комментарий"?
	А) помещаемая в начале издания сопроводительная статья, в которой поясняются цели и особенности содержания и построения произведения.
Б) составная часть аппарата издания, в которой дается характеристика содержания произведения(ий) и/или его автора(ов).
В) сопроводительная статья, помещаемая после основного текста произведения(ий)
Г) составная часть аппарата издания, представляющая собой свод сведений, которые разъясняют и толкуют факты, слова, фрагменты текста или всего произведения.

	5
	Что в книжном издании называется "сноска"?
	А) элемент аппарата издания, содержащий вспомогательный текст пояснительного или справочного характера, помещаемый внизу полосы и снабженный знаком сноски (цифровым номером или астериском).
Б) элемент аппарата издания, содержащий указания на источник, в котором разъясняются или уточняются сведения, приводимые в основном тексте издания.
В) составная часть аппарата издания, которая обеспечивает поиск необходимых сведений, заключенных в издании.
Г) сопроводительная статья, помещаемая после основного текста произведения(ий).

	6
	Что в книжном издании называется "предисловие"?
	А) комментарий, объясняющий слова и обороты речи, непонятные читателю, и построенные в форме алфавитного словаря.
Б) сопроводительная статья, помещаемая после основного текста произведения(ий).
В) помещаемая в начале издания сопроводительная статья, в которой поясняются цели и особенности содержания и построения произведения.
Г) составная часть аппарата издания, содержащая перечень заголовков разделов, глав и других структурных единиц текста издания с указанием страниц, на которых размещается каждая из них.

	7
	Что в книжном издании называется "ссылка"?
	А) составная часть выходных сведении, включающая данные о месте выпуска издания, имени издателя и годе выпуска издания.
Б) элемент аппарата издания, содержащий указания на источник, в котором разъясняются или уточняются сведения, приводимые в основном тексте издания.
В) условное буквенно-цифровое обозначение фамилии автора или первого слова заглавия издания.
Г) составная часть выходных сведений, включающая следующие данные: номер лицензии на издательскую деятельность и дату ее выдачи; дату подписания издания в печать; формат бумаги и долю листа.

	8
	Что в книжном издании называется "сигнет"?
	А) украшение в виде небольшого графического изображения сюжетно-тематического или орнаментального характера, помещаемое на переплете, обложке, на начальной и концевой полосе.
Б) украшение с изображением сюжетно-тематического или орнаментального характера, помещаемое вверху начальной страницы издания или его структурной части.
В) украшение в виде узора, характеризующееся ритмически упорядоченным расположением повторяющихся изобразительных элементов.
Г) фирменный знак, эмблема издательства, типографии или серии, воспроизводимый в издании на авантитуле, титульном листе, обложке или переплете.

	9
	Что в книжном издании называется "двухступенчатый колонтитул"?
	А) колонтитул с одинаковыми или однотипными данными на каждой странице разворота.
Б) колонтитул с разными данными на правой и левой страницах разворота.
В) колонтитул с неменяющимися данными.
Г) колонтитул с меняющимися по мере перехода от одной статьи (раздела) к другой данными.

	10
	Что в периодических изданиях имеет название "ISSN"?
	А) идентификационный код регистрационного характера, проставляемый на книгах.
Б) идентификационный код регистрационного характера, проставляемый на сериальных изданиях.
В) знак, который указывает на то, что произведение и/или другие части издания охраняются авторским правом.
Г) международный стандарт форматов изданий.

	11
	Что создает команда CreateGuides (Создать направляющие) из меню Layout (Макет)? 
	А) макет направляющих с фиксированным расстоянием между ними
Б) макет направляющих с указанием количества вертикальных и горизонтальных направляющих
В) добавочный титульный лист, помещаемый на одном развороте с основным
Г) текстовой фрагмент на латинском языке по объему превышающий размер фрейма

	12
	Какой командой опцией мы пользуемся при редактировании полосы в меню Layout?
	А) Margins and Columns
Б) Ruler Guides
В) Create Guides
Г) Go To Link

	13
	С помощью какой команды можно узнать и изменить параметры страниц?
	А) Ctrl + Shift + Alt + P
Б) Ctrl + Shift + P
В) Ctrl + Alt + P
Г) Link File Info

	14
	Что представляет собой шмуцтитул?
	А) в старопечатных книгах добавочный титул, помещаемый перед титульным листом для предохранения его от загрязнения, порчи.
Б) добавочный титульный лист, помещаемый на одном развороте с основным.
В) четырехстраничный лист бумаги, одна сторона которого приклеивается к внутренней стороне переплетной крышки, узкой полоской у корешка - к первой и последней страницам издания.
Г) оборотная сторона титульного листа, на которой размещают некоторые элементы выходных сведений.

	15
	С помощью какой команды можно скрыть выделенный объект?
	А) Ctrl + 3
Б) Ctrl + Alt + 3
В) Ctrl + Shift + 3
Г) Ctrl + Shift + Alt + 3

	16
	Что в книге называется "ляссе"?
	А) край переплетной крышки или обложки, выступающий за обрез блока.
Б) ленточка-закладка, полоска бумаги или полимерного материала, служащая для отметки места чтения.
В) прочное покрытие издания, содержащее ряд его выходных сведений. 
Г) конструктивный элемент издания в виде листа плотной бумаги или тонкого картона, на который наклеивают иллюстрационный материал. 

	17
	В палитре Links (Связи) показаны все связанные изображения документа с номерами страниц. Где расположено изображение, если вместо номера страницы стоит сокращение <PB>?
	А) за границами рабочего стола
Б) в рабочей области файла
В) изображение отсутствует
Г) в рабочей области графического фрейма

	18
	Какие в программе многостраничной верстки используются изображения для создания дуплексных изображений?
	А) в режиме Bitmap
Б) в цветовой модели RGB
В) в цветовой модели СМYK
Г) в оттенках серого (Grayscale)

	19
	Каким сочетанием клавиш можно закрепить объект?
	А) Ctrl + Alt + B
Б) Ctrl + U
В) Ctrl + L
Г) Ctrl + 2

	20
	Что представляет собой фортитул?
	А) редко используемый в отечественном книжном деле термин, обозначающий то же, что и авантитул.
Б) четырехстраничный лист бумаги, одна сторона которого приклеивается к внутренней стороне переплетной крышки, а другая, в большинстве книг, узкой полоской у корешка - к первой и последней страницам издания.
В) в старопечатных книгах добавочный титул, помещаемый перед титульным листом для предохранения его от загрязнения, порчи.
Г) двойной титульный лист, композиционно составляющий единое целое, где текстовые и/или изобразительные элементы начинаются на левой странице разворота, а заканчиваются на правой.



Критерии оценки: за каждый правильный ответ теста студент может получить 0,25 балла. При условии всех правильных ответов - максимально возможное количество баллов – 5.

8.8. Зачёт с оценкой
Одними из точек контроля знаний, умений и профессионально-личностных качеств студентов, являются выставки-просмотры, выполненных работ по основным темам дисциплины «Проектирование в графическом дизайне».
Пояснения: Обязательным условием допуска студента к зачёту с оценкой является выполнение им самостоятельной и практической работы за V семестр, ответы на контрольные вопросы. Зачёт с оценкой - итог качества работы студентов за V семестр (3 курс обучения). Он проходит в форме выставки-просмотра, где студенты сдают в электронном формате индивидуально выполненные семестровые задания, которые должны по объёму, содержанию и уровню исполнения соответствовать требованиям дисциплины, а также выставляют в распечатанном виде экспозиции форматом А2. 



[bookmark: _Hlk181920078][bookmark: _Hlk181920400]8.8.1. Выставка-просмотр выполненных практических работ 
для проведения зачёта с оценкой за V семестр

После того, как выставили работы, студенты выходят из компьютерной аудитории. На выставку-просмотр приглашают других преподавателей профильных дисциплин кафедры графического дизайна с целью коллегиальной, объективной оценки уровня выполненных студентами работ. Вместе с тем, после коллегиального обсуждения, ведущий преподаватель дисциплины приглашает студентов в аудиторию, где при необходимости задаёт возникшие дополнительные вопросы по основам макетирования книжных изданий, либо проводит тестирование. 
Таким образом, ведущий преподаватель объективно выставляет оценку на зачёте каждому студенту.
[bookmark: _Hlk181918135]Примечание: на усмотрение проводящего контроль преподавателя, выставка-просмотр выполненных практических работ за V семестр может быть заменена устным контролем знаний с помощью вопросов для проведения зачёта с оценкой за V семестр, либо заменена тестированием для проведения зачёта с оценкой за V семестр.

Алгоритм работы студентов в процессе просмотра-выставки работ на зачёте с оценкой:
1. Выставить в электронном виде на компьютере и сдать распечатанную на бумаге итоговую семестровую работу согласно выданным ранее требованиям к заданию. 
2. При необходимости ответить на задаваемые ведущим дисциплину преподавателем вопросы, либо пройти тестирование.
3. Обосновать своё графическое решение по индивидуально выполненному заданию.
4. Осуществить анализ достоинств и недостатков своих работ.
5. [bookmark: _Hlk30497708]Сделать выводы. Определить перспективы дальнейшего саморазвития и самосовершенствования.

Критерии оценки семестровых работ состоят из следующих параметров:

– выбор формата изданий;
- обоснование выбора шрифтовых гарнитур;
- расчёт формата полосы набора;
– идейно-образное решение композиции текстового и иллюстративного материала 
в формате изданий;
- выбор и соподчинённость элементов дизайна в общей структуре издания;
- единство стиля элементов структуры макетов и иллюстративного материала;
-  правила композиции в иллюстрациях и верстке. Конструкция полосы;
 - соблюдение ритма;
- цветовое решение;
 - нацеленность на поиск новых решений и в верстке и иллюстративном материале; 
 - аккуратность верстки;
– передача пространства в иллюстрациях;
– детализация и акцент на главном;
– целостность, обобщение работы.

	Оценка
	Характеристика знания предмета и ответов

	отлично (5)
	Студент выявляет глубокие знания по курсу, осознание важности теоретических знаний в его профессиональной подготовке; свободно использует возможности аппаратных и программных средств, понимает логику и специфику определенного круга прикладных программ, владеет техническими приемами и умеет разработать методику создания, обработки или корректировки рабочих файлов. Рассказывает материал в полном объеме, логично, без существенных ошибок, не требует дополнительных вопросов, выводы доказательные, опираются на теоретические знания, используются навыки, необходимые для ответа. 

	хорошо (4)
	Студент выявляет полные знания теоретического материала по вопросам, включенным в курс, умение оперировать необходимыми понятиями и их определениями на аналитическом уровне; понимает связки между определенным кругом прикладных программ, владеет техническими приемами и умеет разработать простую методику создания, обработки или корректировки рабочих файлов. А также в устном изложении материала есть несущественные ошибки, нет достаточной систематизации и последовательности, выводы содержат отдельные неточности. 

	удовлетворительно (3)
	Студент показывает достаточные теоретические знания из предлагаемых вопросов на уровне репродуктивного воспроизведения, понимает связки между определенным кругом прикладных программ, но не ориентируется в кругу возможностей аппаратных и программных средств и не очень уверенно владеет техническими приемами обработки или корректировки рабочих файлов. А также в устном изложении материала есть существенные пробелы, отсутствует его систематизация, имеют место ошибки, в том числе в выводах, слабая аргументация, не выявлены основные умения. 

	неудовлетворительно (2)
	Студент имеет поверхностные знания по теории, ошибки в определении понятий, имеет достаточно путаное понимание о приложении аппаратных и программных средств, не имеет базовых навыков работы в программе, не в состоянии разработать методику создания, обработки или корректировки рабочих файлов. Студент не в состоянии раскрыть главное содержание материала. 



[bookmark: _Hlk30505969]8.8.2. Вопросы для контроля знаний студентов
в ходе проведения зачёта с оценкой за V семестр

Примечание: Зачёт с оценкой выставляется по суммарному баллу практической и самостоятельной работ, в связи с тем, что знания, полученные студентом, в большей степени усваиваются путём выполнения практических и самостоятельных заданий, согласно специфике дисциплины «Проектирование в графическом дизайне». Вместе с тем, в процессе проверки выполненных заданий преподаватель с целью более глубокого контроля знаний студентов и объективной оценки, может задавать вопросы по теоретическому материалу дисциплины. 
[bookmark: _Hlk181918140]На усмотрение проводящего контроль преподавателя теоретические вопросы для устного контроля знаний в ходе проведения зачёта с оценкой за V семестр, могут быть заменены выставкой-просмотром выполненных практических работ для проведения зачёта с оценкой за V семестр, либо тестами для проведения зачёта с оценкой за V семестр.

1. Дайте определение понятию «колонтитул»?
2. Что в книжных изданиях имеет название «ISBN»?
3. Дайте определение понятию «шмуцтитул»?
4. Для чего в книге предназначено «ляссе»?
5. Что представляет собой «контртитул»?
6. Расскажите, что представляет собой в книжном издании «форзац»?
7. Что представляет собой «колофон»?
8. Для чего в книжном издании необходима «сигнатура»?
9. Расскажите, что в книге называется «каптал» и для чего он служит?
10. Что представляет собой «распашной титул»?
11. Что представляет собой «пагинация»?
12. Что представляет собой «нахзац»?
13. Для чего в книжном издании необходима «норма»?
14. Что в книге называется «фронтиспис»?
15. Расскажите, что представляет собой в книжном издании «авантитул»?
16. Что в книге называется «кант»?
17. Расскажите, что такое «инкунабулы»?
18. Что называют в книге «сторонками»?
19. Что в книге называется «крышка»?
20. Что в книге называется «книжный блок»?
21. Для чего в книжном издании необходим «рубчик»?
22. Что в книжном издании называют «отставом»?
23. Что в книжном издании называют «расставом»?
24. Расскажите, что представляет собой в книжном издании «твердый переплет»?
25. Для чего ряду книжных изданий необходим «футляр или короб»?
26. Что представляет собой в книжном издании «суперобложка»?
27. Расскажите, о том, как могут быть скреплены между собой в корешке листы книги?
28. Какие существуют средства защиты книжных изданий при транспортировке их в сети книжных магазинов?
29. Что представляет собой «спуск полос»?
30. Что в книжном издании называется «сигнет»?

8.8.3. Тестовые вопросы для контроля знаний 
в ходе проведения зачёта с оценкой за V семестр

Примечание: Зачёт с оценкой выставляется по суммарному баллу практической и самостоятельной работ, в связи с тем, что знания, полученные студентом, в большей степени усваиваются путём выполнения практических и самостоятельных заданий, согласно специфике дисциплины «Проектирование в графическом дизайне». Вместе с тем, в процессе проверки выполненных заданий преподаватель с целью более глубокого контроля знаний студентов и объективной оценки, может провести тестирование по теоретическому материалу дисциплины. 
[bookmark: _Hlk181918143]На усмотрение проводящего контроль преподавателя, тестирование для проведения зачёта с оценкой может быть заменено на устный контроль знаний с помощью вопросов для проведения зачёта с оценкой за V семестр, либо может быть заменено выставкой-просмотром выполненных практических работ за V семестр.
Тестирование в ходе проведения зачёта с оценкой, на усмотрение проводящего контроль преподавателя, может проходит либо на бумажных носителях, либо при помощи программного обеспечения, позволяющего проводить электронное тестирование. 
При использовании бумажных носителей, ведущий дисциплину преподаватель произвольно выбирает для тестирования 30 вопросов из 50 предоставленных.


	№
	Вопрос
	Варианты ответа

	1
	Формы фреймов можно изменить с помощью:
	А) Инструмента Реn (Перо)
Б) Инструмента Pencil (Карандаш)
В) Инструментом с быстрой клавишей <N>
Г) Инструментом с быстрой клавишей <P>

	2
	Можно ли создать собственный тип линии в программе многостраничной вёрстки?
	А) Да
Б) Нет

	3
	Преобразование текстовых элементов в графические векторные изображения осуществляется в программе многостраничной верстки.
	А) Инструментом Реn (Перо) для добавления, удаления и редактирования узловых точек.
Б) Инструментом Direct Selection (Прямое выделение)
В) Быстрыми клавишами <Shift+Ctrl+O>

	4
	Как производится автоматическая нумерация страниц?
	А) <Alt>+<Shift>+<Ctrl>+<N>
Б) <Alt>+<Ctrl>+<N>
В) Type> Insert Special Character> Auto Page Number

	5


	Неделимый пробел выполняется с помощью …
	А) … быстрых клавиш <Alt>+<Ctrl>+<Х>
Б) … команды No Break (Не разделять) из контекстного меню палитры Paragraph
В) … командой Туре>Insert White Space>Nonbreaking Space

	
6
	Возможно ли импортирование текста в документ программы многостраничной верстки из файлов Microsoft Word без открытия последних?
	А) Да
Б) Нет

	
7
	Создание направляющих на целый разворот возможно …
	А) … с одновременным нажатием клавиши Ctrl
Б) … без нажатия клавиш
В) … с одновременным нажатием клавиши Alt
Г) … комбинацией клавиш Ctrl+F

	


8

	Командой CreateGuides (Создать направляющие) из меню Layout (Макет) можно создать …
	А) Макет направляющих с фиксированным расстоянием между ними
Б) Сеть вертикальных и горизонтальных направляющих
В) Макет направляющих с указанием количества вертикальных и горизонтальных направляющих
Г) Новые направляющие

	


9
	Как в программе многостраничной верстки создаются одновременно вертикальная и горизонтальная направляющие:

	А) Щелкнуть при нажатой клавише <Ctrl> в левом верхнем углу (там, где пересекаются обе линейки) и перетащить курсор.
Б) Щелкнуть при нажатой клавише <Ctrl> из верхней линейки.
В) Щелкнуть при нажатой клавише <Ctrl> из нижней линейки.

	
10


	Выделение всех объектов в слое?
	А) Щелчок на названии слоя в палитре Layers (Слои)
Б) при нажатой клавише <Alt>
В) Щелчок на названии слоя в палитре Layers (Слои)

	
11


	Могут ли одни и те же отдельные элементы шаблонной страницы видоизменяться (изменять размер, цвет, трансформации) и размещаться в различных местах на текущих страницах, принадлежащих к этому шаблону?
	А) Да
Б) Нет

	12

	Может ли обычная текущая страница не принадлежать ни к какой шаблонной странице?
	А) Да
Б) Нет

	13
	Возможно ли внедрение графики в публикацию программы многостраничной верстки?
	А) Да
Б) Нет

	14
	В каком случае размер файла публикации будет больше?
	А) со связанным изображением
Б) с внедренной графикой

	15

	Каким маркером обозначается текст, который не умещается в ячейку таблицы?
	А) Красным квадратом с плюсом внутри
Б) Красной точкой
В) Красным квадратом со стрелкой внутри

	16
	Что называют «форзац»?
	А) Первая страница книжного блока, один из титульных элементов декоративно-композиционного назначения, появляющийся в книге, как правило, при наличии контртитула или фронтисписа.
Б) Иллюстрация в книге, помещаемая обычно на левой стороне разворота титульного листа.
В) Четырехстраничный лист бумаги, одна сторона которого приклеивается к внутренней стороне переплетной крышки, а другая, в большинстве книг, узкой полоской у корешка - к первой и последней страницам издания.
Г) Последняя страница издания с его выпускными данными.

	17

	Что такое «нахзац»?
	А) Элемент издания в виде односгибного листа бумаги или конструкции из двух листов, скрепляющий книжный блок с задней сторонкой переплетной крышки.
Б) Четырехстраничный лист бумаги, одна сторона которого приклеивается к внутренней стороне переплетной крышки, а другая, узкой полоской у корешка - к первой и последней страницам издания.
В) Последняя текстовая или смешанная полоса издания или его части, обычно заполненная не до конца.
Г) Начальная строка с абзацным отступом.

	18

	Что такое «сигнатура»?
	А) Порядковый номер печатного листа издания, помещаемый в нижнем поле первой полосы перед нормой. Служит для контроля при комплектовании тетрадей в книжный блок.
Б) Краткое название издания, или фамилия автора, или номер типографского заказа, помещаемые в левом нижнем углу первой полосы каждого печатного листа.
В) Порядковая нумерация страниц (полос), столбцов (колонок) или отд. элементов издания (отрезков текста, таблиц, иллюстраций и др.). 
Г) Край переплетной крышки или обложки, выступающий за обрез блока.

	
19
	Что такое «авантитул»?
	А) Разновидность титульного листа, декоративные и изобразительные элементы которого располагаются на первом развороте книги.
Б) Добавочный титульный лист, помещаемый на одном развороте с основным‚ переводных изданиях на нем приводятся те же сведения, что и на титульном листе, но на языке оригинала.
В) Добавочный титул, помещаемый перед титульным листом для предохранения его от загрязнения, порчи.
Г) Первая страница книжного блока, один из титульных элементов декоративно-композиционного назначения. Содержит некоторую часть выходных данных: издательскую марку (или наименование издательства) либо марку серии, реже - эпиграф, посвящение.

	20

	Что такое «глава»?
	А) Структурная часть основного теста издания, завершающая его, где подводятся итоги работы, делаются обобщения, выводы и т.п.
Б) Структурная единица текста произведения, представляющая собой наиболее крупную ступень его деления.
В) Элемент аппарата научного журнала или сборника, содержащий главные положения и выводы статьи и помещаемый обычно в ее конце.
Г) Крупная рубрика, имеющая самостоятельный заголовок. Нередко объединяются в разделы или части произведения и, в свою очередь, могут делиться на параграфы.

	21

	Что называется в книжном издании «часть»?
	А) Небольшая рубрика, имеющая специальное условное обозначение (знак §).
Б) Структурно-композиционная единица текста издания, типографически выделенная и, как правило, имеющая собственный заголовок.
В) Структурная единица текста произведения, представляющая собой наиболее крупную ступень его деления.
Г) Система рубрик основного текста издания, в которой выявлена их связь и соподчиненность.

	22

	Что такое ISBN?
	А) Идентификационный код регистрационного характера, проставляемый на книгах.
Б) Идентификационный код регистрационного характера, проставляемый на сериальных изданиях.
В) Знак, который указывает на то, что произведение и/или другие части издания охраняются авторским правом.
Г) Международный стандарт форматов изданий.

	23

	Что такое «фронтиспис»?
	А) Иллюстрация в книге, помещаемая обычно на левой стороне разворота титульного листа. Может иметь вид воспроизведенных в различных техниках портрет автора книги или лица, о котором идет рассказ.
Б) Редко используемый в отечественном книжном деле термин, обозначающий то же, что и авантитул.
В) Последняя страница издания с его выпускными данными.
Г) Чистая страница, используемая в издании для композиционно-ритмических целей при оформлении. Иногда это оборот титульного листа, шмуцтитула.

	24


	Что такое «норма»?
	А) Линейка, помещаемая вверху полосы и отделяющая колонтитул от текста. 
Б) Краткий   заголовок, помещаемый над текстом начальной полосы книги или её части, главы и отделённый от него крупным пробелом.
В) Порядковая нумерация страниц (полос), столбцов (колонок) или отд. элементов издания (отрезков текста, таблиц, иллюстраций и др.). 
Г) Краткое название издания, или фамилия автора, или номер типографского заказа, помещаемые в левом нижнем углу первой полосы каждого печатного листа и обозначает принадлежность листа к данному изданию.

	25
	Что называют «контртитул»?
	А) Редко используемый в отечественном книжном деле термин, обозначающий то же, что и авантитул. 
Б) Левая часть разворотного титула. Контртитул содержит выходные данные, характерные для многотомного или серийного издания в целом.
В) В старопечатных книгах добавочный титул, помещаемый перед титульным листом для предохранения его от загрязнения, порчи. Современный шмуцтитул, предваряет часть, главу издания, содержит краткое название этой части или главы, эпиграф и т. д. 
Г) Порядковый номер печатного листа издания, помещаемый в нижнем поле первой полосы.

	26


	Что такое «пагинация»?
	А) Порядковая нумерация страниц (полос), столбцов (колонок) или отд. элементов издания (отрезков текста, таблиц, иллюстраций и др.).
Б) Краткое название издания, или фамилия автора, или номер типографского заказа, помещаемые в левом нижнем углу первой полосы каждого печатного листа.
В) Элемент структуры издания, содержащий некоторые справочные данные об издании, например, фамилию автора, заглавие книги.
Г) Иллюстрация, размещенная на развороте.

	27
	Для создания дуплексных изображений в программе многостраничной вёрстки какие используются изображения?
	А) В режиме Bitmap
Б) В цветовой модели RGB
В) В цветовой модели СМYK
Г) В оттенках серого (Grayscale)

	28

	В палитре Links (Связи) показаны все связанные изображения документа с номерами страниц. Где расположено изображение, если вместо номера страницы стоит сокращение <PB>?
	А) За границами рабочего стола
Б) В рабочей области файла
В) Изображение отсутствует
Г) В рабочей области графического фрейма

	29
	Установите правильную последовательность в иерархии структуры книги от самой крупной её составляющей:
	1. Глава 
2. Часть 
3. Раздел
4. Параграф
	A) 1, 4, 2, 3
Б) 4, 1, 2, 3 
В) 3, 1, 4, 2 
Г) 2, 3, 1, 4

	30
	Установите правильную последовательность элементов книжного издания от его начала до конца:
	1. Авантитул
2. Содержание 
3. Титульный лист 
4. Колофон
	A) 4, 3, 2, 1
Б) 3, 4, 2, 1
В) 1, 3, 2, 4 
Г) 4, 2, 1, 3

	31
	Установите классическую последовательность расположения информации на титульном листе книжного издания сверху вниз:
	1. Год издания 
2. Название произведения 
3. Место издания 
4. Имя автора издания
	A) 1, 4, 2, 3 
Б) 4, 2, 3, 1
В) 3, 1, 4, 2
Г) 2, 3, 1, 4

	32
	Установите последовательность верстки макета книжного издания:
	1. Разработка композиции страниц 
2. Поиск концепции оформления издания
3. Подготовка издания к печати
4. Создание макета
	A) 2, 1, 4, 3 
Б) 1, 2, 3, 4 
В) 3, 2, 1, 4 
Г) 2, 3, 1, 4

	33
	Установите последовательность создания шаблона страниц книжного издания:
	1. Создание сетки базовых линий на полосе книжного издания
2. Определение формата книжного издания 
3. Расчет полосы книжного издания
4. Создание нумерации и колонтитулов страниц
	A) 2, 3, 1, 4 
Б) 1, 2, 3, 4
В) 3, 2, 1, 4
Г) 4, 1, 3, 2

	34
	Установите соответствие кеглей шрифта возрастным категориям в детских книжных изданиях:
	1. 16 pt
2. 18 pt
3. 12 pt
4. 14 pt
	A) Младший школьный возраст 
Б) Средний школьный возраст 
В) Дошкольный возраст 
Г) Старший школьный возраст

	35
	Установите соответствие между страницами книжного издания и размещенной на них информацией:
	1. Титульный лист 
2. Фронтиспис 
3. Авантитул 
4. Колофон
	A) Название произведения, автор произведения, место и год издания
Б) Портрет автора произведения 
В) Фирменный знак или название издательства, реже – кому посвящено произведение
Г) Часть выпускных данных

	36
	Установите соответствие элементам книги:
	1. Сигнет 
2. Ляссе 
3. Крышка 
4. Рубчик
	A) Ленточка-закладка, служащая для отметки места чтения
Б) Фирменный знак издательства, воспроизводимый на авантитуле, обложке или переплете
В) Твердая обложка, изготовленная из картона и крепящаяся к книжному блоку при помощи форзацев
Г) Углубление, которое делается на лицевой стороне и обороте переплета для улучшения раскрываемости книги 

	37
	Установите соответствие между типами титулов и их использованием в книжном издании:
	1. Распашной титул
2. Титульный лист 
3. Контртитул 
4. Авантитул
	A) Страница книги, на которой напечатано ее название, имя автора, место и год издания
Б) Левая часть разворотного титула. Может содержать выходные данные, характерные для многотомного или серийного издания или содержит те же сведения, что и на титульном листе, но на языке автора.
В) Разновидность титульного листа, декоративные и изобразительные элементы которого располагаются на первом развороте книги 
Г) Первая страница книжного блока. Содержит издательскую марку (или наименование издательства) либо марку серии, реже – эпиграф, посвящение.

	38
	Установите соответствие между классификацией изданий и их целевому назначению:
	1. Научно-популярное издание
2. Официальное издание
3. Справочное издание
4. Издание для досуга
	A) Издание, содержащее сведения о исследованиях, изложенных в форме, доступной читателю-неспециалисту
Б) Издание, публикуемое от имени госорганов или учреждений, содержащее материалы нормативного или директивного характера
В) Издание, содержащее краткие сведения, расположенные в порядке, удобном для их быстрого отыскивания
Г) Издание, содержащее общедоступные сведения по организации быта, различным видам творчества и увлечениям

	39
	Дайте развернутый ответ на вопрос какие существуют средства защиты книжного издания от повреждения для доставки его на прилавки книжных магазинов, а также служат защитой от изнашивания?

	40
	Объясните, почему рекомендованное максимальное количество символов в строке для латинского и кириллического набора в литературно-художественном книжном издании разное?

	41
	Дайте ответ на вопрос: что представляет собой фронтиспис?

	42
	Какой элемент книжного издания раньше выполнял функции защиты страниц от загрязнений и повреждений, а в современной интерпретации выполняет больше декоративную функцию? Обоснуйте свой выбор.
	A) Фронтиспис
Б) Шмуцтитул 
В) Колофон 
Г) Содержание

	43
	Какому числу всегда кратно количество страниц в тетрадках книжного издания? Обоснуйте свой выбор.
	A) 3 
Б) 11 
В) 8 
Г) 15

	44
	Как назывались первые печатные книги? Обоснуйте свой выбор.
	A) Плоттерными 
Б) Триангулярными 
В) Перевертыши 
Г) Инкунабулы

	45
	Какое существует основное требование, которому должны отвечать формат издания и формат полосы набора поэтического произведения? Обоснуйте свой выбор.
	A) Выключка в тексте должна быть перпендикулярной горизонтали оси центра полосы
Б) Стихотворные строки должны размещаться на полосе без переносов или с наименьшим их числом 
В) Кегль основного текста должен быть таким же, как и кегль в колонтитуле издания
Г) Все строки должны иметь на полосе разный интерлиньяж.

	46
	Выберите несколько ответов и обоснуйте свой выбор.
При оформлении заголовков и подзаголовков какие необходимо соблюдать основные правила?
	A) Переносы слов в заголовке не разрешаются 
Б) Большой заголовок делится по смыслу на несколько строк 
В) В конце заголовка точка не ставится, остальные знаки препинания (многоточие, вопросительный, восклицательный) сохраняются 
Г) В заголовках может быть наличие переносов слов по слогам

	47
	Выберите несколько ответов и обоснуйте свой выбор.
Кто из перечисленных личностей внес значительный вклад в искусство расчёта пропорций книжных полос?
	A) Анри де Тулуз-Лотрек
Б) Душан Шульц 
В) Ян Чихольд 
Г) Густав Мильхзак

	48
	Выберите несколько ответов и обоснуйте свой выбор.
Выберите основные варианты построения свободных стихов?
	A) Ступенчатое построение (лесенкой).  
Б) С выключкой строк по центру 
В) Флаговое построение
Г) Смешанное (комбинированное) построение

	49
	Выберите несколько ответов и обоснуйте свой выбор.
Какие существуют основные единицы измерения полосы?
	A) Пункт
Б) Цицеро (Пики)
В) Квадрат 
Г) Куб

	50
	Выберите несколько ответов и обоснуйте свой выбор.
Кто из перечисленных личностей внес значительный вклад в развитие книгопечатания?
	A) Иоганн Гутенберг
Б) Иван Фёдоров 
В) Франсуа Дидо
Г) Казимир Малевич




Критерии оценки: при верно данных ответах в диапазоне от 54% до 30% от общего количества произвольно выбранных программой тестирования 30-и из 50 вопросов — оценка 3 балла; при верно данных ответах в диапазоне от 84% до 55% от общего количества произвольно выбранных программой 30-и из 50 вопросов — оценка 4 балла; при верно данных ответах в диапазоне от 85% до 100% от общего количества произвольно выбранных программой 30-и из 50 вопросов — оценка 5 баллов. 
8.9. Тестовые задания, которые выдаются в середине VI семестра для контроля знаний в ходе проведения текущей аттестации
ТЕСТ

Примечание: на усмотрение проводящего контроль преподавателя, тестирование проходит либо на бумажных носителях, либо при помощи программного обеспечения, позволяющего проводить электронное тестирование.

Вариант №1

	№
	Вопрос
	Варианты ответа

	1
	С помощью какой команды возможно добавление объектов в выделенную группу или удаление из нее?
	А) Alt + любой инструмент ввода (текста)
Б) Ctrl + любой инструмент перо
В) Shift + любой инструмент выделения 

	2
	С помощью какой команды возможно перемещение объекта с копированием?
	А) Alt +  любой инструмент выделения или трансформирования 
Б) Shift +  любой инструмент перо
В) Ctrl +  любой инструмент ввода (текста)

	3
	С какой клавишей производят перемещение объекта в направлении, кратном 45 градусам?
	А) Alt, любой инструмент трансформирования и выделения, исключая инструмент Reflect (Отражение)
Б) Shift, любой инструмент трансформирования и выделения, исключая инструмент Reflect (Отражение)
В) Ctrl, любой инструмент трансформирования и выделения,исключая инструмент Reflect (Отражение)

	4
	С помощью какой команды можно сделать переключение на инструмент ZOOM IN (Увеличить)?
	А) Shift + Пробел
Б) Alt + Пробел
В) Сtrl + Пробел

	5
	С помощью какой команды возможно переключение на инструмент Hand (Рука)
	А) Пробел (кроме текстового режима) 
Б) Alt (кроме текстового режима) 
В) Сtrl + Пробел (кроме текстового режима) 

	6
	С какой клавишей производят рисование правильных геометрических фигур?
	А) Ctrl
Б) Alt
В) Shift

	7
	С какой клавишей производят включение инструментов выделения при работе с любым другим инструментом?
	А) Ctrl
Б) Alt
В) Shift

	8
	С какой клавишей производят рисование прямоугольников и эллипсов из центра?
	А) Ctrl
Б) Alt
В) Shift

	9
	С какой клавишей производят перемещение геометрической фигуры во время рисования?
	А) пробел
Б) Ctrl + пробел
В) Alt + Ctrl + пробел

	10
	С какой клавишей производят увеличение числа сторон в многоугольнике, углов звезды, завитков спирали?
	А) Стрелка вправо
Б) Стрелка влево
В) Стрелка вверх
Г) Стрелка вниз

	11
	С какой клавишей возможен вызов линейки?
	А) Ctrl + L
Б) Ctrl + R
В) Ctrl + H

	12
	Какое клавиатурное сокращение соответствует команде Send To Back (Переместить объект на самый задний план)?
	А) Ctrl + Shift + [
Б) Shift + Page Down 
В) Ctrl + Shift + Стрелка вниз 
Г) Ctrl + Стрелка вниз

	13
	Какая команда применяется для показа сетки прозрачности?
	А) Ctrl + Shift + T
Б) Ctrl + Shift + D
В) Ctrl + Alt + W
Г) Ctrl + Alt + T

	14
	При помощи какой функции возможно пропорциональное масштабирование выделенных объектов?
	А) Ctrl +  маркеры "габаритного прямоугольника"
Б) Alt +  маркеры "габаритного прямоугольника"
В) Shift +  маркеры "габаритного прямоугольника"
Г) Ctrl +  Shift +  маркеры "габаритного прямоугольника"

	15
	Какое клавиатурное сокращение делает возможным увеличение/ уменьшение интерлиньяжа?
	А) Alt + >/<
Б) Alt + Стрелка вверх/Стрелка вниз
В) Alt + Стрелка вправо/Стрелка влево

	16
	Какая функция клавиш позволяет вклеить содержимое буфера обмена под низ выделенного объекта?
	А) Ctrl + F
Б) Ctrl + B
В) Ctrl + V

	17
	Какое необходимо выполнить действие для того, чтобы показать/скрыть габаритный блок?
	А) Ctrl + Alt + G
Б) Ctrl + H
В) Ctrl + Shift + B

	18
	Какое действие позволит закрыть открытый в программе файл?
	А) Ctrl + W
Б) Ctrl + Q
В) Ctrl + E

	19
	Какое клавиатурное сокращение соответствует команде Transform Again (Трансформировать снова (повторить действие))
	А) Ctrl + D
Б) Shif + F
В) Alt + D

	20
	Какой командой возможно увеличение/
уменьшение кернинга и трекинга?
	А) Alt + Стрелка вправо/Стрелка влево
Б) Alt + Стрелка вверх/Стрелка вниз 
В) Alt + >/< 



Вариант №2

	№
	Вопрос
	Варианты ответа

	1
	Какая функция клавиш позволяет вклеить содержимое буфера обмена поверх выделенного объекта?
	А) Ctrl + F
Б) Ctrl + B
В) Ctrl + V
Г) Ctrl + K
Д) Ctrl + Y

	2
	С какой клавишей производят уменьшение числа сторон в многоугольнике, углов звезды, завитков спирали?
	А) Стрелка вправо
Б) Стрелка влево
В) Стрелка вверх
Г) Стрелка вниз
Д) Ctrl

	3
	Какое клавиатурное сокращение соответствует команде Bring To Front (Переместить объект на самый передний план)?
	А) Shift + A
Б) Ctrl + Shift + ]
В) Shift + Page Up
Г) Ctrl + Shift + Стрелка вверх
Д) Ctrl + Shift + [

	4
	Какое клавиатурное сокращение соответствует команде Bring Forward (Сдвинуть вверх на один объект)?
	А) Ctrl + ]
Б) Ctrl + Page Up
В) Shift + Стрелка вверх
Г) Ctrl + Shift + вверх\вниз
Д) Shift + вверх\вниз

	5
	Какое клавиатурное сокращение соответствует команде Hide Selection (Спрятать выделенные объекты)?
	А) Ctrl + 3
Б) Ctrl + Shift + 3
В) Ctrl + Shift + Alt + 3
Г) Ctrl + K
Д) Ctrl + Y

	6
	Какое действие выполнит группировку выделенных объектов?
	А) Ctrl + С
Б) Ctrl + G
В) Ctrl + K
Г) Ctrl + Shift + G
Д) Ctrl + F

	7
	Какое действие выполнит блокировку (закрепить) выделенных объектов?
	А) Ctrl + 3
Б) Ctrl + Shift + 4
В) Ctrl + 2
Г) Ctrl + Shift + 2
Д) Ctrl + Shift + Alt + 2

	8
	Какое клавиатурное сокращение соответствует команде Show All (Показать все)?
	А) Ctrl + Alt + 3
Б) Ctrl + Shift + 3
В) Ctrl + Shift + Alt + 3
Г) Ctrl + Alt + 2
Д) Ctrl + Shift + 2

	9
	Какая команда позволяет соединить разорванный контур?
	А) Ctrl + 5
Б) Ctrl + J
В) Ctrl + Y
Г) Ctrl + А
Д) Ctrl + К

	10
	Какая команда позволяет создать Clipping Mask (Отсекающую (обтравочную) маску)?
	А) Ctrl + 5
Б) Ctrl + 6
В) Ctrl + 7
Г) Ctrl + 8
Д) Ctrl + 9

	11
	Какое клавиатурное сокращение соответствует команде Blend / Make (Превращение / Создать "Блэнды")?
	А) Ctrl + Shift + Alt + B
Б) Ctrl + Shift + B
В) Ctrl + Alt + B
Г) Ctrl + Shift + O
Д) Ctrl + Al + Shift + O

	12
	С помощью какой команды можно просмотреть контурный вид объектов в файле?
	А) Ctrl + U
Б) Ctrl + Y
В) Ctrl + J

	13
	Какая команда позволяет преобразовать текст в "кривые"?
	А) Ctrl + Alt + R
Б) Ctrl + Shift + Q
В) Ctrl + Shift + O

	14
	С помощью какой команды можно показать / спрятать границы выделения?
	А) Ctrl + H
Б) Ctrl + T
В) Ctrl + I

	15
	С помощью какой команды можно Вызвать палитру Character (Символ)?
	А) Ctrl + T
Б) Ctrl + C
В) Ctrl + R

	16
	Какое клавиатурное сокращение соответствует команде показать/скрыть Smart Guides ("Умные" направляющие)?
	А) Ctrl + Shift + Alt + <
Б) Ctrl + Shift + ;
В) Ctrl + Alt + ;
Г) Ctrl + U
Д) Ctrl + H

	17
	Какое клавиатурное сокращение соответствует команде увеличение/уменьшение кегля?
	А) Ctrl + H
Б) Shift + Ctrl + X
В) Shift + Ctrl + >/< 
Г) Shift + Alt + Стрелка вверх/Стрелка вниз

	18
	Какое клавиатурное сокращение соответствует команде Average (Выровнять точки)?
	А) Ctrl + Alt + F
Б) Ctrl + A
В) Ctrl + Alt + J

	19
	Каким сочетанием клавиш можно сгруппировать выделенные объекты?
	А) Ctrl + С
Б) Ctrl + G
В) Ctrl + K

	20
	Какое клавиатурное сокращение соответствует команде Show/Hide Guides (Показать / Спрятать направляющие)?
	А) Ctrl + H
Б) Ctrl + ;
В) Ctrl + I



Критерии оценки: за каждый правильный ответ теста студент может получить 0,25 балла. При условии всех правильных ответов - максимально возможное количество баллов – 5.

8.10. Итоговые тестовые задания, 
которые выдаются в конце VI семестра

ТЕСТ

Примечание: на усмотрение проводящего контроль преподавателя, итоговое семестровое тестирование проходит либо на бумажных носителях, либо при помощи программного обеспечения, позволяющего проводить электронное тестирование. 
При использовании бумажных носителей, ведущий дисциплину преподаватель произвольно выбирает для тестирования 30 вопросов из 90 предоставленных.

	№
	Вопрос
	Варианты ответа

	1

	Для чего предназначен инструмент Magic Wand Tool?
	А) Для выделения всех растровых объектов, находящихся в файле.
Б) Для выделения объектов, к которым были применены одинаковые цветовые модели.
В) Для выделения объектов с одинаковыми цветовыми характеристиками.
Г) Для выделения объектов с одинаковыми габаритными показателями.

	2

	Если в текстовом фрейме присутствует табуляция, с помощью каких инструментов можно увеличить или уменьшить текстовый фрейм пропорционально вместе с табуляцией?
	А) Scale Tool
Б) Free Transform
В) Selection Tool
Г) Direct Selection Tool
Д) В программе выполнить данное действие невозможно

	3
	С помощью какой команды возможно при помощи одного объекта разрезать объекты находящиеся над или под ним?
	А) Object > Path > Divide Objects Below
Б) Object > Divide Objects Below
В) Object > Path > Divide Objects Backward
Г) Object > Divide Objects Backward
Д) В программе данное действие выполнить невозможно.

	4
	С помощью какой команды возможно заменить текстовый символ во всем документе?
	А) Type>Find Font...
Б) Type>Find Type...
В) Edit>Find and Replace...
Г) Edit>Replace Font...
Д) Edit>Type and Replace...

	5
	С помощью какой команды возможно заменить во всем файле одну шрифтовую гарнитуру на другую?
	А) Type>Find Font...
Б) Edit>Find and Replace...
В) Type>Find and Replace...
Г) В программе данное действие выполнить невозможно.

	6
	При помощи какой функции, возможно изменять насыщенность нескольких выделенных объектов?
	А) Edit>Edit Colors>Saturate
Б) Object>Colors>Saturate
В) Object>Edit Colors>Saturate
Г) В программе данное действие выполнить невозможно.

	7
	Что произойдет, если объект на который было назначено обтекание текстом, переместить под текст?
	А) Ничего не произойдет.
Б) Исчезнет назначенное ранее обтекание с объекта.
В) Назначенное обтекание на объекте останется, но текст примет изначальную форму по фрейму.
Г) Программа запросит при помощи диалогового окна внести корректуру в опциях назначенного обтекания.

	8
	Какая комбинация клавиш позволяет закрепить все объекты кроме выделенного?
	А) Ctrl+Alt+2
Б) Ctrl+Alt+Shift+2
В) Ctrl+Shift+2
Г) Ctrl+Shift+Alt+2
Д) Ctrl+Shift+Alt+3

	9
	При помощи какой функции возможно перевести текст в "кривые"?
	А) Type>Create Outline
Б) Type>Font>Create Outline
В) Type>Create Outline
Г) Type>Path>Create Outline

	10
	При помощи какой функции возможно сделать выделенные символы прописными/строчными/с заглавной/первая буква в предложении с заглавной?
	А) Type>Recent Fonts>Register Fonts...
Б) Type>Glyphs
В) Type>Path>Change Case
Г) Type>Change Case

	11
	При помощи какой команды возможно обрезать растровое изображение?
	А) Object>Flatten Transparency
Б) Object>Rasterize
В) Object>Path>Separate Raster Object
Г) Object>Separate Transparency
Д) Object>Envelope Distort>Rastr Option

	12
	Возможно ли в программе обрезать встроенное растровое изображение?
	А) Да
Б) Нет

	13
	Возможно ли в программе обрезать помещенное растровое изображение?
	А) Да
Б) Нет

	14
	Какая комбинация клавиш вызывает диалоговое окно, в котором возможно назначить свои клавиатурные сокращения?
	А) Ctrl+Alt+Alt+F
Б) Ctrl+Alt+Shift+B
В) Ctrl+Shift+Alt+K
Г) В программе данное действие выполнить невозможно.

	15
	С какой клавишей удаляют узлы с градиентной сетки "мэш"?
	А) Ctrl
Б) Alt
В) Shift
Г) Ctrl+Alt
Д) В программе данное действие выполнить невозможно.

	16
	С помощью каких действий возможно помещение текста в нарисованный "плашечный" объект любой формы (в том числе и в объект нерегулярной формы), находящийся выше помещаемого в него текста?
	А) Ctrl+Alt+C
Б) Ctrl+Shift+Alt+C
В) Ctrl+Alt+R
Г) Object > Envelope Distort > Make with Top Object
Д) В программе данное действие выполнить невозможно.

	17
	Что произойдет с примененными к объектам эффектами Photoshop если к ним применить функцию Expand Appearance?
	А) Эффект разделится на простые составляющие
Б) Эффект растрируется
В) Эффект соединится с объектом, к которому он был применен
Г) Эффект станет вектором
Д) В программе данное действие выполнить невозможно.

	18
	Можно ли отдавать файл, содержащий не расширенные кисти и символы в печать офсетным способом?
	А) Да
Б) Нет

	19


	Как в программе упаковать в одну папку файл, все помещенные в него фотографии и используемые в нем шрифты?
	А) С помощью функции Package... из меню File
Б) С помощью функции Package... из меню Edit
В) С помощью функции Place... из меню File
Г) С помощью клавиатурных сокращений Alt+Shift+Ctrl+P
Д) С помощью клавиатурных сокращений Alt+Shift+P
Е) С помощью клавиатурных сокращений Ctrl+Shift+P

	
20
	Можно ли отдавать файл, содержащий не расширенные эффекты и "бленды" в печать офсетным способом?
	А) Да
Б) Нет

	
21


	Каким инструментом можно редактировать маску прозрачности находясь в ней?
	А) Opacity Mask
Б) Gradient
В) Rectangle
Г) Warp Tool
Д) Eraser

	

22


	Перед тем, как создать графический символ из комбинированного векторного и помещенного в файл растрового изображения, какое, из предложенных действий следует выполнить?
	А) выделить растровое изображение и в контекстном меню палитры Links выбрать действие Embed Image
Б) следует на всех объектах на которые назначен контур при помоши команды Object > Path > Outline Stroke расширить контур, только после этого станет возможным создание символа
В) выделить группу комбинированных изображений (вектор и растр) и перевести их в растр при помощи команды Rasterize...
Г) зайти в контекстное меню палитры Symbols и включить функцию Allow making the symbol

	23
	С помощью какой команды можно расширить "бленды"?
	А) Object > Expand
Б) Object > Expand Appearance
В) Object > Blend > Expand
Г) Object > Blend > Expand Option Blend

	
24


	При помощи каких, из предложенных, действий возможно выровнять узлы?
	А) Ctrl+J
Б) Ctrl+Alt+J
В) Ctrl+K
Г) Ctrl+Alt+K
Д) Object > Path > Average...
Е) Object > Average point
Ж) Выделить узлы и выровнять их в палитре Align

	
25


	Как можно замкнуть незамкнутый контур?
	А) при помощи клавиатурных сокращений Ctrl+J
Б) при помощи клавиатурных сокращений Ctrl+Alt+C
В) при помощи клавиатурных сокращений Ctrl++Alt+A
Г) Object > Path > Join
Д) Object > Path > Average point
Е) Object > Path > Connect point

	26

	Как встроить помещенное изображение в файл?
	А) Необходимо выделить помещенное в файл изображение и после этого, в палитре Links, нажать на появившуюся кнопку Place Image.
Б) Необходимо выделить помещенное в файл изображение и после этого, в контекстном меню палитры Attributes, выбрать функцию Place Image(s).
В) Необходимо выделить помещенное в файл изображение и после этого, в палитре Control, нажать на появившуюся кнопку Embed.
Г) Необходимо выделить помещенное в файл изображение и после этого, в контекстном меню палитры Links, выбрать функцию Embed Image(s).
Д) Необходимо выделить помещенное в файл изображение и после этого, в контекстном меню палитры Document, выбрать функцию Embed Image(s).

	27

	Пропорционально уменьшить или увеличить контур можно…
	А) Выбрав инструмент Scale Tool и нажав клавишу Enter в появившемся диалоговом окне Scale установить данную опцию.
Б) Выбрав инструмент Free Transform Tool и нажав клавишу Enter в появившемся диалоговом окне Scale установить данную опцию.
В) В контекстном меню палитры Stroke выбрав опцию Free Transform Stroke
Г) Выбрав инструмент Selection Tool и при трансформировании зажать клавишу Shift

	28
	Выровнять несколько объектов относительно любого из них можно...
	А) Выровнять несколько объектов относительно любого из них можно...
Б) Выровнять несколько объектов относительно любого из них можно...
В) Выровнять несколько объектов относительно любого из них можно...
Г) Выровнять несколько объектов относительно любого из них можно...

	29
	Каким образом можно выделять отдельные объекты в группе и манипулировать ими?
	А) С помощью инструмента Group Selection выделить объект внутри группы и сменить на инструмент Selection изменить его, не влияя на остальные объекты группы.
Б) Следует выделить объект инструментом Selection и перетаскивать маркеры рамки габаритного блока, ограничивающей объект.
В) Следует выделить объект инструментом Selection и выбрать команду меню Effect > Distort & Transform > Transform.
Г) С помощью инструмента Group Selection выделить объект внутри группы и изменить его размер потянув за маркеры трансформации, не влияя на остальные объекты группы.

	30


	Как в программе расширить контур?
	А) Зайти в основное меню программы Object и выбрать команду Path > Outline Stroke.
Б) Зайти в основное меню программы Object и выбрать команду Path > Offset Path.
В) С помощью горячих клавиш Ctrl+Alt+P
Г) С помощью горячих клавиш Ctrl+Shift+O

	31


	В какой палитре можно отредактировать или отменить "эффект"?
	А) Attributes
Б) Appearance
В) Flattener Preview
Г) Variables
Д) Effect Transform
Е) Effect

	32



	Как в программе выровнять несколько выделенных объектов, на одном из которых назначен контур, по этому же контуру?
	А) В контекстном меню палитры Align включить функцию Use Preview Bounds
Б) В контекстном меню палитры Align включить функцию Align Key Object
В) В контекстном меню палитры Align включить функцию Align On Path
Г) В программе выполнить данное действие невозможно

	33
	Какая комбинация клавиш позволяет скрыть все не закрепленные объекты кроме выделенного?
	А) Ctrl+Alt+2
Б) Ctrl+Alt+Shift+2
В) Ctrl+Shift+3
Г) Ctrl+Shift+Alt+2
Д) Ctrl+Shift+Alt+3
Е) Ctrl+Alt+3
Ж) Ctrl+3

	34
	Штрихи, созданные с помощью этой кисти, похожи на эффект плакатного пера. При этом кисти круглой или приплюснутой формы. Эта кисть называется ...
	А) Каллиграфическая
Б) Разделенная
В) Художественная
Г) Бордюрная

	35

	При использовании данного типа кистей объекты (листья, жучки, пузырьки и т.д.) располагаются вдоль пути следования кисти. Эта кисть называется ...
	А) Каллиграфическая
Б) Разделенная
В) Художественная
Г) Бордюрная

	36

	При использовании этой кисти объект распределяется вдоль траектории, заданной инструментом. В этих кистях используется имитация различных графических средств. Эти кисти называются ...
	А) Каллиграфическая
Б) Разделенная
В) Художественная
Г) Бордюрная

	
37
	С помощью данного типа кисти создается узор, состоящий из разных фрагментов. Сложность создания данной кисти состоит в задании и определении места нахождения каждого из фрагментов. Эта кисть называется ...
	А) Каллиграфическая
Б) Разделенная
В) Художественная
Г) Бордюрная

	38

	В чем разница между градиентной заливкой и "блэндами"?
	А) В градиенте цвета переходят друг в друга внутри градиентной заливки, в "блендах" они переходят друг в друга между объектами.
Б) Градиентная заливка "весит" тяжелее чем "бленды".
В) Количество стэпов в градиентной заливке ограничивается количеством 256 шагов, а в блендах это количество достигает 1024.
Г) Разницы нет

	39

	Как сохранить различные градиенты?
	А) В контекстном меню палитры Gradient назначить действие Save Gradient Fill
Б) Перенести захватив курсором назначенный градиент (иконка Gradient Fill) из палитры Gradient в палитру Swatches.
В) В основном меню программы Object > Fill > Save Gradient Fill
Г) В программе выполнить данное действие невозможно.

	40

	Какое существует в программе количество инструментов для ввода текста?
	А) 1
Б) 2
В) 3
Г) 4
Д) 5
Е) 6
Ж) 7

	41


	Какое количество выключек текста существует в программе в палитре Paragraf?
	А) 1
Б) 2
В) 3
Г) 4
Д) 5
Е) 6
Ж) 7

	42
	Возможно ли в программе применение "бленд" к тексту?
	А) Возможно
Б) Невозможно
В) Возможно, если текст переведен "в кривые"

	43


	Возможно ли в программе применение "мешей" к тексту?
	А) Возможно
Б) Невозможно
В) Возможно, если текст переведен "в кривые"

	44


	С помощью, какой команды возможно в программе применение "мешей" к тексту?
	А) Object > Envelope Distort > Make with Warp...
Б) Object > Live paint > Make with Warp...
В) Object > Text Wrap > Make 
Г) Type> Type Effect > Make Mesh

	45
	Отметьте, в каких цветовых моделях работает программа?

	А) Grayscale
Б) RGB
В) CMYK
Г) LAB
Д) PNDS
Е) HSL

	46

	Как поместить изображение в файл?
	А) С помощью функции Insert... из меню File
Б) С помощью функции Place... из меню File
В) С помощью клавиатурного сокращения Shift+Ctrl+P
Г) С помощью клавиатурного сокращения Ctrl+Alt+P
Д) С помощью клавиатурного сокращения Shift+Alt+Ctrl+P

	47

	Какая комбинация клавиш выполняет действие "Закрепить выделенный объект"?
	А) Ctrl+2  
Б) Ctrl+Alt+2
В) Ctrl+Shift+2
Г) Ctrl+Shift+Alt+2
Д) В программе из предложенных комбинаций клавиш, выполняющих данное действие нет.

	
48


	Какая комбинация клавиш выполняет действие "Показать все скрытые объекты"?
	А) Ctrl+3
Б) Ctrl+Alt+3
В) Ctrl+Shift+3
Г) Ctrl+Shift+Alt+3
Д) В программе из предложенных комбинаций клавиш, выполняющих данное действие нет.

	
49
	Какая комбинация клавиш выполняет действие "Вклеить под низ выделенного объекта"?
	А) Ctrl+F
Б) Ctrl+B
В) Ctrl+V
Г) Ctrl+Shift+F
Д) В программе из предложенных комбинаций клавиш, выполняющих данное действие нет.

	50

	Какая комбинация клавиш выполняет действие "Переместить объект на самый задний план"?
	А) Ctrl+Shift+]
Б) Ctrl+Shift+[
В) Ctrl+]
Г) Ctrl+Alt+]
Д) В программе из предложенных комбинаций клавиш, выполняющих данное действие нет.

	51

	Какая комбинация клавиш выполняет действие "Вклеить поверх выделенного объекта"?
	А) Ctrl+F
Б) Ctrl+B
В) Ctrl+V
Г) Ctrl+Shift+B
Д) В программе из предложенных комбинаций клавиш, выполняющих данное действие нет.

	52
	Какая комбинация клавиш выполняет действие "Показать/скрыть габаритный блок"?
	А) Ctrl+Alt+G
Б) Ctrl+H
В) Ctrl+Shift+B
Г) Ctrl+Shift+H
Д) В программе из предложенных комбинаций клавиш, выполняющих данное действие нет.

	53
	Какая комбинация клавиш выполняет действие "Повторить последнее действие"?
	А) Ctrl+D
Б) Ctrl+Alt+3
В) Ctrl+Alt+K
Г) Ctrl+Alt+J
Д) В программе из предложенных комбинаций клавиш, выполняющих данное действие нет.

	54

	Временное переключение при работе с любым инструментом на инструменты выделения происходит при нажатии клавиши…?
	А) Ctrl
Б) Shift
В) Alt

	55
	Какая из предложенных команд, удаляет все незакрепленные и не скрытые объекты, которые не имеют атрибутов цвета заливки и обводки?
	А) Select > Object > Without Attribute
Б) Select > Same > Fill & Stroke
В) Object > Path > Clean Up
Г) Object > Path > Offset Path

	56

	Минимальная толщина четко пропечатываемой обводки офсетным способом печати составляет...?
	А) 0,1 pt
Б) 0,2 pt
В) 0,25 pt
Г) 0,3 pt
Д) 0,35 pt

	57

	Расширить эффект, примененный к объекту, можно ли при помощи какой-либо из предложенных команд?
	А) Object > Expand Effect
Б) Object > Expand Appearance
В) Object > Flatten Effect
Г) В программе из предложенных команд, выполняющей данное действие нет.

	58
	Можно ли при помощи инструмента Magic Wand Tool выделить объекты и текст с одинаковыми цветовыми характеристиками?
	А) Да
Б) Нет

	59

	С помощью какой команды можно расширить графические символы?
	А) Object > Expand
Б) Object > Expand Appearance
В) Object > Expand Simbols
Г) Object > Flatten Effect
Д) В программе из предложенных команд, выполняющей данное действие нет.

	60

	В какой палитре назначается маска прозрачности?
	А) Attributes
Б) Appeaгance
В) SVG Interactivity
Г) Transparency
Д) Effects

	61

	В какой палитре можно сохранить образцы градиентов?
	А) Color
Б) Swatches
В) Gradient
Г) Layers

	62

	В какой палитре отображается состояние помещенной растровой графики?
	А) Color
Б) Attributes
В) SVG Interactivity
Г) Links
Д) Layers

	63
	Файл со встроенной растровой графикой будет "весить" легче или тяжелее файла со связанной (помещенной) растровой графикой?
	А) Легче
Б) Тяжелее
В) Будут весить одинаково

	64
	Для офсетного вида печати отдавать в типографию можно файл, если он соответствует следующим параметрам…
	А) Ai; Растровая графика встроена, 300 dpi, jpg, RGB
Б) Ai; Растровая графика встроена, 300 dpi, tif, RGB
В) Ai; Растровая графика встроена, 300 dpi, jpg, CMYK
Г) Ai; Растровая графика встроена, 300 dpi, tif, CMYK
Д) EPS; Растровая графика встроена, 300 dpi, tif, CMYK
Е) EPS; Растровая графика встроена, 300 dpi, tif, RGB

	65

	Отметьте одно из основных преимуществ шрифтов формата Open Type
	А) Эти шрифты работают как в системах Windows, так и в системах Macintosh.
Б) Эти шрифты могут быть использованы без потери качества при создании WEB-сайтов
В) Эти шрифты имеют встроенную возможность поддержки RGB и LAB.

	66

	Какими способами можно блокировать слои?
	А) Щелкнуть мышью на столбце слева от имени слоя; появляется значок в форме замка, который указывает, что слой блокирован
Б) Выбрать в меню палитры Layers (Слои) команду Lock Others (Блокировать остальные), чтобы блокировать все слои кроме активного слоя
В) Можно скрыть слой, чтобы защитить его от изменений

	67
	Как в программе можно конвертировать отсканированные изображения в векторный формат?
	А) Воспользоваться командой Object > Image Trace > Make
Б) Воспользоваться командой Object > Live Trace > Tracing Options
В) Воспользоваться командой Object > Envelope Distort > Mace
Г) Вызвав из меню Window палитру Image Trace
Д) Воспользоваться командой Ctrl+Alt+B

	68

	Что относится к преимуществам использования графических символов?
	А) Упрощение использования многократно повторяющихся фигур.
Б) При внесении изменений в один символ обновлению подвергаются все экземпляры этого символа.
В) Возможность отображения рисунков на поверхности трехмерных объектов.

	69
	Для чего служит инструмент Group Selection?
	А) Инструмент Group Selection указывает ограничивающую рамку выделенных объектов.
Б) Для выделения объектов с общими признаками.
В) Для выделения отдельных объектов или подгруппы объектов внутри группы и изменять их, не влияя на остальные объекты группы.

	70

	Возможно ли в программе создать файл с несколькими рабочими областями?
	А) Да
Б) Нет

	71

	Что позволяет создавать подключенный флажок Dashed Line в палитре Stroke?
	А) Свой тип линий
Б) Пунктир
В) Произвольную толщину линий
Г) Скруглять концы линий

	72
	В какой палитре существует возможность изменить координаты и размер объекта?
	А) Attributes
Б) Appearance
В) Transform
Г) Variables
Д) Pathfinder
Е) Document Info

	73

	С помощью какой команды в программе происходит создание объектов "клонов"?
	А) Object > Expand Appearance
Б) Object > Envelope Distort > Mace
В) Effect > Distort & Transform > Transform
Г) Type> Type Effect > Make Mesh

	74
	При встроенном растровом изображении в файл векторного редактора что станет с файлом? Обоснуйте свой выбор.
	A) Вес файла векторного редактора станет больше
Б) Вес файла векторного редактора станет меньше
В) Тип файла станет растровым 
Г) Изменится формат файла векторного редактора
	A) Вес файла векторного редактора станет больше


	75
	Установите правильную последовательность этапов создания объемного натюрморта в векторном графическом редакторе:
	1. Поместить фотографию натюрморта в файл векторного графического редактора 
2. При помощи эффектов программы и инструмента градиентная сетка мэш отрисовать каждый элемент натюрморта
3. При помощи эффектов программы наложить текстуры на векторные элементы натюрморта
 4. Собрать векторный натюрморт, идентичный помещенному растровому изображению.
	A) 1, 2, 3, 4
Б) 2, 1, 4, 3 
В) 3, 1, 2, 4 
Г) 4, 3, 2, 1

	76
	Установите правильную последовательность этапов создания портрета, имитирующего технику туши в векторном графическом редакторе:
	1. При помощи кисти сделать на бумаге мазок тушью и отсканировать результат.
2. Поместить изображение мазка тушью в векторный редактор и при помощи функций палитры Image Trace от трассировать его, сделав этот мазок векторным.
3. Поместить векторный мазок в палитру Brushes и в результате чего создать новую кисть, имитирующую мазок тушью. 
4. Отрисовать портрет кистью имитирующей мазок тушью. 
	A) 4, 3, 2, 1 
Б) 2, 1, 3, 4 
В) 1, 2, 3, 4 
Г) 3, 1, 2, 4

	77
	Установите правильную последовательность этапов создания портрета, имитирующего технику акварели в векторном графическом редакторе:
	1. Отрисовать портрет кистями, имитирующими мазки акварельной краски.
2. Поместить изображения акварельных мазков в векторный редактор и при помощи функций палитры Image Trace от трассировать их, сделав эти мазки векторными.
3. Поместить по одному векторные мазки в палитру Brushes и в результате чего создать новые кисти, имитирующие мазки акварельной краски.
4. При помощи акварельной кисти сделать на бумаге акварельными красками мазки необходимых цветов и отсканировать результат.
	A) 1, 4, 2, 3 
Б) 4, 2, 3, 1
В) 3, 1, 4, 2
Г) 2, 3, 1, 4

	78
	Установите соответствие между меню программы векторного графического редактора и его содержимым:
	1. Меню, содержащее общие команды редактирования (копирование, вырезания и вставка объектов), команды настроек
2. Меню, в котором собраны команды выделения объектов, выделения объектов по общим признакам
3. Меню, в котором собраны команды работы со шрифтами
4. Меню, в котором собраны команды работы c эффектами программы
	A) Edit
Б) Select
В) Type 
Г) Effect

	79
	Установите соответствие между палитрами и их функциями в векторном графическом редакторе:
	1. Align 
2. Stroke
3. Pathfinder 
4. Transform
	A) Выравнивание объектов
Б) Работа с контуром 
В) Функции палитры позволяют создавать сложные фигуры, разрезать фигуры на новые формы или объединять несколько объектов в одну фигуру.
Г) Работа с размерами объектов, их расположением согласно оси координат

	80
	Установите соответствие между палитрами и их функциями в векторном графическом редакторе:
	1. Transparence 
2. Character 
3. Layers
4. Color
	A) Работа со шрифтовыми гарнитурами, их кеглем, интерлиньяжем, трекингом и кернингом.
Б) Работа со слоями файла 
В) Работа с прозрачностью объектов
Г) Работа с цветом заливки объектов и цветом контуров объектов

	81
	Дайте развернутый ответ на вопрос: что представляет собой функция Package (Упаковать) в векторном графическом редакторе и в чем положительный аспект данной функции?

	82
	Объясните, почему не желательно отдавать в печать офсетным способом макет, созданный в векторном графическом редакторе, с объектами к которым были применены прозрачность и эффекты.

	83
	Дайте развернутый ответ на вопрос: для чего предназначен инструмент Magic Wand (Волшебная палочка) в векторном графическом редакторе?

	84
	Дайте сравнительный анализ векторным редакторам.

	85
	Как называется меню с командами отображения палитр, основного средства управления векторного графического редактора? Обоснуйте свой выбор.
	A) Window
Б) Edit
В) Object
Г) File

	86
	Как называется меню векторного графического редактора, где собраны команды режима просмотра, масштабирования, отображения? Обоснуйте свой выбор.
	A) Select
Б) View
В) Edit
Г) Help

	87
	Как называется меню векторного графического редактора, содержащее операции с объектами - изменение порядка наложения, блокирование, группировка, скрытие, работу с «блендами», графиками?
Обоснуйте свой выбор.
	A) Window
Б) Help
В) Object
Г) View

	88
	Выберите несколько ответов и обоснуйте свой выбор.
Какие из перечисленных параметров должны быть у цветного растрового изображения при использовании его в файле векторного графического редактора, подготовленного для печати офсетным способом?
	A) Цветовая модель CMYK
Б) Растровая графика встроена
В) Резолюция растрового файла 300 dpi
Г) Анимация должна не превышать 24 кадров 

	89
	Выберите несколько ответов и обоснуйте свой выбор.
Какие составляющие макета собирает векторный графический редактор в одну папку при использовании функции Package (Упаковать)?
	А) Все используемые в файле шрифты 
Б) Копию макета 
В) Инсталляцию программы
Г) Все помещенные в файл растровые и векторные объекты 


	90
	Выберите несколько ответов и обоснуйте свой выбор.
Какие из перечисленных кистей используются в векторном графическом редакторе?
	A) Каллиграфические (Calligraphic) кисти
Б) Анимированные (Animation) кисти
В) Художественные (Art) кисти
Г) Шаблонные (Pattern) (или бордюрные) кисти



Критерии оценки: при верно данных ответах в диапазоне от 54% до 30% от общего количества произвольно выбранных программой тестирования 30-и из 90 вопросов — оценка 3 балла; при верно данных ответах в диапазоне от 84% до 55% от общего количества произвольно выбранных программой 30-и из 90 вопросов — оценка 4 балла; при верно данных ответах в диапазоне от 85% до 100% от общего количества произвольно выбранных программой 30-и из 90 вопросов — оценка 5 баллов.

8.11. Тестовые задания, которые выдаются в VII семестре для контроля знаний в ходе проведения текущей аттестации
ТЕСТ

	№
	Вопрос
	Вариант ответа
	код
	балы

	1
	Какой из перечисленных вариантов относится к элементам фирменного стиля:
	шрифты, которые используются при создании фирменного стиля;
	а
	0,25

	
	
	фирменные цвета;
	б
	

	
	
	логотип;
	в
	

	
	
	все варианты верны;
	г
	

	2
	Понятие «гайдлайн» обозначает: 

	свод правил, где описываются вариации использования логотипа бренда и фирменных шрифтов;
	а
	0,25

	
	
	брошюра, описывающая фирменные цвета и их использование в брендированной полиграфической продукции;
	б
	

	
	
	руководство, в котором содержится набор правил по использованию цветов, логотипа, слогана, товарного знака, шрифтов и других составляющих фирменного стиля.
	в
	

	3
	Аббревиатура POS (Point of Sale) в переводе означает —
	точка продаж;
	а
	0,25

	
	
	логотип;
	б
	

	
	
	цветовая гамма;
	в
	

	
	
	шрифты.
	г
	

	4
	В каких четырех основных зонах размещается рекламная продукция в точках продаж:
	в пространстве входной группы;
	а
	0,25

	
	
	в торговом зале;
	б
	

	
	
	в складской зоне;
	в
	

	
	
	в местах выкладки товара
	г
	

	
	
	в прикассовой зоне;
	д
	

	5
	Какие функции выполняют POS-материалы? (несколько вариантов ответов)
	помогает найти дорогу к торговой точке или нужному товару;
	а
	0,25

	
	
	привлекает внимание потенциального покупателя;
	б
	

	
	
	предоставляет потребителю необходимую информацию о товаре;
	в
	

	
	
	анализ конкурентных компаний;
	г
	

	
	
	стимулирует совершить покупку как можно скорее;
	д
	

	
	
	побудить потенциального покупателя как можно дольше задержаться у стойки с товаром
	е
	

	6
	Выберите определение понятия «Воблер» — 
	это рекламные материалы прямоугольной формы (450х50мм), которые размещают на полках и витринах магазина для привлечения внимания клиентов;
	а
	0,25

	
	
	это относительно небольшие таблички из картона, ламинированной бумаги или пластика, чаще всего круглой формы(100х100мм), которые подвешиваются к полке с товаром с помощью гибкой пластиковой ножки;
	б
	

	
	
	рекламный материал, крепящийся на горлышко бутылки для привлечения внимания к товару;
	в
	

	
	
	табличка, которая вертикально крепится к полкам с продукцией, задача которой — остановить человека и приковать его внимание к рекламируемому товару.
	г
	

	7
	Укажите разновидности шелфтокеров по внешнему виду (несколько вариантов ответов):
	плоские
	а
	0,25

	
	
	треугольные
	б
	

	
	
	в форме буквы «Г»;
	в
	

	
	
	в форме буквы «Т»;
	г
	

	
	
	в форме буквы «О»;
	д
	

	
	
	в форме буквы «V»;
	е
	

	8
	Для печати плакатов большого формата используется:
	Струйный принтер;
	а
	0,25

	
	
	сублимационный принтер;
	б
	

	
	
	плоттер;
	в
	

	
	
	лазерная печать;
	г
	

	
	
	трафаретная печать;
	д
	

	9
	Можно ли редактировать логотип бренда, изменять такие параметры как ширину, наклон, пропорции, расположение элементов?
	нет, логотип нельзя редактировать;
	а
	0,25

	
	
	в исключительных случаях можно;
	б
	

	
	
	да, логотип можно редактировать;
	в
	

	
	
	можно менять только наклон логотипа;
	г
	

	10
	Укажите какие бывают виды плакатов?
	Рекламный;
	а
	0,25

	
	
	Социальный;
	б
	

	
	
	Агитационный;
	в
	

	
	
	Иллюстрация.
	г
	

	11
	Последовательность обзора зрителем элементов на листе производится в порядке:
	Справа налево и снизу вверх;
	а
	0,25

	
	
	слева направо и сверху вниз;
	б
	

	12
	Некхенгер — это:
	это рекламные материалы прямоугольной формы(450х50мм), которые размещают на полках и витринах магазина для привлечения внимания клиентов;
	а
	0,25

	
	
	рекламный материал, крепящийся на горлышко бутылки для привлечения внимания к товару;
	в
	

	
	
	это относительно небольшие таблички из картона, ламинированной бумаги или пластика, чаще всего круглой формы(100х100мм), которые подвешиваются к полке с товаром с помощью гибкой пластиковой ножки;
	г
	

	
	
	табличка, которая вертикально крепится к полкам с продукцией, задача которой — остановить человека и приковать его внимание к рекламируемому товару.
	д
	

	13
	Расставьте в хронологическом порядке этапы разработки «шелфтокера»
	Произвести сбор и анализ аналогов шелфтокеров;
	а
	0,25

	
	
	На базе выполненных эскизов, создать макетирование и сборку шелфтокера для бренда;
	б
	

	
	
	Разработать общую концепцию шелфтокера для бренда;
	в
	

	
	
	Выполнить эскиз шелфтокера;
	г
	

	14
	Маскот в фирменном стиле — это:
	персонаж-талисман, который выполнен в фирменных цветах бренда;
	а
	0,25

	
	
	персонаж-талисман, узнаваемый персонаж, который олицетворяет собой бренд;
	б
	

	
	
	персонаж-талисман, который является средством пропаганды;
	в
	

	15
	Расставьте в хронологическом порядке этапы разработки бренда:
	Нейминг, разработка наименования бренда;
	а
	0,25

	
	
	Анализ рынка, конкурентных компаний, целевой аудитории;
	б
	

	
	
	Разработка логотипа, фирменного стиля;
	в
	

	
	
	Разработка коммуникационной стратегии по продвижению бренда;
	г
	

	16
	Дайте развернутый ответ: перечислите какие виды POS-материалов вы знаете?
	
	0,25

	17
	Дайте развернутый ответ: расскажите какие функции выполняют POS-материалы?
	
	0,25

	18
	Дайте развернутый ответ: перечислите носители фирменного стиля.
	
	0,25

	19
	Дайте развернутый ответ: расскажите для чего необходимо предварительно проводить анализ рынка и целевой аудитории перед разработкой собственного бренда?
	
	0,25

	20
	Дайте развернутый ответ: перечислите, что характерно для удачного нейминга?
	
	0,25


При условии всех правильных ответов - максимально возможное количество балов – 5.

8.12. Вопросы к экзамену в VII семестре

1.  Понятие системной рекламной коммуникации.  
2. История становления фирменного стиля как самостоятельного направления в дизайне.  
3. Понятие фирменного стиля и его роль в рекламных коммуникациях.  
4. Что входит в пакет фирменного стиля.  
5. Понятие торговой марки и товарного знака.  
6. Логотип в пакете фирменного стиля.  
7. Композиция фирменного знака.  
8. Символы в товарных знаках.  
9. Классификация фирменных знаков по Веркману.  
10. Особенности восприятия потребителем фирменного знака, логотипа.
11. Цветосимволика в рекламе.
12. Функциональная нагрузка шрифта в пакете фирменного стиля.
13. Перечислите виды pos-материалов.
14. Перечислите функции pos-материалов.
15. Перечислите этапы разработки бренда.
16. Сувенирная продукция в пакете фирменного стиля. 
17. Дополнительные элементы фирменного стиля: буклет, персонаж, спецодежда и пр. 
18. Сайт как носитель фирменного стиля и корпоративной культуры современной организации. 
19. Упаковка как элемент фирменного стиля.
20. Перечислите этапы разработки pos-материалов.

9. МЕТОДЫ ОБУЧЕНИЯ

В процессе обучения для достижения планируемых результатов освоения дисциплины используются следующие методы образовательных технологий:
- методы IT – использование Internet-ресурсов для расширения информационного поля и получения профессиональной информации; 
- междисциплинарное обучение – обучение с использованием знаний из различных областей (дисциплин), реализуемых в контексте конкретной задачи;
- проблемное обучение – стимулирование студентов к самостоятельному приобретению знаний для решения конкретной поставленной задачи;
- обучение на основе опыта – активизация познавательной деятельности студента посредством ассоциации их собственного опыта с предметом изучения.
Изучение дисциплины «Проектирование в графическом дизайне» осуществляется студентами в ходе прослушивания лекций, освоения материала с помощью практических работ, а также посредством самостоятельной работы с рекомендованной литературой.
В рамках лекционного курса материал излагается в соответствии с рабочей программой. При этом преподаватель подробно останавливается на концептуальных темах курса, а также темах, вызывающих у студентов затруднение при изучении. В ходе проведения лекции студенты конспектируют материал, излагаемый преподавателем, записывая подробно базовые определения и понятия.
Для изучения дисциплины предусмотрены следующие формы организации учебного процесса: лекции, практические занятия, самостоятельная работа студентов и консультации.



10. КРИТЕРИИ ОЦЕНИВАНИЯ ЗНАНИЙ СТУДЕНТОВ

	Оценка
	Характеристика знания предмета и ответов

	
	Критерии оценивания тестовых заданий

	отлично (5)
	Студент ответил на 85-100% вопросов.

	хорошо (4)
	Студент ответил на 84-55% вопросов.

	удовлетворительно (3)
	Студент ответил на 54-30% вопросов.

	неудовлетворительно (2)
	Студент ответил на 0-29% вопросов.

	
	Критерии оценивания выполнения задания

	отлично (5)
	Студент демонстрирует сформированность дисциплинарных компетенций на итоговом уровне, обнаруживает всестороннее, систематическое и глубокое знание учебного материала, усвоил основную литературу и знаком с дополнительной литературой, рекомендованной программой. Умеет собирать и анализировать необходимую информацию, используя Интернет и электронные базы данных. Свободно оперирует приобретенными знаниями, выполняя творческие задания, предусмотренные программой. 
Умеет вести компоновку и проектировать объекты дизайна с помощью компьютерных графических программ. Оформляет и готовит в печать творческий проект на высоком уровне.

	хорошо (4)
	Студент демонстрирует сформированность дисциплинарных компетенций на хорошем уровне, обнаруживает знания учебного материала, усвоил основную литературу, умеет собирать и анализировать необходимую информацию, используя Интернет и электронные базы данных. Выполняет задания, допуская незначительные ошибки и неточности. Умеет проектировать вести компоновку и проектировать объекты дизайна с помощью компьютерных графических программ.

	удовлетворительно (3)
	Студент демонстрирует сформированность дисциплинарных компетенций на базовом уровне: проявляется отсутствие отдельных знаний, умений, навыков по некоторым дисциплинарным компетенциям, студент испытывает значительные затруднения при оперировании знаниями и умениями, в ходе выполнения творческих заданий допускает значительные ошибки.

	неудовлетворительно (2)
	Студент демонстрирует сформированность дисциплинарных компетенций на уровне ниже базового, проявляется недостаточность знаний, умений, навыков. Выполняя творческие задания не в полном объеме испытывает значительные затруднения при оперировании знаниями и умениями.



11.  МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ
УЧЕБНАЯ И РЕКОМЕНДУЕМАЯ ЛИТЕРАТУРА

РАЗДЕЛЫ I-II
Основная литература:
 
1. Денизо, Ж. Краткая история искусств. Самое главное о мировом искусстве. — М. : Эксмо, 2019. — 320 с. — 978-5-04-088825-2
2. Бесчастнов Н. П. Художественный язык орнамента : учеб. пособ. для студ. вузов / Н. П. Бесчастнов. — М. : ВЛАДОС, 2010. — 335 с. : ил. — Изобразительное искусство. — 978-5-691-0 1702-5.  
3. Буткевич Л. М. История орнамента : учеб. пособ. / Л. М. Буткевич. — М. : Владос, 2008. — 267 с. : ил. — Изобразительное искусство. — 978-5-691-00891-7. 
4. Григорян Е. А. Основы композиции в прикладной графике : учеб.-метод. пособие для студентов и учащихся высших и средних спец. учеб. заведений. — Ереван : [б. и.], 1986. — 32 с.  
5. Даглдиян К. Т. Декоративная композиция : учеб. пособие / К. Т. Даглдиян. — 2-е изд., перераб. и доп. — Ростов н/Д : Феникс, 2010. — 312 с. : ил. 
6. Кон-Винер Э. История стилей изобразительных искусств / Эрнст Кон-Винер ; пер. с нем. ; под ред. М. М. Житомирского. — 4-е изд. — М. : Сварог и К, 2000. — 217 с.  
7. Лесняк В. Графический дизайн (основы профессии) / В. Лесняк. — [б. м.] : Index Market, 2011. — [415 с.]. —  
8. Орнамент всех времен и стилей : в 2-х т.. Т. 1 : Античное искусство, искусство Азии, средние века / гл. ред. Т. И. Хлебнова ; пер. с франц. Б. Б. Павлова. — М. : АРТРОДНИК, 2004. — 267 с. : ил. 
9. Орнамент всех времен и стилей : в 2-х т.. Т. 2 : Средневековое искусство, ренессанс, XVII - XIX века / гл. ред. Т. И. Хлебнова ; пер. с франц. Б. Б. Павлова. — М. : АРТ-РОДНИК, 2004. — 250 с. : ил. 
10. Плаксина Э. Б. История костюма: стили и направления : учеб. пособие / Э. Б. Плаксина. — 2-е изд., стер. — М. : Академия, 2004. — 224 с., 8 л. цв. ил.:ил. 
11. Сержантова И. А. Основы композиции : учеб. пособ. для студентов высш. учеб. заведений культуры и искусства. — Луганск : ФЛП Михненко О.В., 2017. — 318 с.: нот. — 978-966-2005-08-0. Академия, Худ. отд. 
12. Хеллер С., Чваст С. Эволюция графических стилей. От викторианской эпохи до нового века. — М. : Изд-ао Студии Артемия Лебедева, 2015. — 320 с. : ил. 
13. Эйри Д. Логотип и фирменный стиль : Руководство дизайнера / Д. Эйри; пер. с анг. В. Шрага. — СПб. : Питер, 2011. — 208 с. : ил. 
14. Элам К. Геометрия дизайна. Пропорции и композиция. — СПб : Питер, 2011. — 109 с. : ил.  
15. Элементы дизайна. Развитие дизайна и элементов стиля от Ренессанса до Постмодернизма / гл. ред. Н. Райли ; пер. с англ. — М. : ООО "Магма", 2004. — 522 с. : ил. 
16. Элементы стиля: энциклопедия архитектурных деталей : новая редакция / гл. ред. С. Кэлоуэй ; пер. с англ. — Изд. 2-е, доп. и перераб. — М. : ООО "Магма", 2006. — 452 с. : ил. 

Дополнительная литература:

1. Процесс рисования цифровой живописи. [Электронный ресурс]. - Режим  доступа: https://pikabu.ru/story/protsess_risovaniya_tsifrovoy_zhivopisi_khudozhnitsa_bogena_dia_5382160  
2. Сайт посвящен современному искусству различных жанров; [Электронный ресурс]. - Режим доступа: https://www.saatchigallery.com/  
3. Официальный сайт Московского союза художников, освещающий выставки, профессиональную деятельность художников; [Электронный ресурс]. - Режим доступа: http://www.artanum.ru/  
4. На сайте рассматриваются проблемы современного компьютерного дизайна; https://compuart.ru/ 

РАЗДЕЛЫ III-IV
Основная литература:

1. Белицкий Я. М. Рассказы об открытках / Я. М. Белицкий, Г. Н. Глезер. — М.: Радио и связь, 1986. — 144 с.  
2. Лаптев В. В. Просто дизайн / В. В. Лаптев. — М.: Аватар, 2008. — 176 с. — 978-5-903781-03-4.  
3. Пантюхин В. Почтовые карточки Великой Отечественной войны. Издания 1941-1945 гг.: ил. кат. односторон. почтовых карт. СССР / В. Пантюхин. — М. : Деловой ритм, 2009. — 160 с. — 978-5-903291-12-0.  
4. Башкина В. Я. Привет из Луганска. История Луганска из почтовых открытках и фотографиях / В. Я. Башкина, А. И. Поболелов. — Луганск : Максим, 2007. — 128 с. — Академия  
5. Левітас Й. Я, Все про марки / Й. Я. Левітас, В. М. Басюк. — К.: Реклама, 1975. — 237 с.  
6. Левитас И. Я. Основы практической филателии / И. Я. Левитас. — М.: Радио и связь, 1986. — 280 с.  
7. Возженников Н. П. Искусство партмаксимума / Н. П. Возженников, В. А. Якобс. — М. : Связь, 1979. — 64 с.  
8. Макельский С. Как создать и продать логотип / С. Макельский. — [б. м.] : [б. и.], 2008. — [33 с.]. —  
9. Патернотт Ж. Разработка и создание логотипов и графических концепций / пер. с фр. Т. Л. Черноситова. — Ростов н/Д: Феникс, 2008. — 78 с. — Мастер-класс. — 978-5-22212525-0.  
10. Эйри Д. Логотип и фирменный стиль: Руководство дизайнера / Д. Эйри; пер. с анг. В. Шрага. — СПб.: Питер, 2011. — 208 с.: ил. — 978-5-459-00289-8.   
11. Годин А. М. Брендинг: учебное пособие / А. М. Годин. — 3-е изд., перераб. и доп. — М.: 
«Дашков и К°», 2012. — 184 с. — 978-5-394-01149-8. Академия  
12. Крейг Дж., Скала И. Шрифт и дизайн. Современная типографика. — СПб: Питер, 2016. — 176 с. : ил. — 978-5-496-01370-3.   
13. Курушин В. Д. Дизайн и реклама / В. Д. Курушин. — М.: ДМК Пресс, 2006. — 272 с.: ил. — Самоучитель. — 5-94074-299-8.   
14. Лин М. В. Современный дизайн. Пошаговое руководство. Техника рисования / Майк В. Лин. — М.: Астрель, 2012. — 199 с. — 978-5-271-26204-3.   
15. Победин В. А. Знаки в графическом дизайне / В. А. Победин. — Х.: Ранок, 2001. — 96 с. — 966-679-042-4.   
16. Шнейдеров В. С. Фотография, реклама, дизайн на компьютере / В. С. Шнейдеров. — 2-е изд. — СПб: Питер, 2004. — 331 с.: ил. — Самоучитель. — 5-94723-837-3.   
17. Элам К. Графический дизайн. Принцип сетки. — СПб: Питер, 2014. — 120 с. : ил. — 9185-496-00432-9.   
18. Яцюк О. Основы графического дизайна на базе компьютерных технологий / О. Яцюк. — СПб.: БХВ-Петербург, 2004. — 240 с. — 5-94157-411-8  
19. Найс К. Рисунок тушью: пер с англ. — Мн.: Попурри, 2000. — 144 с.: ил. — Школа рисования. — 985-438-383-0.  
20. Устин В. Б. Композиция в дизайне. Методические основы композиционнохудожественного формообразования в дизайнерском творчестве: учеб. пособие. — 2-е изд., уточненное и доп. — М.: АСТ, 2007. — 340 с.: ил. — 5-17-035856-3.   
21. Калмыкова Н. В. Дизайн поверхности: композиция, пластика, графика, колористика : учеб. пособие / Калмыкова Н. В., Максимова И. А. — М. : КДУ, 2010. — 154 с. — (ил.). — 978-5-98227-562-2. 
 
Дополнительная литература:
 
22. Загорский В. Каталог почтовых марок: 1992-2010. Российская Федерация / В. Загорский. — СПб: Стандарт-Коллекция, 2011. — 243 с. : ил. — 978-5-902275-47-3.  
23. Загорский В.Б., Лебедев В.Б. - Каталог почтовых карточек. Ассоциация художников революции 1922-1932 (2006) 
24. Левитас Филателия школьникам 
25. Каталог почтовых карточек и конвертов с оригинальными марками. СССР 1923-1991 
26. Каталог знаків поштової оплати України 2010. — К.: Укрпошта, 2011. — 64 с.: іл.  
27. Каталог-справочник официальных знаков почтовой оплаты России, СНГ и Прибалтики 1992-2001 / [под общ. ред. И. Д. Панфилова, С. В. Гарынова]. — М.: ЗАО "Экон-информ", 2002. — 224 с.: ил. — Мир марок. — 5-9506-0003-7. 
28. Пантюхин В.А. - Почтовые карточки Великой Отечественной войны. Издания 1941-1945 гг (2009) 
29. Михайло Петрів - Коломия наше місто. Каталог листівок (2016) 
30. Каталог почтовых карточек и конвертов с оригинальными марками. СССР 1923-1991
31. Луптон Э., Филлипс Дж. Графический дизайн. Базовые концепции. — СПб: Питер, 2017. — 256 с. : ил. — 978-5-496-01810-4. 
32. Элам К. Геометрия дизайна. Пропорции и композиция. — СПб: Питер, 2011. — 109 с. : 
ил. — 978-5-459-00277-5. 
33. Letterhead & Logo Design N4 
34. Logolounge_1  

РАЗДЕЛЫ V-VI
Основная литература:

1. Adobe Illustrator CC. Официальный учебный курс / пер. с англ. М. А. Райтман. — М. : Эксмо, 2014. — 592 с.
2. Adobe Illustrator CS6. Официальный учебный курс / пер. с англ. М. А. Райтман. — М. : Эксмо, 2013. — 592 с. : ил.
3.  .
4. Adobe InDesign CS3 : руководство пользователя / В.Г.Завгородний. — [б. м.] : [б. и.]. — 693 с. : ил.
5. Adobe InDesign CS5 : официальный учебный курс / пер. с англ. М. А. Райтман. — М. : Эксмо, 2011. — 480 с.
6. Adobe InDesign CS5 : официальный учебный курс ]Диск] / пер. с англ. М. А. Райтман. — М. : Эксмо, 2011. — 480 с.
7. Adobe Photoshop CC. Официальный учебный курс / пер. с англ. М. А. Райтман. — М. : Эксмо, 2014. — 456 c.
8. Adobe Photoshop CS6. Официальный учебный курс / пер. с англ. М. А. Райтман. — М. : Эксмо, 2013. — 432 с. : ил.
9. Брингхерст Р. Основы стиля в типографике / Р. Брингхерст. — М. : Аронов Д., 2006. — 434 с.
10. Водчиц С. С. Эстетика пропорций в дизайне. Система книжных пропорций : учеб. пособие для вузов. — М. : Техносфера, 2005. — 432 с. : ил.
11. Ландер А. Самоучитель Adobe InDesign CS5 / А. Ландер. — СПб. : БХВ-Петербург, 2011. — 384 с.: ил.
12. Пикок Дж. Издательское дело : Книга - от замысла до упаковки / Дж. Пикок. — М. : ЭКОМ, 1998. — 400 с. : ил.
13. Рейнхардт Р. Macromedia Flash MX Action Script : библия пользователя / Р. Рейнхард. — М. : Вильяме, 2003. — 1280 с. : ил.
14. Романова Ю. Д. Информатика и информационные технологии : конспект лекций / И. Г. Лисничая. — 2-е изд., перераб. и доп. — М. : Эксмо, 2009. — 320 с.
15. Франк Я. Тайные знания коммерческих иллюстраторов / Я. Франк. — М. : Студия Артемия Лебедева. — 165 с. : ил.
16. Чихольд Я. Облик книги : Избранные статьи о книжном оформлении / Я. Чихольд. — М. : Книга, 1980. — 242 с. : ил. 

Дополнительная литература:

1. Барышников Г. М. Шрифты. Разработка и использование / Г. М. Барышников и др. — М. : Эком, 1997. — 288 с.
2. Буковецкая О. А. Готовим в печать журнал, книгу, буклет, визитку / О. А. Буковецкая. — М. : НТ Пресс, 2005. — 303, [1] с. : ил. 
3. Буковецкая О.А Основы допечатной подготовки / О.А. Буковецкая. — М. : НТ Пресс, 2005. — 159 с.
4. Вилсон Д. Дж. Основы офсетной печати. — М. : ПРИНТ-МЕДИА центр, 2005. — 214 с. : ил.
5. Гилл М. Гармония цвета: естественные цвета : руководство для создания наилучших цветовых сочетаний / Марта Гилл. — М. : ACT, Астрель, 2006. — 108 с. : ил. 
6. Голубева О. Л. Основы композиции : учеб. пособие / О. Л. Голубева. — 2-е изд. — М. : Искусство, 2004. — 121 с. 
7.  
8. Демосфенова Г. Л. Как иллюстрируется книга / Г. Л. Демосфенова. — М. : Академия художеств СССР, 1961. — 67 с.
9. Иванова Т. Допечатная подготовка : учебный курс / Т. Иванова. — СПб. : Питер, 2004. — 304 с.: ил. 
10. Калинин С. Ю. Как правильно оформить выходные сведения издания : пособие / С.Ю. Калинин. — 2-е изд., перераб. и доп. — М. : МГУП, 2001. — 224 с. 
11. Королькова А. Живая типографика / А. Королькова. — М. : IndexMarket, 2007. — 228 с.
12. Кричевский В. Типографика в терминах и образах. Т. 1 / В. Кричевский. — М. : Слово, 2000. — 145 с.
13. Кричевский В. Типографика в терминах и образах. Т. 2 / В. Кричевский. — М. : Слово, 2000. — 166 с.
14. Кудрявцев А. И. Шрифт. История. Теория, Практика : учебно-метод. пособие / А. И. Кудрявцев; под общ. ред. Н. В. Нестеревой. — М. : [б. и.], 2003. — 250 с. : ил.
15. Николаев Д. Г. Современные технологии компьютерной верстки : учеб. пособие / Д. Г. Николаев, А. В. Ольшевская, Д. Г. Штенников. — СПб : СПбГУ ИТМО, 2010. — 132 с.
16. Самара Т. Типографика цвета. Практикум : Как выбрать шрифт / Т. Самара. — [б. м.] : Рип-холдинг. — 255 с. 
17. Саттон Т. Гармония цвета: полное руководство по созданию цветовых комбинаций / Т. Саттон, Б. Вилен. — М. : АСТ, 2004. — 215 с. 
18. Серов С. И. Гармония классической типографики : Конспект-программа лекций по авторскому курсу «Проектная концептуалистика». — М. : ЗАО «Линия График», 2003. — 32 c.
19. Толивер-Нигро Х. Технологии печати : учеб. пособие для вузов. — М. : ПРИНТ-МЕДИА центр, 2006. — 232 с. : ил.
20. Уэйншенк С. 100 главных принципов дизайна : Как удержать внимание / С. Уэйншенк ; [пер. с англ.]. — СПб : Питер, 2012. — 272 с. : ил.
21. Файола 3. Шрифты для печати и Web-дизайна. — СПб. : БХВ-Петербург, 2003. — 288 c.
22. Феличи Д. Типографика: шрифт, верстка, дизайн / Д. Феличи. — СПб : БХВ-Петербург, 2004. — 500 с.
23. Фивер У. Когда мы были детьми : Два века книжной иллюстрации для детей / У. Фивер; пер. с англ. А. Ильф. — М. : Советский художник, 1979. — 96 с. : ил. 
24. Чернышев О. В. Формальная композиция : творческий практикум по основам дизайна / О. В. Чернышев. — Минск : Харвест, 1999. — 312 с. : ил. 
25. Чихольд Я. Новая типографика. Руководство для современного дизайна / Я. Чихольд; пер. с нем. Л. Якубсона. — М. : Студия Артемия Лебедева, 2011. — 242 с. : ил. 
26. Шпикерман Э. О шрифте / Э. Шпикерман; пер. с англ. Н. Мухина. — М. : ПараТайп, 2005. — 194 с.
27. Шульмейстер М. В. Книжно-журнальная верстка : в вопросах и ответах / М. В. Шульмейстер. — М. : Книга, 1978. — 200 с.
28. Юрьев Ф. Цвет в искусстве книги : монография / Ф. Юрьев. — К. : Вища школа, 1987. — 246 с. : ил.

Интернет-источники:

1. Журнал «КомпьюАрт» [Электронный ресурс]. – Режим доступа : http://compuart.ru/Index.aspx
2. Крупнейшая русскоязычная база шрифтов [Электронный ресурс]. – Режим доступа : http://fontomania.ru/
3. Приемы работы, хитрости и секреты, скрипты, плагины, автоматизация верстки Эффективная работа в Adobe InDesign [Электронный ресурс]. – Режим доступа : http://adobeindesign.ru/

РАЗДЕЛ VII
Основная литература:

1. Аникст М., Бабурина Н. Русский графический дизайн. – М.: «Внешсигма». – 1997 
2. Аренс Б. Современная реклама. С-.Пб. Витязь. 2007.-192 с. 
3. Арнхейм Р. Искусство и визуальное восприятие. – М.: «Прогресс», 1984 
4. Артемьева Е.Ю. Основы психологии субъективной семантики. М.: Смысл, 
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6. Иттен И. Искусство формы. Мой форкурс в Баухаузе и других школах / Иоханнес Иттен. — М. : Изобразительное искусство, 1975. — 138 с. 
7. Козловски П. Культура постмодерна. М., 1997. 
8. Крейг Дж., Скала И. Шрифт и дизайн. Современная типографика. — СПб : 
Питер, 2016. — 176 с. : ил. 
9. Никулина И. А. Верстака, дизайн и допечатная подготовка в полиграфическом процессе : учебник. — Краснодар : Кубанский гос. ун-т, 2010. — 236 с. : ил. 
10. Кудин П.А., Ломов Б.Ф., Митькин А.А. Психология восприятия и искусство плаката. – М.: «Плакат». - 1987  
11. Пикок Дж. Издательское дело : Книга - от замысла до упаковки / Дж. Пикок. — М. : ЭКОМ, 1998. — 400 с. : ил. 
12. Рунге В. Ф. Сеньковский В. В. Основы теории  и  методологии дизайна. Учебное пособие (конспект лекций) — М.: МЗ-Пресс, 2003 — 252 с. 
13. Самара Т. Типографика цвета. Практикум. – М.: «РИП-холдинг» - 2007 — 255 с. 
14. Смирнов С. И. Шрифт в наглядной агитации. — Москва: Плакат, 1987 —192 с., ил. Стандарты по издательскому делу. — М.: Юристъ, 1998. 
15. Стефанов Стефан. Полиграфия и технологии печати : учеб. пособие / под науч. 
ред. В. Н. Румянцева, В. Р. Фиделя. — М. : ЛИБРОКОМ, 2009. — 144 с.  
16. Шевелев И.Ш. М.А.Марутаев, И.П.Шмелев, Золотое сечение/Section Divine. М.: Стройиздат, 1990. 17. Шевченко В. Я. Композиция плаката. Учебное пособие. — Харьков.: Колорит, 
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Дополнительная литература:
 
18. Ковешникова Н.А. Дизайн: история и теория. – М.: Омега-Л, 2009. – 224 с. 
19. Макельский С. Как создать и продать логотип / С. Макельский. — [б. м.] : [б. и.], 2008. — [33 с.]. 
20. Розенсон И.А. Основы теории дизайна. – СПб.: Питер, 2008. – 219 с. 
21. Эйри Д. Логотип и фирменный стиль : Руководство дизайнера / Д. Эйри; пер. с анг. В. Шрага. — СПб. : Питер, 2011. — 208 с. : ил. 
22. Эльбрюнн Б. Логотип / Б. Эльбрюнн; под ред. С. Г. Божук. — СПб. : Нева, 2003. — 127 с. 
 
Интернет-источники:
 
23. Портал о рекламе и дизайне.  [Электронный ресурс]. – Режим доступа :  www.adme.ru 
24. Электронный журнал о дизайне. [Электронный ресурс]. – Режим доступа : https://awdee.ru/categories/
25. Электронный ресурс для дизайнеров. Статьи, материалы. [Электронный ресурс]. – Режим доступа : https://infogra.ru/
26. Журнал в области дизайна и культуры. [Электронный ресурс]. – Режим доступа :  https://www.slanted.de/

12. МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ
И ИНФОРМАЦИОННЫЕ ТЕХНОЛОГИИ


Учебные занятия проводятся в аудиториях согласно расписанию занятий. При подготовке к занятиям по данной дисциплине используется аудиторный фонд (оборудованный настольными компьютерами)..
Для самостоятельной работы студенты используют литературу читального зала библиотеки Академии Матусовского, имеют доступ к ресурсам электронной библиотечной системы Академии, а также возможность использования компьютерной техники, оснащенной необходимым программным обеспечением, электронными учебными пособиями и законодательно-правовой и нормативной поисковой системой, имеющий выход в глобальную сеть Интернет.

